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1 機能概要 
  BioStationViewer の主な機能は、 
1) タンパク質の分子構造の表示 
2) 電子密度、静電ポテンシャル、分子軌道の等値面、断面表示 
3) 電子密度等値面上に静電ポテンシャルの値による色付けした表示 
4) 分子構造の編集 
5) フラグメント間相互作用解析の表示 
6) 電場ベクトルの表示 
7) 分子構造の時系列変化のアニメーション表示 
です。 
 
図 1.1 に電子密度等値面上に静電ポテンシャルの値により色付けした表示例を示します。 
 

 

図 1.1 電子密度等値面上に静電ポテンシャルの値により色付けした表示例 
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2 使用方法 
2.1 起動方法 

デスクトップのアイコン をダブルクリックして起動します。起動画面を図 2.1 に示します。

左側に分子構造を Tree 図で表示し、右側に 3D 表示します。メニューバーより表示指定のメニュ

ーを表示し、各種指定を行えます。Tree 図は、チェーン、残基、原子の階層で表示されます。

Tree 図をピックすると、該当の原子等がハイライトされ、表示されている構造をピックすると該当す

る Tree 図中の原子等がハイライトされます。下部にはメッセージが表示されます。 
 

 

図 2.1 メイン画面 

2.2 メニューの説明 
メイン画面のメニューの説明をします。 

 

図 2.2 メニュー 
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2.2.1 File ファイル操作 

  

図 2.3 File メニュー 

♦ Open PDB フ ァ イ ル (*.pdb,*.ent) 、 ABINIT-MP Check Point File(*.cpf) 、
ABINIT-MP Grid File(*.den,*esp,*.map,*.mo,*.efv)、MOL2 ファイル (*.mol2)、
MDL ファイル (*.mol, *.mdl),Gaussian Cube ファイル (*.cube,*.cub), Gaussian 
output ファイル (*.gout),XYZ ファイル (*.xyz), Mopac input/output ファイル

(*.min,*.arc),トラジェクトリｰファイル(*.trj,*.tr2,*.tj2,trj2)、Pno ファイル(*.pno),表示属

性ファイル（*.prof）を読みます。各ファイルの仕様は以下の URL より参照してください 
 ABINIT-MP : http://www.fsis.iis.u-tokyo.ac.jp/result/software 

cpf ファイルは、zip、gz の圧縮ファイルの読み込みが可能です。 
 PDB ファイル： 

http://www.rcsb.org/pdb/docs/format/pdbguide2.2/guide2.2_frame. html 
 MOL2 ファイル： http://www.tripos.com/custResources/mol2Files 
 MDL ファイル： 

http://www.chm.tu-dresden.de/edv/vamp65/REFERS/vr_03d.htm 
 Gaussian Cube ファイル： http://www.gaussian.com の G03 Manual Pages 

Gaussian output ファイル 
 XYZ ファイル：初めに原子数、コメント、その後原子数分１行に原子記号、ｘ座標、ｙ

座標、ｚ座標が記述された形式。拡張として、BioStation Viewer では、座標の後ろ

に x,y,z のベクトル量を指定して、原子ごとのベクトル表示が可能です。ベクトルの表

示属性の変更は Preference 指定の Arrow を参照してください。 

http://www.fsis.iis.u-tokyo.ac.jp/result/software
http://www.tripos.com/custResources/mol2Files
http://www.chm.tu-dresden.de/edv/vamp65/REFERS/vr_03d.htm
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 Mopac input/output ファイル: Dewar, M.J.S., Thiel, W., J. Am. Chem. Soc., 1977, 
99, 4899, 3907 

 トラジェクトリ－ファイル：2.4.1 参照 
 Pno ファイル：http://www.fsis.iis.u-tokyo.ac.jp/result/software 参照 
 表示属性ファイル:表示形式を保存し、そのファイルを読み込むことにより表示を再現

できます。以下に対応している機能を示します。 
 CPF を 1 つ含むこと。他の構造ファイルは未対応 
 View Point 
 Model 
 Color 
 Atom,Residue の個別表示指定(Model,Color,Label) 
 Tool(Display * in Distance, Set Rotation Center ) 
 Monitor(Distance, Angle, Dihedral Angle, Interaction Energy, IFIE 

1:1,N:1 
 Preference 
 

1) 分子構造ファイル 
PDB ファイル、ABINIT-MP Check Point File、MOL2 ファイル、MDL ファイル、XYZ ファ

イル、Gaussian output ファイル、Mopac input/output ファイルを読み込んだ場合は分子

構造が表示されます。読み込んだ後の表示形式は、原子の数が 300 より少ない場合は Stick、
300 以上の場合は CA(Line)になります。 
 
2) ABINIT-MP Grid File、Gaussian Cube ファイル 
ABINIT-MP Grid File の拡張子の意味は、 
  ⅰ) den：電子密度 
  ⅱ) esp：静電ポテンシャル 
  ⅲ) map：電子密度の等値面上に静電ポテンシャルをマップしたファイル 
  ⅳ) mo：分子軌道 
  ⅴ) efv：電場ベクトル 
です。ABINIT-MP Grid File を読み込んだ場合には、表示する等値面を指定します。                  

Gaussian Cube ファイルの場合は、そのファイルが電子密度、静電ポテンシャル、分子軌道

の指定、周期表示時の境界の値の補填指定をおこない、そのそれぞれの表示指定を行いま

す。Periodical grid value は、格子データを周期表示した場合に、端の境界１セル分を補っ

て表示する場合は on に、補わない場合は off にします。指定画面を図 2.4 に示します。 
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図 2.4 Gaussian Cube ファイルの指定画面 

3) 電子密度の表示指定 
電子密度指定画面を図 2.5 に示します。表示する等値面の値、色、透明度、格子データ領

域の表示、断面を指定します。色付けの方法は2つあり、単一で指定する方法と、最小値、最

大値を指定しその範囲で色を割り当て、指定された値の色で表示する方法があります。範囲

で指定した場合は値の低→高に合わせて、青→緑→赤と変化します。図 2.6 に単一色のカ

ラー選択画面を示します。 
等値面の値は、直接指定と、σ指定があり、σは、以下の式で算出され、1以上の場合は 1と

して扱われるます。 

σ[ρ] = �
∑ {𝜌𝜌(𝑥𝑥𝑖𝑖 ,𝑦𝑦𝑖𝑖 , 𝑧𝑧𝑖𝑖)− �̅�𝜌}𝑁𝑁
𝑖𝑖=1

2

𝑁𝑁 �
1/2

 

 Section の”Set”ボタンをクリックすると断面の指定画面が表示されます。断面指定の説明は、

2.3 節に示します。 
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図 2.5 等値面の指定画面 

 

図 2.6 カラー選択画面 

4) マップファイル、静電ポテンシャルの指定 
マップファイルの場合には、表示する等値面の値、静電ポテンシャルの値の範囲を指定します。指

定画面を図 2.7 に示します。デフォルトでは値が高→低の変化に合わせて、表示色が赤→白→

青に変化します。値の範囲指定のボタンを”Min Max(red,blue)”にすると表示色が青→白→赤に

変化します。 
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 静電ポテンシャルの場合は指定された値の±の２つの等値面を表示します。 
 

 

   

図 2.7 マップファイル、静電ポテンシャルの指定画面 
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5) 分子軌道表示の指定 
分子軌道の場合は各軌道のエネルギーの

グラフが表示されます。グラフ表示画面を図 
2.8 に示します。グラフ上にマウスを移動すると、

軌道番号、エネルギーの値がグラフの下に表

示されます。グラフをクリックすると、Mo No.に
その軌道番号が設定されます。ここに、軌道番

号を直接入力することも可能です。Draw ボタ

ンをクリックすると指定された値の±の等値面

を表示します。 
”＋”、”－“ボタンをクリックすることによりグラ

フの拡大縮小が可能です。Line Width でグ

ラフの太さを指定できます。等値面の色は、カ

ラー選択画面で指定可能です。また、

Color(-,+)は Color(+,-)と変更可能で、選択さ

れたときに±の色が入れ替わります。色付けす

る値の範囲を Min,Max で指定します。

Transparency で透明度を指定します。

Section で断面を指定します。 
Gaussian Cube ファイルの場合はエネルギ

ーの値がないので、複数の軌道の記述がある

場合は、１から順にグラフが表示されます。 

 
図 2.8 分子軌道の等値面指定画面 
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6) 電場ベクトルの表示指定 
電場ベクトルファイルを読み込むと図 2.9 に示す指定画面が表示され、３D 表示にはデフォルトの

表示指定での電場ベクトルが表示されます。電場ベクトルは、指定された等値面上の点を基準とし

て表示されます。表示指定を以下に説明します。 

 

図 2.9 電場ベクトル指定画面 

• Map Property 電場ベクトル表示の元となる等値面の指定をおこないます 
 Value of Density Isosurface 

表示する電子密度の等値面の値を指定します。 
 Min Max(blue,red)/ (red,blue) 

等値面上に色付けする静電ポテンシャルの値を指定します。デフォルトでは値が

高→低の変化に合わせて、表示色が赤→白→青に変化します。値の範囲指定の

ボタンを”Min Max(red,blue)にすると表示色が青→白→赤に変化します。 
 Transparency 

透明度を指定します。 
 Bounding Box 
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格子データの境界の表示の有無を指定します。 
 Section 

Set ボタンをクリックすると断面指定画面が表示されます。断面指定は 2.3 節で説

明します。 
• Electric Field Vector Property 電場ベクトル表示の指定をおこないます 

 Model 
表示形式を Line, Stick から選択します。Stick の場合は Stick の太さを指定しま

す。 
 Start Value Threshold(min,max) 

電場ベクトルの開始点となる等値面上の点の静電ポテンシャルの値の範囲を指定

します。 
 Numbet of Step 

電場ベクトルの表示ステップ数を指定します。ここで指定されたステップ数の回数

だけ繰り返し計算しベクトルを表示します。 
 Length(Å) 

１ステップあたりの長さ 
 Thinned-out ratio (0.0-1.0) 

開始点の間引きの割合。0～1 で指定します。 
• Draw 指定された値で電場ベクトルを表示します。 
    注意！ Stick の場合表示する数を多くすると、Viewer が異常終了する場合がありま

す。原因は究明中です。 
7) トラジェクトリｰファイル 
時系列で分子構造が変化する様子をアニメーション表示します。詳細は 2.4 節に説明しま

す。 
8) Pno(Pair Natural Orbital)グリッドファイル 
軌道ペアの等値面を表示します。ファイルを入力すると、ファイルに記述されていた軌道ペ

アごとに表示指定が表示されます。それぞれ緩和エネルギー、Hole 軌道の占有数、

Particle 軌道の占有数が表示されます。ペアの表示、Hole 軌道、Particle 軌道、Hole 軌

道→Particle 軌道の格子領域の重心を結ぶ Vector の表示の有無を指定できます。Select 
All ですべてのペアを選択できます。Unselect All ですべての選択を解除します。”Apply”
ボタンをクリックすると指定の様式で表示されます。図 2.10、図 2.11 に指定画面を示しま

す。 
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図 2.10  Pno(Pair Natural Orbital)グリッドファイル指定画面 

  

図 2.11 Hole, Particle,Vector 指定画面 
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♦ Open CPF 
チェックポイントファイルの入力時に表示の対象とするフラグメントを指定できます。指定された

フラグメントのみ表示されます。非表示指定のフラグメントは、再読み込みしない限り表示され

ません。指定方法は以下の 3 通りです。 
1) None : 指定なしでそのまま表示します。 
2) Ignore Fragments : 表示対象としないフラグメント番号を指定 
3) Fragments in Distance : 指定されたフラグメントからの距離内にあるフラグメントを

表示 

 

図 2.12 指定画面 

 

図 2.13 None 指定の表示例 
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図 2.14  Ignore Fragments の表示例 

 

 

図 2.15  Fragments in Distance の表示例 
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♦ Open File[difference density] グリッドファイルの差分表示 
複数のグリッドファイルを読み込みその係数を指定し,各グリッドの点の値を計算し等値面を表

示します。グリッドの大きさ個数が異なるファイルを指定した場合はエラーになります。図 2.16
に指定画面を示します。ファイルは 7 つまで指定可能です。 

 

図 2.16 グリッドファイルの差分指定画面 

♦ Open File[difference cpf] チェックポイントファイルの差分表示 
複数のチェックポイントファイルを読み込みその係数を指定し,電荷、フラグメント相互作用エネ

ルギーの値を計算し表示します。ファイル読み込み後 Tool->IFIE MAP を選択すると計算さ

れた値の MAP を表示します。図 2.17 に指定画面を示します。ファイルは 7 つまで指定可能

です。ただし、原子数が異なる場合は、電荷の計算が、フラグメント数が異なる場合は、IFIE
の値が計算されません。 
Adjust Atom rangeは、そのファイルの１部の原子を適用したい場合に指定します。形式は、 
     開始原子番号 － 終了原子番号 File の対応する原子番号 
です。たとえば、File 2 で “10 – 20 5” と指定すると、File1 の 10-20 の原子の値が、File2
の 5-15 に適用します。何も指定しない場合は、すべての原子に適用します。フラグメント相互

作用エネルギーの値は、指定された原子のフラグメントが適用されます。 
Coodinate は、”apply”がチェックされると、そのファイルの原子の座標が表示に使用されま

す。 

 

図 2.17 チェックポイントファイルの差分指定画面 
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♦ OpenFile[Supermolecule] 超分子計算 
コンプレックス、タンパク質、リガンドの CPF を指定します。図 2.18 に指定画面を示します。コ

ンプレックス中のタンパク質のフラグメント番号を“1-100“のように指定します。OK をクリックす

ると、指定されたファイルを読み込み、リガンド結合による電子緩和の効果を取り込んだ、フラ

グメント単位のタンパク質―リガンド IFIE 解析の値が、3D 表示、リスト表示、MAP 表示で表

示されます。 

 

図 2.18 超分子計算ファイル指定画面 

♦ Save File ファイルの格納 
拡張子を選択することにより各種ファイル出力が可能です。 
1) pdb, ent 表示されている分子構造を PDB ファイルの形式で格納します。格納されたファ

イル中の原子番号は振りなおされます。 
2) gjf Gaussian の入力ファイルを出力します。出力例を以下に示します。ABINIT-MP 
Check Point File を表示している場合は、分子電荷、スピン多重度は以下の式で計算されま

す。 
 分子電荷＝核荷電の和(原子番号の和)－フラグメントの電子数の和 
 スピン多重度＝電子状態の１文字目が S の場合は１、Ｄの場合は２、Ｔの場合は３。 

%chk=test.chk 
#HF/6-31G(d,p) POPT=(MaxCycle=100) SCF=TIGHT 
 
 
 
 0 1 
  N  0 x001 y001 z001 
  C  0 x002 y002 z002 
  C  0 x003 y003 z003 
…………… 
  H  0 x071 y071 z071 
  O  0 x072 y072 z072 
  H  0 x073 y073 z073 
 Variables: 
 x001=  0.162000 
 y001= -0.202000 
 z001=  0.000000 
 x002=  1.612000 
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…………… 
z072= -5.671000 

 x073= -4.846000 
 y073= 12.697000 
 z073= -6.024000 
 Constants: 

3) jpg 表示を JPEG ファイルに出力します。 
4) png 表示を PNG ファイルに出力します。 
5) tif 表示を Tiff ファイルに出力します。 
6) ＸＹＺ XYZ 形式のファイルを出力します。XYZ 形式とは、初めに原子数、コメント、そ

の後原子数分１行に原子記号、ｘ座標、ｙ座標、ｚ座標が記述された形式です。 
7) prof 表示属性ファイル :BioStation Viewer の表示属性を記述。 

♦ Save Profile File 
BioStation Viewer の表示属性をファイル（*.prof）に出力します。このファイルを読み込

みことで、表示を再現できます。 
♦ Save Renumbered PDB File 

分子構造の原子番号を１からリナンバリングして、PDB 形式で格納する。ファイル名は

xxx-renumbered.pdb(xxx は元のファイル名)が設定される。チェーン終端の”TER”出力

の有無出力するチェーン名を指定する。 

 
 

♦ Edit ABINIT-MP File ABINIT-MP 入力ファイルの編集 
ABINIT-MP 入力ファイルの編集画面が表示されます。ここで、パラメータを設定してフ

ァイルの格納、読み込みができます。入力指定は 2.8 節に示します。 
♦ Edit Gauusian Input File Gaussian の入力ファイルの編集 

Gaussian 入力ファイルの簡易編集画面が表示されます。ここで、パラメータを設定して

ファイルの格納、読み込みができます。 
♦ Edit cpf2den Input File cpf2den の入力ファイルの編集 

cpf2den 入力ファイルの簡易編集画面（図 2.19）が表示されます。ここで、パラメータを

設定してファイルの格納、読み込みができます。チェックポイントファイルを読み込み表示
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している場合は、Check Point File の欄にそのファイル名が表示され、Domain 
computing lattice point の Min,Max にそのファイルに記述されている原子の座標の

xyz の最大値、最小値に±2Å加えた値が表示されます。 cpf2den の詳細は

「ABINIT-MP 利用マニュアル」を参照してください。 

 

図 2.19 cpf2den 入力ファイル編集ウインドウ 

 Molecular Orbitals(*.mo) 
fragments で指定されたフラグメントの分子軌道（Molecular Orbital）のグリッド

データをファイルに出力するかどうかを指定します。 
fragments: 分子軌道のグリッドデータを出力するフラグメントをフラグメント番号

で指定します。例：’1,2,8-12’ 
Level : 出力される MO の範囲を指定します。以下に示す方法がある。 
・HOMO-LUMO 周辺の軌道を指定：’ Homo-5:Lumo+5’など。 
・全ての軌道を指定：’All’ 
・全ての占有軌道を指定：’Occ’ 
・全ての非占有軌道を指定：’Virtual’ 
・軌道の番号を直接指定：’1-10’など。 

 Electron Density File(*.den) 
電子密度（Electron density）のグリッドデータをファイルに出力するかどうかを指

定します。 
 Electrostatic Potential File(*.esp) 
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静電ポテンシャル（Electrostatic potential）のグリッドデータをファイルに出力す

るかどうかを指定します。 
 Esp Mapped on Isourface(*.map) 

等電子密度面上の静電ポテンシャルのグリッドデータをファイルに出力するかどう

かを指定します。Isosurface Value:等値面の値を指定します。 
 Electronic Field Vector File(*.efv) 

等電子密度面上の電場ベクトルのグリッドデータをファイルに出力するかどうかを

指定します。 
 Pair Natural Orbitals(*.pno) 

Pno ファイルを出力するかどうかを指定します。 
 Partial Grid 

分子の部分構造に対するグリッドデータを計算するかどうかを指定します。NO の

ままだと分子全体に対するグリッドデータを計算します。 
Reagion : グリッドデータの計算対象となる部分構造をフラグメント番号で指定し

ます。例：’1,2,8-12’ 
 Auto Grid 

YESの場合は、グリッドデータを計算するボックスのサイズをGrid Delta Sizeと
Grid Box Space の値を基に自動で設定します。  
Boundary how/Hide : 格子領域の表示有無を指定します。 
Grid Delta Size : グリッドデータのメッシュの細かさを Å 単位で指定します。 
Grid Box Space ： グリッドデータを計算するボックスのサイズに関する指定。ボ

ックスは分子の大きさに合わせて自動的に計算され、GridBoxSpace では分子の

端とボックスの最短距離を Å 単位で指定します。リターンキーを押すと指定された

値でボックスを再描画します。 
NO の場合は、ｘ、ｙ、ｚのグリッド数、開始点、終了点を指定します。指定画面を次

に示します。 

    
 CNS formatted Electron Dnty(*.cns) 

CNS ファイルを出力するかどうかを指定します。Yes の場合は、グリッド指定を行

います。 
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 Restart from file 
リスタートファイルから指定するかどうかを指定します。Yes の場合は、必要な情報

を指定します。 
 Base Name 

出力されるグリッドデータファイルのベースネームを指定します。指定されない場

合は、読み込んだ CPF ファイルのベースネームを基に決定されます。 
 

♦ Molda Molda の起動 
Molda を起動します。Molda の使用方法は、Molda のマニュアルを参照してください。 

♦ Molda(with file) Molda の起動 
現在表示しているファイルを入力として、Molda を起動します。 

♦ File List 読み込んだファイルリストを表示 
複数のファイルを読み込んだ場合に表示する項目を選択します。指定画面を図 2.20 に

示します。ABINIT-MP Grid File の場合は Value ボタンをクリックすると、図 2.5、図 
2.7、図 2.8 または図 2.9 の指定画面が表示され、表示指定を変更できます。 

 

図 2.20 ファイルリストの表示画面 

♦ Close File 読み込んだファイルの削除 
読み込んだファイルを Viewer 上から削除します。チェックボックスをチェックして”Ok”ボタ

ンをクリックすると削除されます。指定画面を図 2.21 に示します。 

 

図 2.21 削除ファイルリストの表示画面 

♦ Exit 終了します。 
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2.2.2 Viewpoint 視点操作 

 

図 2.22 Viewpoint メニュー 

視点を決められた位置へ移動します。表示の座標系は図 2.23 のようになっています。 
 
 
 

 
 
 

図 2.23 表示の座標系 

♦ Front：正面(z 軸のプラス方向から) 
♦ Back：後(z 軸のマイナス方向から) 
♦ Left：左側(x 軸のマイナス方向から) 
♦ Right：右側(x 軸のプラス方向から) 
♦ Top 上(y 軸のプラス方向から) 
♦ Bottom：下(y 軸のマイナス方向から) 
♦ Rotate X:X 軸を中心に回転します。 
♦ Rotate Y:Y 軸を中心に回転します。 
♦ Rotate Z:Z 軸を中心に回転します。 
♦ Rotation/Translation/Magnify  

視点位置をテキストで指定する機能。指定画面を図 2.24 に示し、表示指定を次に説明

x 

y 

z 
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します。“Apply”ボタンをクリックすることにより視点が移動します。 

   

図 2.24 視点位置指定画面とそのファイルメニュー 

• File メニュー 視点位置をファイルから読み込み、格納します。拡張子は*.pos で

す。 
 Open ViewPosition File 視点位置をファイルから読み込みます。 
 Save ViewPosition File 視点位置をファイルへ格納します。 

• Rotation 回転の指定します 
 Axis 回転軸を指定します 
 Angle 回転角を指定します 

• Translation 移動指定します 
 X,Y,Z x,y,z それぞれの移動距離を指定します 

• Magnify 拡大縮小を指定します 
 Scale 拡大縮小率を指定します 

♦ Periodic 周期表示機能 X,Y,Z 方向に指定された個数だけ同じものを表示します。指定

画面を図 2.25 に示し、表示指定を次に説明します。 

 

図 2.25 周期表示指定画面（Gaussian Cube ファイルの例） 
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• File メニュー 
 Reset 

初期状態に戻します。 
 Close 

画面を閉じます。 
• X ,Y, Z 

Num に X,Y,Z 方向の表示数を指定します。Interval は表示間隔を指定します。

Gaussian Cube ファイルを読み込んだ場合は、3 つの値を指定します。 
• Draw 

指定された周期で表示します。分子構造の表示形式を変更した場合はこのボタンを

クリックすることにより表示が切り替わります。等値面、断面を変更した場合は一度単

一で表示してから、このボタンをクリックすることにより表示が切り替わります。 
 

2.2.3 Model 表示形式指定 

表示形式は、Atom/Structure の２種類選択可能です。それぞれ同時に表示可能です。Atom の

場合に水素の表示形式を指定できます。 

  

図 2.26 Model(Atom)メニュー 

1) Atom の表示形式を指定します。 
♦ Off 非表示にします。 
♦ Wire frame ワイヤーフレーム形式で表示します。 
♦ Wire frame(with fragment bound) ワイヤーフレーム形式で表示します。フラグメント

の境界が分かるように Cαに球を表示します。 
♦ Ball&Stick ボールアンドスティック形式で表示します 
♦ Stick スティック形式で表示します。 
♦ Ball&Wire ボールアンドワイヤー形式で表示します。 
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♦ CPK 空間充填モデル形式で表示します。 
♦ Backbone 主鎖をチューブ形式で表示します。 
♦ Cα[line] Cαを spline 補間して線で結んで表示します。 
これらの表示例は 3.1.1 項に示します。 
 

 

図 2.27 Model(Structure)メニュー 

2) Structure の表示形式を指定します。 
♦ Off 非表示にします。 
♦ Cα Cαを直線で結んで表示します。 
♦ Cα[line] Cαを spline 補間して線で結んで表示します。 
♦ Cα[tube] Cαを spline 補間してチューブ形式で結んで表示します。 
♦ Line Ribbon Ribbon(line)形式で表示します。 
♦ Flat Ribbon Ribbon(Flat)形式で表示します。 
♦ Solid Ribbon Ribbon(Solid)形式で表示します。 
♦ Cartoon Cartoon 形式で表示します。 
ERE_EST.cpf の表示例を図 2.28－図 2.34 に示します。  
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図 2.28 Cαの表示例 

 

図 2.29 Cα Line の表示例 
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図 2.30 Cα Tube の表示例 

 

図 2.31 Line Ribbon の表示例 
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図 2.32 Flat Ribbon の表示例 

 

図 2.33 Solid Ribbon の表示例 
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図 2.34 Cartoon 表示例 

 
3) 水素の表示形式 

 
 

♦ All 表示します。 
♦ Polar N に接続している水素を表示します。 
♦ Non Polar  N 以外に接続している水素を表示します。 
♦ No 非表示にします。 
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2.2.4 Color 色指定 

Atom/Structure それぞれの表示色を指定します。Atom/Structure の指定項目は同じです。デ

フォルトは Atom:Atom、Structure:Structure です。 

 

図 2.35 Color メニュー 

♦ Atom 原子の種類で色付けします。 
♦ Residue 残基で色付けします。 
 Name 残基の種類、DNA の場合は ATGC で色付けします。 
 Hydrophilic/Hydrophobic 親水性（  ）、疎水性(  )で色付けします。 
 Hydrophilic/Hydrophobic/Surface 親水性(  )、疎水性(  )、分子表面(  )で色

付けします。親水性、疎水性は分子表面以外の場合に色付けされます。 
 Function 機能で色付けされます。 

機能 色 対象アミノ酸 
酸性  アスパラギン酸、グルタミン酸 
塩基性  アルギニン、リジン、ヒスチジン 
中性  セリン、トレオニン、アスパラギン、グルタミン 
脂肪族性  グリシン、アラニン、バリン、イソロイシン、ロイシン、メチオニン 
芳香族性  フェニルアラニン、チロシン、トリプトファン 
チオール基  システイン 
イミノ基  プロリン 

 Select Residue 指定画面で選択された残基のみ色付けして表示し他は白で表示し

ます 
♦ Charged Residue 残基の電荷の値で色付けします。(＋：   ０：   －：   ) 
♦ Charge 表示指定のウインドウが表示され、その指定に従い表示されます。チェックポイン

トファイルが Version2 以降の場合値は、HF, MP2, HF NBO, MP2 NBO から選択でき

ます。色付けする値の範囲を指定でいきます。また、色付けは、赤→白→青、青→白→赤

のどちらかを選択できます。電荷の指定がない場合は原子の種類で色付けします。表示

形式が Cαの場合は、その元となる原子の値で表示します。 
 Atom 原子の電荷の値で色付けします。 
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 B Factor 温度因子の値で色付けします。色付け範囲の最大値、最小値を指定しま

す。 

 

図 2.36 温度因子表示指定ウインドウ 

 Fragment フラグメントの電荷の値で色付けします。 
 Residue 残基単位の電荷の値で色付けします。 

 

図 2.37 電荷表示指定ウインドウ 

♦ Fragment フラグメントで色付けします。以下の 8 色でサイクリックに色付けします。 

 
♦ Chain チェーンごとに色付けします。以下の 8 色でサイクリックに色付けします。 

 
♦ File ファイルごとに色付けします。以下の 8 色でサイクリックに色付けします。 

 
♦ Structure 2 次構造の属性で、αへリックス、βシート、その他で色付けします。 

 

2.2.5 Selection 選択指定 

 
図 2.38 Selection メニュー 
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表示画面上をクリックして対象とする場合の選択対象を指定します。 
♦ Atom 原子を対象とします。 
♦ Residue 残基を対象とします。 
♦ Fragment フラグメントを対象とします。 

 

2.2.6 Tool ツール機能 

 

図 2.39 Tool メニュー 

♦ Display Atom in Distance 指定した原子、残基またはフラグメントからの距離内の原子

を表示します。このメニューを選択する前に対象をクリックしておき、図 2.40 に示す画面

で距離を指定します。From selected では基準となるものが原子か、残基かを指定します。

Display List では表示された原子のリスト表示指定を行います。表示されたリストの例を

図 2.41 に示します。原子のリスト表示では、File メニューの Save で表示内容をテキスト

ファイルに格納することが可能です。Distance で距離を指定します。 
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図 2.40 原子距離内表示の指定画面 

      

   図 2.41 距離の指定リスト表示画面

♦ Display Residue in Distance 指定した原子、残基またはフラグメントからの距離内の残

基を表示します。残基は、構成する原子がひとつでも距離内にある場合にに表示されま

す。このメニューを選択する前に対象をクリックしておき、図 2.42 に示す画面で距離を指

定します。From selected では基準となるものが原子か、残基かを指定します。Display 
List では表示された原子のリスト表示指定を行います。原子のリスト表示では、File メニュ

ーの Save で表示内容をテキストファイルに格納することが可能です。Distance では距離

を指定します。 

 

図 2.42 残基距離内表示の指定画面 

 
♦ Display Fragment in Distance 指定した原子、残基またはフラグメントからの距離内の

フラグメントを表示します。フラグメントは、構成する原子がひとつでも距離内にある場合に

に表示されます。このメニューを選択する前に対象をクリックしておき、図 2.43 に示す画

面で距離を指定します。From selected では基準となるものが原子か、残基かを指定しま

す。Display List では表示された原子のリスト表示指定を行います。原子のリスト表示で

は、File メニューの Save で表示内容をテキストファイルに格納することが可能です。

Distance では距離を指定します。 
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図 2.43 フラグメント距離内表示の指定画面 

 
♦ Label 全体の残基、原子、フラグメントのラベル表示を指定します。指定画面を図 2.44

に示します。 

 

図 2.44 ラベル表示指定画面 

♦ Display H Bonds[all] すべての水素結合を表示します。もう一度選択すると表示が消え

ます。 
♦ Display H Bonds[intermolecule] 分子間の水素結合を表示します。もう一度選択する

と表示が消えます。 
♦ Display Dipole moment HF フラグメントごとの HF の Dipole moment の値を矢印で

表示します。表示指定は、Preference(2.2.9)で指定可能です。もう一度選択すると表示

が消えます。 
♦ Display Dipole moment MP2 フラグメントごとの MP2 の Dipole moment の値を矢印

で表示します。表示指定は、Preference(2.2.9)で指定可能です。もう一度選択すると表

示が消えます。MP2 は、チェックポイントファイル Ver.2 以上を読み込んだ場合に有効で

す。 
♦ Multi Layer 

チェックポイントファイル Ver.3 以上で有効です。High Layer を Stick,、Middle Layer
を Wire frame、Low Layer を Cα Line で表示します。 
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♦ Reset Model & Color 表示モデル、色を初期状態に戻します。各残基、原子の指定がク

リアされます。 
♦ Display Selected Residue 指定した残基を表示します。残基ごとの表示指定画面を表

示して、表示する残基を指定します。表示指定画面を図 2.45 に示します。Select All ボ
タンをクリックするとすべての残基が指定され、Unselect All ボタンをクリックするとすべて

の残基の選択が解除されます。 

 
図 2.45 残基表示有無指定画面 

 
♦ Add Hydrogen ＰＤＢファイルを対象として水素付加を行います。指定画面でオプション、

入力ファイル、出力ファイルを指定します。指定画面を図 2.46に示します。Input Fileに
は表示しているPDB ファイル名が指定され、Output FileにはPDB ファイル名_addHと

初期表示されます。実行後結果と表示を入れ替えるかどうかの確認の画面（図 2.47）が
表示されます。ここで、”OK”をクリックすると表示が入れ替わります。 
使用する プログ ラム は 、 Reduce 、 Babel 、 Bond Builder から選択しま す 。

Reduce,Babel,Bond Builder の設定は、それぞれ、7.5 節、7.6 節、7.7 節を参照してく

ださい。 
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図 2.46 水素付加指定画面 

 

図 2.47 3D 表示入れ替えの指定  

♦ Hydrogen Capping Mode 
末端処理を行います。Terminal では、末端の処理方法を選択します。Histidine では、

HIS の水素の形式を選択します。 

 

図 2.48 末端処理の指定  
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♦ Optimize Structure 
構造最適化を実行し表示します。Hydrogen Option file は、水素付加に関するオプショ

ンを記述したファイルを指定します。Optimize Option file は、構造最適化のオプション

を記述したファイルを指定します。オプションは、5 章に詳細なマニュアルを記載していま

す。”OK”ボタンを押すと実行ウインドが表示され、途中結果が表示されます。終了後に実

行後結果と表示を入れ替えるかどうかの確認の画面が表示されます。ここで、”OK”をクリ

ックすると表示が入れ替わります。 

 

図 2.49 構造最適化の指定  

♦ TINKER 
Tinker を起動して結果を表示します。Program では、使用するプログラムを指定します。

Other の場合は、プログラム名をテキストで入力します。Options は、オプションパラメータ

を指定します。 Input File は、入力の PDB ファイルを指定します。デフォルトとして、3D
表示されているファイル名が設定されます。Key Fileは、使用するKey Fileを指定します。

Key File はあらかじめ編集し用意しておいてください。”OK”ボタンを押すと実行ウインド

が表示され、途中結果が表示されます。終了後に実行後結果と表示を入れ替えるかどう

かの確認の画面が表示されます。ここで、”OK”をクリックすると表示が入れ替わります。結

果ファイル名は、入力ファイルが ABC.pdb の場合、ABC_プログラム名.pdb になります。 

 

図 2.50 TINKER の指定  
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♦ Overlay Molecules  
重ねあわせを行います。図 2.51 の重ね合わせ画面が表示されます。 

 

 

図 2.51 重ね合わせの指定画面 

Type、Method、Fit Number(Residue or Atom)を指定します。 
1) Type 

File、Residue、Atom があり、重ね合わせの対象を指定します。 
2) Method 

Cα、Heavy Atoms、All Atoms があり、このメニューの選択により Type が File、Residue
の場合はその中の対象原子を指定します。 

3) Fit Number(Residue or Atom) 
対象とするファイルとそのファイル中の原子、残基の番号を指定します。番号は、対象とする

残基、原子を分子構造表示、または、Tree図よりクリックして選択することができます。キーボ

ードによるテキスト入力も可能です。番号は連番の場合は”－”で入力し、連番でない場合

は” ”で区切って入力します。 
  例 1 1 から 5 残基を対象とする場合 “1－5” 
  例 2  1,2,5, 残基を対象とする場合  “1,2,5” 
一度選択された番号は削除されないので、取り消す場合はキーボードの Back Space また

は、Delete で削除してください。 
入力された原子の数に過不足がある場合は少ないほうに合わされます。”Ok”ボタンをクリッ

クすることにより、重ね合わせられた分子構造が表示されます。このときに、各ファイルの移動

中心は重ね合わせに使用した原子全体の重心になります。選択した原子の RMSD をメッセ

ージエリアに表示します。 
4) Sort 

On/Off で、指定した原子番号をソートするかどうかを指定します。 
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♦ Complement Main Chain 主鎖の補完処理を行います。 
Start Residue NO.に補完する主鎖の番号を指定します。補完する主鎖の番号を指定し

ない場合は、欠損している部分を自動的に補完します。補完する主鎖の番号を指定する

場合は、元の構造の端の残基を Tree 図上でクリックすることにより指定します。補完に使

用するファイル名を指定し、”Apply”ボタンをクリックします。補完後のファイルは、Viewer
起動ディレクトリに元のファイル名(xxx)より、xxx_complement.pdb として格納されます。 

 

図 2.52 主鎖の補完の指定画面 

♦ CHPI CHPI プログラムを起動し、結果を表示します。使用方法は 3.9 節に示します。 
♦ Set Rotation Center 回転中心を設定します。選択されている原子を中心に表示が回転

するようになります。 
♦ Reset Center 回転中心をデフォルトの状態に戻します。 
♦ Set File Rotation Center ファイルごとの重心に移動中心を設定します。 
♦ Add Text 3D 表示上にテキストを表示します。このメニューを選択すると図 2.53 示すテ

キスト指定画面が表示されます。File メニューの Open File, Save File で指定されたテキ

ストの入出力が可能です。 

 

図 2.53 テキスト指定画面 
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 Text 表示するテキストを指定します。 
 Font フォントを指定します。ただし,うまく表示されないものもあります。日本語を入

力した場合は MS xxx のフォントを指定してください。 
 Style Plane, Bold, Italic, Bold Italic を指定します。 
 Color 色を指定します。 
 Position(%) 表示位置を指定します。表示後、表示テキストをマウスの右ボタンを押

しながら、位置の調節が可能です。マウスの位置は、テキストの左下ですが、若干ず

れることがあります。 
 Add 指定されたテキストを 3D 表示画面に表示します。表示されたテキストはボタン

下のリストに追加され、リストを選択することにより、変更削除が可能です。 
 Modify 表示形式を変更します。リストをクリックすることにより、そのテキストの表示

属性が表示されます。ここで、必要な値の変更を行い、”Modify”ボタンをクリックする

ことによりその表示が変更されます。 
 Delete リストで選択されているテキストを削除します。 
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2.2.7 Monitor モニター機能 

 

図 2.54 Monitor メニュー 

♦ Distance 原子間の距離を表示します。メニュー選択後原子を二つクリックするとその距

離が表示されます。このモードの時はメニューが緑色になっています。もう一度同じ原子を

クリックすると表示が消えます。 
♦ Angle 角度を表示します。メニュー選択後原子を三つクリックするとその角度が表示され

ます。このモードの時はメニューが緑色になっています。もう一度同じ原子をクリックすると

表示が消えます。 
♦ Dihedral Angle ２面角を表示します。メニュー選択後原子を四つクリックするとその２面

角が表示されます。このモードの時はメニューが緑色になっています。もう一度同じ原子を

クリックすると表示が消えます。 
♦ Interaction Energy 指定されたフラグメント間のフラグメント間相互作用エネルギーの値

を表示します。メニュー選択後原子を二つクリックするとその２つのフラグメント間相互作用

エネルギーの値が表示されます。このモードの時はメニューが緑色になっています。 
♦ Reset Monitor 機能で指定された表示を消します。 
♦ VISCANA あるタンパク質に対して、複数のリガンドを適用したときの、それぞれのケース

の各フラグメントと対象フラグメントとの相互作用の値により、クラスタ解析を行い、その結

果を表示するものです。詳細は 2.5 節で説明します。 
♦ IFIE MAP 
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IFIE MAP はフラグメント間の相互作用エネルギーの値を２次元の MAP で表示します。

それぞれのフラグメント間の相互作用エネルギーの値で色づけされ、右、上に二次構造を

色で指定します。表示は拡大縮小が可能で、マウスにより値に表示、３Ｄ表示との連携が

可能です。詳細は 2.6 節で説明します。 
♦ FILM Isosurface LMP2 の計算結果の等値面表示を行います。詳細は 2.7 節で説明し

ます。 
♦ Charge List (HF,MP2,HF NBO,MP2 NBO,HF ESP, MP2 ESP)  

HF, MP2, HF NBO, MP2 NBO, HF ESP, MP2 ESP の電荷の値をリスト表示します。

MP2 は、チェックポイントファイル Ver.2 以上を読み込んだ場合に有効で,NBO はチェッ

クポイントファイル Ver.3 以上を読み込んだ場合に有効です。表示例を図 2.55 に示しま

す。File メニューより、リストをテキストファイルに出力することも可能です。 
 

 
リストの種類 

     

(1) Atom   (2) Fragment  
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(3) Residue  (4) Residue(DNA) 

図 2.55 電荷リスト表示例 

 Atom 原子ごとの電荷のリストを表示します。 
 Fragment フラグメントごとの電荷のリストを表示します。 
 Residue 残基ごとの電荷のリストを表示します。 
 Residue(DNA) 残基ごとの電荷のリストを表示します。DNA の部分は塩基とそれ以

外の部分の合計が表示されます。 
 Sum of Charge 指定された範囲のフラグメント、残基、原子の電荷の合計を表示し

ます。範囲指定の画面を図 2.56 に示します。結果は Sum of Charge のところに表

示されます。 

 

図 2.56 指定範囲の電荷表示画面 

 



42 

♦ Intefragment Interaction フラグメント間相互作用に関するオペレーション 
 1:1 1対 1のフラグメント間相互作用エネルギーの値でフラグメントを色付けします。こ

のメニューを選択する前に基準となるフラグメントを選択しておいてください。基準とし

たフラグメントからのエネルギーの値で色付けします。このメニューを選択すると値の

種別、色付けする値の範囲と閾値を指定する画面（図 2.57）が表示されます。CPF
の Version により Value の選択項目がかわります。詳細は 2.6 節を参照ください。 
Many Body Calculation (Value:main+side chain) 
CPF の Version3 以降で多体の値がある場合に有効です。多体の評価の表示指定

です。この項目をチェックした場合、フラグメントが、主鎖、側鎖が別のフラグメントで

分割されている場合に、残基単位で、主鎖＋側鎖の値で色付けします。 
Color 
 単位は kcal/mol です。デフォルトとして、ファイル全体の最小値、最大値が表示さ

れています。変更すると、次にこのメニューを選択するまで、その範囲での色付けで

表示されます。色は変更可能です。変更後”default”ボタンをクリックすると、デフォル

トの色が設定されます。最小値、最大値を変更後、ファイル全体の最小値、最大値に

戻すにはそれぞれ０を指定します。閾値を指定すると、エネルギーの値の絶対値が

閾値以下のフラグメントは表示されなくなります。これにより、相互作用の小さいフラグ

メントの表示の抑制が可能です。 このメニューを選択した場合は、分子構造をクリッ

クすると、クリックされたフラグメントを基準とした色付けの表示がされます。Solvent は、

表示する値を es+np,es,np から選択できます。 
このメニュー選択前、フラグメントが選択されていない場合は、次に選択されたフラグ

メントを基準として表示します。 

 

図 2.57 フラグメント間相互作用エネルギーの表示の指定画面 
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 1:1(Lock) フラグメント間相互作用エネルギーの値でフラグメントを色付けします。前

述との違いは、分子構造をクリックした場合に基準のフラグメントは変化せず、クリック

した原子の情報がメッセージエリアに表示される点です。表示はそのままにしておき、

着目した原子の情報を得るのに使用します。このモードの場合は、残基、原子の選

択は不可となり、表示属性の変更もできません。 
 
 N:1 基準となるフラグメントを複数指定して指定されたフラグメント群とのフラグメント

間相互作用エネルギーの値でフラグメントを色付けします。指定画面を図 2.58 に指

定します。基準となるフラグメントは、3D 表示上でシフトを押しながらフラグメントを選

択するとその間のフラグメントが選択されます。Tree 図上で選択、テキスト入力で指

定することも可能です。 
複数のフラグメントを指定する場合は、”,”または”－”で連続する番号を指定してくだ

さい。 

 

図 2.58 N:1 のフラグメント間相互作用エネルギー表示の指定画面 

 N:N 基準となるフラグメントと対象とするフラグメント両方を複数指定して、その間の

フラグメント間相互作用エネルギーの値をメッセージエリアに表示します。指定画面を

図 2.59 に指定します。3D 表示、Tree 図より選択する場合は入力フィールド前の○

をチェックしてください。チェックしてある入力フィールドに指定が反映されます。 
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図 2.59 N:N のフラグメント間相互作用エネルギー表示の指定画面 

 List  リスト表示する値の種別を選択後、指定されたフラグメントと各フラグメント間の

相互作用エネルギーの値をリスト表示します。この内容をファイルに格納することも可

能です。ファイル格納は、メニューバーの File→Save を選択しファイル名を指定しま

す。フラグメントが側鎖の場合には、残基名の表示に”_s”が付加されます。図 2.60
に表示例を示します。 
PIEDA を選択した場合は、total, ES, EX, CT+mix, DI, Solvent を表示します。 

  

図 2.60 List の指定画面、リスト表示の画面例 

 3 Body List 多体項の計算値の三体項の値と、その構成フラグメント番号を表示しま

す。表示されたリストをクリックすると、該当のフラグメントがハイライト表示されます。リ

スト表示は、エネルギー計算レベル、ソート対象、最大値、最小値を指定し

て、”Apply”ボタンをクリックするとその条件でリストが表示されます。表示例を図 
2.61 に示します。 
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図 2.61 三体項の値リスト表示の画面例 

 4 Body List  多体項の計算値の 4 体項の値と、その構成フラグメント番号を表示し

ます。表示されたリストをクリックすると、該当のフラグメントがハイライト表示されます。

リスト表示は、エネルギー計算レベル、ソート対象、最大値、最小値を指定し

て、”Apply”ボタンをクリックするとその条件でリストが表示されます。表示例を図 
2.62 に示します。 

 

図 2.62 四体項の値リスト表示の画面例 
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1 対 1 のフラグメント間相互作用エネルギーの値でフラグメントを色付けする Tripcage の例で、

Fragment Value:main+side chainをチェックした場合としない場合の表示例を示します。この例

では、フラグメントが、主鎖、側鎖で別に切られています。画面上部の SER20 が、図 2.63 では、

それぞれのフラグメント値で表示されていますが、図 2.64 では、残基ごとに主鎖＋側鎖の値で色

付けされます。 

 

図 2.63 フラグメント間相互作用エネルギー フラグメントの値で色づけ 

 

図 2.64 フラグメント間相互作用エネルギー 残基ごとに色づけ 
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2.2.8 Edit 編集機能 

 

図 2.65 Edit メニュー 

♦ Cut(selected) 選択されている対象を削除します。 
♦ Cut(unselected)  選択されていない対象を削除します。 
♦ Undo 削除を取り消します。 
♦ Redo 削除を再実行します。 

 

2.2.9 Preferences プリファレンス指定 

 

図 2.66 Preference メニュー 

♦ Set Preferences 表示指定の画面を表示します。指定画面を図 2.67 に示します。タブ

により指定項目を切り替えます。入力フィールドの右の値は推奨範囲です。解像度を上げ

ると表示はきれいになりますが、表示時間、メモリを多く使用します。指定後”Apply”ボタン

をクリックすると指定が反映されます。 

 

図 2.67 Preference 表示指定画面 

1) ファイルメニュー 
ファイルメニューの Open,Save でこの設定のファイルの読み込み、格納ができます。起

動時にはカレントディレクトリ、ホームディレクトリの順で” .bioViewer”という名称のファイ

ルを読み込みます。もしファイルがあればその設定が反映されます。 
Set Default Value でデフォルトの値が設定されます。 
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2) Rotation 
① Speed ＶｉｅｗＰｏｉｎｔの Rotation を選択した場合の回転速度を指定します。 

3) Projection 
投影法を指定します。Parallel の場合はマウスでの拡大縮小ができなくなります。

ViewpointメニューのRotation/Transration/Magnifyで拡大縮小を行ってください。 
4) Connect Atom 

ボンドの表示判定をファンデル・ワールス半径、共有結合半径のどちらを使用するかを

指定します。Scale を指定することにより判定値を scale up/down することができます。 
5) Resolution 

① Line Width ： ワイヤーフレーム表示の太さを指定します。 
② Cα Line With ： Cα [Line]表示の表示の太さを指定します。 
③ Ball ： ボールアンドスティック表示の解像度を表示します。 
④ Sthick ： スティック表示の解像度を表示します。 
⑤ CPK ： 空間充填モデルの解像度を表示します。 
⑥ Tube ： Cα [tube]表示の解像度を表示します。 
⑦ Ribbon Width ： Ribbon 表示の幅 
⑧ Ribbon Height ： Ribbon(Solid)表示の高さ 
⑨ Ribbon Line Width ： Ribbon(Line)の線の幅 
⑩ Cartoon α Head Height ： Cartoon のαの円錐の高さ 
⑪ Cartoon α Radius ： Cartoon のαの胴の半径 
⑫ Cartoon width ： Cartoon の幅 
⑬ Cartoon β Height ：Cartoon のベータの高さ 
 

6) Radius 
① Ball ： ボールアンドスティック表示のボールの大きさを指定します。 
② Bond ： ボールアンドスティック表示のボンドの太さを指定します。 
③ Stick ： スティック表示の太さを指定します。 
④ Tube ： Cα [tube]表示の Tube の太さを指定します。 
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7) Color 
① Background ： 表示の背景色を指定します。 
② Atom ： 各原子の表示色を指定します。指定画面を図 2.68 に示します。 

 

図 2.68 原子の表示色指定画面 

③ Residue ： 各残基の表示色を指定します。指定画面を図 2.69 に示します。 

 

図 2.69 残基の表示色指定画面 
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④ Fragment ： フラグメントの表示色を指定します。指定画面を図 2.70 に示しま

す。フラグメント、チェーン、ファイルは 8 色でサイクリックに色付けされます。 

 

図 2.70 フラグメントの表示色指定画面 
⑤ Chain ： チェーンの表示色を指定します。デフォルトの色はFragmentと同じで

す。 
⑥ File ： ファイルの表示色を指定します。デフォルトの色は Fragment と同じで

す。 
⑦ DNA：DNA のＡＴＧＣの表示色を指定します。指定画面を図 2.71 に示します。 

 

 図 2.71 DNA の表示色指定画面 

⑧ Isosurface ： 等値面の色を指定します。指定画面を図 2.72 に示します。 

     

 図 2.72 等値面の表示色指定画面 
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⑨ 2nd Structure：2 次構造の色を指定します。指定画面を図 2.73 に示します。 

 

図 2.73 2 次構造の表示色指定画面 

⑩ Selected ： 選択項目の色を指定します。 
⑪ IFIE：IFIE の色を指定します。指定画面を図 2.74 に示します。 

      

 図 2.74 IFIE の表示色指定画面 

8) Arrow：ベクトル表示の形式を指定します。”Apply”ボタンをクリックすると表示が変わり

ます。指定画面を図 2.75 に示します。 
Arrow(Trajectory) : トラジェクトリーのベクトル表示の形式を指定します。 
Arrow(Dipole moment HF) : HFのDipole momentのベクトル表示の形式を指定し

ます。 
Arrow(Dipole moment MP2) : MP2 の Dipole moment のベクトル表示の形式を指

定します。 
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図 2.75 ベクトル表示形式指定画面 

 
① Display 矢印の表示の有無を指定します。Dipole moment は、Ｔｏｏｌメニューで

表示を制御するのでこの項目はありません。 
② Style 形式を指定します。 

1. Radius 矢印の頭と胴体の太さを指定します。 
2. Head Length 矢印の頭の大きさを、固定にするのか全体に対する割合に
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するのかを指定します。 
3. Scale 矢印の長さのスケールを指定します。ファイルに記述のあるベクトル

の長さで表示します。表示の 1 の長さは 1Åです。 
③ Color 色付けを指定します。 

1. Value 最小値、最大値を指定して、青→緑→赤に変化させます。 
2. One color 指定した単一色で色付けします。 

 
9) Numbe of decimal：3D 表示の角度、距離、IFIE の値の小数点以下の桁数を指定し

ます。”Apply”ボタンをクリックすると次の指定から表示が変わります。指定画面を図 
2.76 に示します。 

 

図 2.76 小数点以下桁数指定画面 

 
10) CHPI CHPI の結果表示の形式を指定します。指定画面を図 2.77 に示します。 

① Model 表示形式を Line Solid/Line Dash/Stick から選択します。 
② Color 色を指定します。 
③ Line Width 線の太さを指定します。 
④ Stick Radius Stick の半径を指定します。 

 

図 2.77 CHPI 指定画面 

 
11) Multi Layer QM/MM の層ごとの表示色を指定します。指定画面を図 2.78 に示しま

す。 
① High Layer Color High Layer の色を指定します。 
② Middle Layer Color  Middle Layer の色を指定します。 
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図 2.78  Multi Layer 指定画面 

12) Font フォントサイズを指定します。 

 

図 2.79  フォントサイズ 指定画面 

 
♦ Display Axis 座標軸を画面の左下に表示することの有無を指定します。 
♦ Display Direction ファイルごとのキーによる移動方向を表示の有無を指定します。 

 

2.2.10 Help ヘルプ機能 

♦ View Help(Japanese/English) Web ブラウザを起動してマニュアルを表示します。（日

本語、英語） 
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2.3  断面指定 
格子データを読み込んだ場合は、Section→Set ボタンを押下することで任意の断面を表示可

能です。格子データを読み込んだ場合は、その断面表示化可能です。断面指定は GUI 上より、

中心点の指定、回転角の指定または断面の法線ベクトルで行います。断面表示形式はフリンジ、

等値線が選択でき、入力するファイルの値により色付けされます。色付けの範囲も指定できます。

複数の断面の表示が可能です。図 2.80 に断面指定の説明図を、図 2.81 に断面指定画面を示

します。 
表示指定を次に説明します。 
• No. 

指定している断面の番号を示します。”Add”ボタンをクリックすると断面指定が追加されます。

断面指定は 3D 表示で白の半透明の面で表示されます。”delete”ボタンをクリックするとそ

の番号の断面が削除されます。 
• Assign Section Plane 断面の位置指定。タブで Center と Angle を切り替えます。 

 Center 
断面の中心点の座標(X,Y,Z)を指定します。スライダーによる指定か、座標を入力してリター

ンキーを押すことにより断面が移動します。 
 Angle  
スライダーによる指定(Rotation)と断面の 
法線ベクトル(Vector)のいづれかで指定で 
きます。スライダーによる指定では、面の 
紫の軸を中心にＡが、オレンジを中心にＢが 
回転します。Ｃは、面に垂直な軸を中心に 
回転します。 
 法線ベクトルは、x, y, z の値を入力して 
リターンキーを押すことにより移動します。 
 Set Plane 
xy,yz,xz 平面の断面を表示します。 

図 2.80 断面の指定の説明図 

• Section Property 断面の表示形式指定 
 Display  
表示の有無を指定します。 
 Value  
表示する物理量を選択します。 
 Color Range 
色付けの値の範囲を指定します。 

A 
C 

(X,Y,Z) 

[x, y, z] 

B 
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 Type 
フリンジか等値線かを指定します。 
 Transparency 
フリンジの透明度を指定します。 
 Number of Lines 
等値線の数を指定します。分子軌道の場合は±1e-8 を 0 として処理しています。 
 Draw 
”Draw”ボタンをクリックすると断面が表示されます。 

 

図 2.81 断面指定画面 
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2.4 トラジェクトリー機能 
File→Open Fileでトラジェクトリｰファイルを選択すると時系列に構造変化が表示されるトラ

ジェクトリー表示ができます。 

2.4.1 ファイル形式 

ファイル形式は 2 つあります。 
1) 拡張子は、trj です。trj は各ステップのエネルギーの値を含んだファイルです。はじめに原子

数を記述し、その後はステップごとのエネルギーの値、各原子の座標を記述します。エネルギーが

ない場合は０を記述しておいてください。 
#は行末までコメントです。 

2008年 12月にフラグメント識別のため、行の最後にフラグメント番号の記述を追加しまし

た。フラグメントの必要が無ければ記述が無くてもかまいません。 

ファイル読み込み前に、Color->Fragment を選択すると、フラグメント単位で色づけされた

表示で時系列の表示が可能です。 

ファイル例 

1000      #原子数 

# step 0 

9.87654 #エネルギー 

O 1.23345678 1.23345678 1.23345678 

H 1.23345678 1.23345678 1.23345678 

N 1.23345678 1.23345678 1.23345678 

C 1.23345678 1.23345678 1.23345678 

..... 

# step 1 

9.87654 #エネルギー 

O 1.23345678 1.23345678 1.23345678 

H 1.23345678 1.23345678 1.23345678 

N 1.23345678 1.23345678 1.23345678 

C 1.23345678 1.23345678 1.23345678 

..... 

 
フラグメント番号ありの例 
1000      #原子数 

# step 0 

9.87654 #エネルギー 

O 1.23345678 1.23345678 1.23345678 1 

H 1.23345678 1.23345678 1.23345678 1 

N 1.23345678 1.23345678 1.23345678 1 

C 1.23345678 1.23345678 1.23345678 2 

..... 

# step 1 

9.87654 #エネルギー 

O 1.23345678 1.23345678 1.23345678 1 
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H 1.23345678 1.23345678 1.23345678 1 

N 1.23345678 1.23345678 1.23345678 2 

C 1.23345678 1.23345678 1.23345678 2 

..... 

 
2) 新トラジェクトリ－ファイル 
拡張子は、trj2, tj2, tr2のいずれかです。XYZ形式の拡張です。ステップごとに原子数、コメント、

原子の座標、ベクトル値が記述されています。コメントは、タグ、値の組で表現し、この値でグラフを

表示します。タグが Label の場合は 3D 表示のテキストとなります。タグと値の間に”=”を挿入し、項

目間は”,”があってもかまいません。ベクトルの表示属性の変更は Preference 指定の Arrow を参

照してください。 
例 
8 
label="MD step 1" Ekin(Ha)=0.0000000000 Epot(Ha)=-31.6395526318 Etot(Ha)=-31.6395526318 
Fmax(Ha/bohr)=0.1505408174 
Si 0.8686973703168 0.5700826492704 0.67866982056 -0.090561 0.076468 -0.082145 
Si 4.6421015726304 4.7235419510976 4.75068874392 0.026857 0.018088 0.002683 
Si 0.67866982056 3.4204958956224 3.5019362740896 -0.022970 0.000783 -0.024173 
Si 4.75068874392 2.03600946168 2.03600946168 0.032733 -0.001620 -0.002599 
Si 3.4204958956224 0.7872569918496 3.3933491028 -0.012222 -0.029104 -0.017059 
Si 1.764541533456 4.886422708032 2.03600946168 0.101043 -0.077951 0.079853 
Si 3.5019362740896 3.3933491028 0.7058166133824 -0.050445 -0.000565 0.003814 
Si 2.03600946168 2.0088626688576 4.6421015726304 0.015567 0.013899 0.039625 
8 
label="MD step 2" Ekin(Ha)=0.0000001274 Epot(Ha)=-31.6395536508 Etot(Ha)=-31.6395535234 
Fmax(Ha/bohr)=0.1505348131 
Si 0.868696441081553 0.570083434040259 0.678668977580644 -0.090558 0.076465 -0.082141 
Si 4.64210184833175 4.72354213683881 4.75068877143722 0.026857 0.018087 0.002683 
Si 0.678669585076125 3.42049590356006 3.50193602590547 -0.022970 0.000783 -0.024173 
Si 4.75068907994755 2.0360094452755 2.03600943522114 0.032732 -0.001620 -0.002599 
Si 3.42049577020739 0.787256693393632 3.39334892764233 -0.012222 -0.029103 -0.017058 
Si 1.76454257011423 4.88642190844518 2.03601028084638 0.101040 -0.077948 0.079849 
Si 3.50193575655425 3.39334909697905 0.705816652541516 -0.050443 -0.000565 0.003814 
Si 2.03600962149153 2.00886281120628 4.64210197903853 0.015567 0.013899 0.039623 
….. 
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2.4.2 表示指定 

メイン画面のメニューバーの File→Open File でトラジェクトリｰファイルを指定して入力してくだ

さい。ファイル読み込み時に表示処理を行います。ステップ数、原子数、表示形式に比例して処理

時間がかかります。処理時間の目安は、Pentium 4 2GHz、100原子、100ステップ、ワイヤーフレ

ームで 25 秒、ボールアンドスティックで 40 秒です。処理が終わると図 2.82 に示すトラジェクトリー

操作画面が表示されます。グラフ用のデータがファイルに記述されていた場合はそのグラフを縦に

並べて操作パネルの上に表示します。 

    

図 2.82 トラジェクトリー操作画面 

 
1) メニューの説明 

• File メニュー 
♦ Create image files 

ビデオファイル作成用の各ステップの表示イメージを jpeg 形式で imageXXX.jpgのファ

イル名で指定されたディレクトリに格納します。XXX には通し番号が入ります。このメニュ

ーを選択するとディレクトリ指定の画面が表示されます（図 2.83）。Output Folder にフ
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ァイルを格納するフォルダーを指定してください。Screen Size を指定して Apply ボタン

をクリックすると 3D 表示が指定の大きさになります。表示の大きさによりビデオファイルの

容量が代りますので、必要に応じて調整してください。ここで、”Create”ボタンをクリック

すると各ステップが表示されファイルが作成されます。ただし、CPU、グラフィックカード

の性能によりコマ落ちすることがあるのでご注意ください。 

 

図 2.83 イメージファイル作成指定画面 

 
♦ Create Video File 

ビデオファイルを作成します。指定ダイアログを図 2.84 に示します。InputFolder は、

Create image files で作成した jpeg ファイルを格納しているフォルダを指定します。

Output File Name は、出力するファイル名を指定します。Frame Rate は、１秒あたり

のフレーム数を指定します。Video Format は、MSVIDEO/Quick Time のいずれかを

指定します。MSVIDEO は、ファイル容量が大きくなりますが、Power Point で貼り付け

て表示できます。Quick Time は、ファイル容量は小さくなりますが表示には Quick 
Time の Player が必要です。 
Create ボタンをクリックするとビデオファイルが作成されます。 

 

図 2.84 ビデオ作成指定画面 
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♦ Save Graph Image File 
表示されているグラフを、JPEG,PNG または Postscript ファイルとして保存できます。フ

ァイル選択画面で指定されたファイル名の拡張子で形式は判断します。 
♦ Close 

画面を閉じます。 
• Mode 

♦ Cyclic 
連続的に再生します。 

• Text 
3D テキストの表示属性を指定します。フォント、スタイル、サイズ、色、表示位置が指定可

能です。指定を変更して”Apply”ボタンをクリックすると変更が反映されます。図 2.85に指

定画面を示します。 

図 2.85 テキスト指定画面 

• Width 
♦ Ajust 

グラフ横軸の大きさを表示ウインドウの大きさに合わせて、全体が表示されるようにします。

デフォルトでは一定間隔で表示され、カレントのステップが見えるように表示されます。 
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2) 操作パネルの説明 
•  top 

先頭のステップを表示します。 
•  reverse 

逆再生します。 
•  back 

1 ステップ戻ります。 
•  stop 

再生をストップします。 
•  tail 

最後のステップを表示します。 
•  play 

順再生します。 
•  forward 

1 ステップ進めます。 
• Interval Time [sec] 

表示間隔を指定します。あまり小さな値を表示しても限界があります。 
• Current Step No. 

表示しているステップ番号を表示します。番号をキー入力してリターンキーを押すとそのス

テップが表示されます。ステップ番号は 0 から始まります。 
• スライダーバー 

表示ステップを指定します。 
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2.5 VISCANA 機能 
VISCANA（Visualized Cluster Analysis）は、あるタンパク質に対して、複数のリガンドを適

用したときの、それぞれのケースのタンパク質とリガンドとの相互作用の値により、クラスタ解析を行

い、その結果を表示するものです。 
複数の CPF ファイルを使用しますが、アライメント情報が無い場合は、フラグメント数は同じでな

くてはいけません。アライメント情報を使用した例は、チュートリアル 0 節に示します。 
VISCANA メニューを選択すると 図 2.86 の VISCANA 画面が表示されます。左側にクラスタ

解析の結果のデンドログラムを表示し、真ん中は、リガンド名を示し、バインディングエネルギーの

値で色付けされています。マウスをリガンド名の上に持っていくとバインディングエネルギーの値が

表示されます。右側は各フラグメントの相互作用エネルギーを示しています。 
マップ上にマウスを置くと、ポップアップの表記で、ファイル名、seq.は複数の Check Point File

（以下 CPF）間で共通となるアラインメント後の配列番号を、frag.=各 CPF 個別のフラグメント番号

を表示します。 
表示は 3D 表示と連動しており、右側のフラグメントをマウスで選択し、”3D Model View”ボタン

をクリックすると、3D 表示に構造が表示され、指定されたフラグメントが強調表示され、フラグメント

の位置がどこであるかが容易にわかるようになっています。(図 2.87) 
表示の下部は、”Data”,”Analysis”タブがあり、”Data”では表示指定を、”Analysis”では、クラ

スタ解析の値を表示します。 

 

図 2.86  VISCANA 画面 
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2GIU の 40 番のフラグメントを選択 “3D Model View”ボタンをクリック 

 

図 2.87 12 番のフラグメントを強調表示 

指定項目を説明します。 

2.5.1 メニュー 

• File メニュー 
♦ Load CSV File 

CSV ファイルを読み込み表示します。CSV ファイルの形式は、１行が 
  ファイル名, フラグメント 1 の値, フラグメント２の値, …フラグメント N の値 
であり、これが複数行続く形式です。 

♦ Save image 
表示された結果を PNG,Tiff または JPG ファイルに格納します。 

♦ Save CSV file (Raw data)  
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CPF によって読み込んだ各種相互作用エネルギーを生データとして切り出して出力す

る 
"1ERE H2O EST600","0.06704805904155364","0.004935882592690177","-0.004161305550951511","-0.003949102 

"1L2J ETC600","0.09012984097353183","-0.01233636905089952","-0.06828176585258916","-0.01509068469749 

"2I0G I0G1","0.017258612366276793","-0.001573896166519262","0.018046159180812538","0.007235390599817 

"1QKM GEN600","0.06880561851721723","-0.021663096427801065","0.014909053323208354","0.00948922598036 

"1U3Q 272501","0.03297848604415776","-0.022831991052953526","-0.029928279720479622","-0.030791792451 

図 2.88 Save CSV file (Raw data)の出力 

♦ Save CSV file (Raw data with cluster#) 
CPF によって読み込んだ各種相互作用エネルギーを生データとして切り出して出力し、

タイトル、クラスタ番号が出力される 
"Cluster","Title","GLU266(1)","GLN267(2)","LEU268(3)","VAL269(4)","LEU270(5)","THR271 … 

"1","1L2J","0.004422543410328217","-0.0017177658883156255","-0.00244106788886711","-0 … 

"1","2JJ3","-0.0029467978893080726","0.009508218805422075","0.00513503716501873","0.0 … 

"1","3OLS","-0.02434854664898012","0.016759303412982263","1.7115636728703976E-4","0.0 … 

"1","4ZI1","-0.010549071987043135","0.008117687830235809","-0.0062418528978014365","0 … 

"1","1YY4","-0.01569034659769386","-0.0017285672220168635","-0.01229054767463822","-0 … 

"1","2YJD","0.0018548246443970129","-0.016161552906851284","-0.01687829554430209","-0 … 

"2","1QKM","-0.01033311647188384","0.016623245552182198","-0.009609946864657104","-0.  … 

"2","1U3S","-0.029734298965195194","-0.002225780044682324","-0.018211634043836966","- … 

"2","1YYE","-0.03943274790071882","-0.0013379475567489862","-0.021705138933612034","- … 

"2","1U3Q","-0.03647428649128415","0.0033225355291506276","-0.02517848760180641","-0.  … 

"2","1U9E","-0.01673011857928941","-0.0054608482751064","-0.010434834490297362","-0.0 … 

"2","1X76","-0.0112376005272381","-0.0026311323599657044","-0.021413976384792477","-0 … 

"2","1X78","0.007286158637725748","0.010399236518424004","-0.010982639651047066","-0.  … 

"2","1X7B","-0.028911706773214974","0.002566304348874837","-0.011377972521586344","7.  … 

"3","1U3R","-0.029407480076770298","0.007906074039055966","-0.0059105008986080065","0 … 

"3","1ZAF","-0.027610782271949574","0.009124418895225972","2.941601269412786E-4","0.0 … 

"3","2QTU","0.023051065276376903","0.011827122478280216","-0.0036844993592239916","-0 … 

"3","2NV7","-0.04559103159408551","0.010739662931882776","-0.0036646668886533007","0.  … 

"4","2Z4B","0.023356488600256853","0.008737203490454704","-0.0036989772343076766","-0 … 

"5","2GIU","0.04086011557956226","-0.008129799374728464","-0.018197902871179394","-0.  … 

"5","3OMO","0.00813774490961805","-0.010438287048600614","-0.01630014342663344","-0.0 … 

"5","3OMQ","-0.01761319577053655","-0.013049710614723153","-0.021847352050826885","-0 … 

"5","3OMP","0.05095229222206399","-0.0370117163984105","-0.022769159768358804","-0.03 … 

図 2.89 Save CSV file (Raw data with cluster#)の出力 

♦ Save CSV file (filtered data) 
Base Fragment からの距離によって選択されたフラグメントに対する相互作用エネルギ

ーのみを出力する。ユーザーは出力ファイル名を指定（例：IFIE_filtered.csv）し、それ

に対応するファイル名（例：IFIE_filtered_fragment_number.csv）にて、インデックス

情報が出力される。出力されるインデック情報は、ポップアップの情報と同一である。 
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"1ERE H2O EST600","0.06704805904155364","0.004935882592690177","-0.004161305550951511","-0.003949102 

"1L2J ETC600","0.09012984097353183","-0.01233636905089952","-0.06828176585258916","-0.01509068469749 

"2I0G I0G1","0.017258612366276793","-0.001573896166519262","0.018046159180812538","0.007235390599817 

"1QKM GEN600","0.06880561851721723","-0.021663096427801065","0.014909053323208354","0.00948922598036 

"1U3Q 272501","0.03297848604415776","-0.022831991052953526","-0.029928279720479622","-0.030791792451 

a) 出力ファイル 

"1ERE H2O EST600","1;19;19","1;20;20","1;21;21","1;33;33","1;34;34","1;35;35","1;36;36","1;37;37","1 

"1L2J ETC600","2;19;17","2;20;18","2;21;19","2;33;30","2;34;31","2;35;32","2;36;33","2;37;34","2;38; 

2I0G I0G1","5;19;17","5;20;18","5;21;19","5;33;30","5;34;31","5;35;32","5;36;33","5;37;34","5;38;35" 

"1QKM GEN600","3;19;17","3;20;18","3;21;19","3;33;30","3;34;31","3;35;32","3;36;33","3;37;34","3;38; 

"1U3Q 272501","4;19;17","4;20;18","4;21;19","4;33;30","4;34;31","4;35;32","4;36;33","4;37;34","4;38; 

b) インデック情報 

図 2.90 Save CSV file (Raw data)の出力 

♦ Close 
この画面を閉じます。 
 

2.5.2 Data タブ指定 

1) CPF Data Directory 
VISCANA機能で表示するデータのディレクトリを指定します。”Directory”ボタンをクリックする

とディレクトリ指定画面が表示されます。”Load”ボタンをクリックするとファイルが読み込まれます。

ファイルが読み込まれると”View”ボタン、下のリガンド指定のボタンが有効になります。”View”
ボタンは、VISCANA の結果表示され、表示されているフラグメントを選択してクリックすると、

3D表示に構造が表示され、指定されたフラグメントが強調表示されます。結果ファイルは同じタ

ンパク質に異なるリガンドを適用し計算された CPF ファイル群で、アライメント情報が無い場合

は、フラグメント数は同じでなくてはいけません。アライメント情報を使用した例はに示します。 
 

2) データ選択(Data Select) 
クラスタリングに用いる IFIE の種類や PIEDA の成分を選択します。クラスタリング配列

の選択インターフェースを図 2.91 に、凡例への選択成分の表示例を図 2.92 に示します。 

  

図 2.91  クラスタリング配列の選択（左：IFIE、右：PIEDA） 
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図 2.92  クラスタリング配列の凡例への表示：IFIE, HF (Hartree Fock) の例 

3) クラスタパラメータ指定(Cluster Analysis) 

 

図 2.93  クラスタパラメータ指定 

• Base Fragment 
クラスタ分析の基準となりフラグメント番号を指定します。 

• IFIE/PIEDA(X) 
相互作用エネルギーの色付けの値の範囲、色を指定します。指定しない場合は、ファイル

から読み込まれた値の最大値、最小値を使用します。 
• Sum over X 

バインディングエネルギーの色付けの値の範囲を指定します。指定しない場合は、ファイ

ルから読み込まれた値の最大値、最小値を使用します。 
• Cluster Method 

クラスタ解析の手法を選択します。以下の手法が用意されています。 
 furthest neighbor 最長距離法 
 nearest neighbor 最短距離法 
 group average 群平均法 
 centroid 重心法 
 median メジアン法 
 Ward ウォード法 
 flexible フレキシブル法 

• Apply 
“Apple”ボタンをクリックすると、指定の値で再表示します。 

4) 表示フィルタ(View Filter) 
• Distance 

Base Fragment からの距離内にあるフラグメントのみを表示する。 
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• Distance Type 
距離内判定の方式を指定する 
Neaest Interatomic : 最近接の原子間距離 
Center of mass :  フラグメントの重心からの距離 

• Filter 
“Filter”ボタンをクリックすると、指定の値で再表示します。 

 

図 2.94 表示フィルタ指定 

5) 3D Model View 
選択されたフラグメントを 3D 表示で強調表示する。 

2.5.3 Analysis 

Cluster No を ON にすると、デンドログラムの表示領域のマウスの位置に、縦に黄色の破線が

表示されます。その位置でのクラスタ番号がデンドログラムの左に表示されます。所望の位置での

クラスタ番号を表示したい場合は、位置を決め、デンドログラムの上下から抜けるとその位置での表

示が維持されます。 

 

図 2.95 Analysis タブ 
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クラスタの指定は、デンドログラムの横線をクリックすると、選択されたクラスタ番号が”*”で表示さ

れ、その配下の番号が Cluster #1,2 のチェックボックスが有効な方に指定されます。指定された項

目名は、#1 がマゼンダ色に、#2 が緑色に表示されます。横線以外をクリックすると、選択が解除さ

れます。 

 

 

図 2.96 クラスタ選択 

Applyボタンをクリックすると、それぞれの IFIEの値の平均の差を計算し、その絶対値の大きい順に

Result に、フラグメント番号,値 が表示されます。リストをクリックすると該当フラグメントが黄色の枠

で表示されます。 

 

図 2.97 絶対値の大きい順に Result に、フラグメント番号,値を表示 
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2.6 IFIE MAP 表示機能 
IFIE MAP はフラグメント間の相互作用エネルギーの値で色づけされた２次元 MAP 表示で、

右、上に二次構造を色で表示します。表示は拡大縮小が可能で、マウスにより値に表示、３Ｄ表示

との連携が可能です。 
File->Open File でチェックポイントファイルを読み込みます。Monitor->IFIE MAP を選択し、

IFIE 表示画面を表示します。Apply ボタンをクリックすると IFIE MAP が表示されます。表示例を

以下に示します。 

 

図 2.98  IFIE MAP 表示画面 

表示指定項目を説明します。 
1)メニューの説明 

• File メニュー 
♦ Save image 

表示された結果を PNG/Tiff/Jpeg ファイルに格納します。 
♦ Save text 

表示された結果（インデックス、値）をテキストファイルに格納します。 
♦ Close 

この画面を閉じます。 
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2) 表示パラメータ設定 
表示パラメータは、タブを切り替えてそれぞれの属性を指定します。指定後”Apply”ボタンをクリ

ックすると表示が変更されます。 
• Display Value 

値指定のパネルを図 2.99 に示します。 

 

図 2.99  IFIE MAP 値指定画面 
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♦ Format 
３つの表示形式が選択できます。 

 

図 2.100  Format 指定 

 Separate(-/+) 
左にマイナスの値を、右にプラスの値を表示します。表示例を図 2.98 に示し

ます。 
 Symmetric  

マイナスの値、プラスの値を表示します。表示例を図 2.101 に示します。 
 Distance Matrix 

左に Symmetric 表示、右に各フラグメント間の距離を表示します。距離の基

準となる原子は次の項目で指定します。表示例を図 2.102 以下に示します。 
 

 

図 2.101 Symmetric 表示例 
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図 2.102  Distance Matrix 表示例 

♦ Value 
表示する値を選択します。CPF のバージョンにより選択できる項目がかわります。各

Version の選択画面を図 2.103 に示します。表示するエネルギーを選択し、”Apply”
ボタンをクリックすると、そのエネルギーで MAP が表示されます。 

    

a) Version1            b) Version2 
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          c) Version3,4.-4.2, 7.0           d) Version 4,201, 7.0-4.0, Open1.0 rev10 

  
e) Open1.0 rev21 では、記述されていないエネルギーはグレーアウトされる 

図 2.103 各 CPF での IFIE 選択値 

超分子計算結果を読み込んだ場合は、Super Molecule Step2 が有効になり、これを選択する

と超分子計算の Step2 の計算結果で MAP が表示されます。 
多体項の計算結果を読み込んだ場合は、Many Body Correction が有効になり、これを選択

すると多体項の補正値で MAP が表示されます。 
 
Verision3 の場合は、Compound-IFIE が選択可能で、図 2.104 が表示されます。これは、複数

の結果を足し合わせた値を表示するための指定画面です。Coefficient に係数を指定し、Value
を選択します。フラグメント数は同じである必要があります。 
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図 2.104 Value 指定(Version3 Compound) 

 
♦ Color 
 Auto 

Color(-),Color(+)の min,max に値を指定することにより色づけの範囲が指定で

きます。値のスケールは、Log/Linear が指定できます。Ｌｏｇで 0 を指定した場合

は 1e-10 に変更されます。 
Outside the range で、”Colored”を選択すると最大値、最小値の範囲外の値は

最大値、最小値の色で表示され、”None”の場合は色が付きません。 
 Custom 

指定した範囲内(min<max)の値を、指定した色で表示します。範囲外は白になり

ます。Color のところをクリックすると色指定画面が表示されます。表示例を図 
2.105 に示します。 
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図 2.105 Costum 表示例 

♦ Distance Matrix 
Ｄistanceのmin,maxに値を指定することにより色づけの範囲が指定できます。値のス

ケールは、Log/Linear が指定できます。Ｌｏｇで 0 を指定した場合は 1e-10 に変更され

ます。 
 

• Distance Matrix(Base atom) 
残基、DNA、その他で、Distance Matrix を計算するときに、どの原子を基準にするかを

指定します。 
1) Center of mass フラグメント重心 
2） The shortest interatomic 最短原子間距離 
3) Custom 個別指定 
CPF ファイル中の Atom Type 名を指定してください。DNA は、１DNA１フラグメントのと

きに、backboneまたは、baseのどちらかを基準にするか選択します。指定をしない場合は、

フラグメント重心を基準とします。 
others には、残基、DNA 以外のフラグメント要素の場合にどの原子を基準にするかを指

定します。指定方法は “フラグメント番号：原子名“ です。複数ある場合は空白で区切っ

て、複数記述します。記述例 222:C3’ 244:P 
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図 2.106  Distance Matrix 表示例 

• Fragment Order 
MAP 上のフラグメントの表示の順番を指定します。 
All は、全てのフラグメントの指定で、Chain はチェーンごとの指定が可能で、チェックボッ

クスでチェックのついているチェーンを表示します。各入力フィールドに、入力された順に

表示されます。以下の指定が可能です。 
1) 開始フラグメント番号―終了フラグメント番号：増分 
  指定されたフラグメントがはじめに表示されます。空白で区切り、複数範囲の記述が 
  可能です。 
  example 200-220:2 
2) 残基名指定 
  GLY, ASP 等の 3 文字で残基名を指定すると、その残基が表示されます。 
  空白で区切り、複数範囲の記述が可能です。(Ａｌｌのみ有効) 
♦ Clear fragments 

指定をクリアします。 
♦ Set Default 

デフォルトの値を設定します。 
 
 Add fragments in range 

All,Chain でフラグメント番号を指定するための補助機能です。 
この画面を表示中に、3D 表示で、構造をクリックするとそのフラグメント番号が No. 
に表示されます。フラグメントは、複数指定可能です。Åにそのフラグメントからの

距離を指定して、”Add”ボタンをクリックすると、範囲内にあるフラグメントが、フラグ
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メント指定のフィールドに追加されます。 
“Center of mass”は、フラグメントの重心で比較し、”The shortest interatomic”
は、最短原子間距離で比較します。 

 Sort by base/backbone(DNA) 
DNA の場合に、base/backbone の順にソートされ、表示されます。 

 Sort by Main/Side Chain 
多体計算の場合に、主鎖／側鎖の順でまとめて表示されます． 

 

図 2.107  IFIE MAP Fragment Order 指定画面 

• Graph 
横軸にフラグメント番号、縦軸に IFIEの値を表示するグラフを表示します。Fragmentsに、

フラグメント番号を指定します。複数のフラグメント番号が指定された場合は、その和を表

示します。Label は、グラフ上の凡例に表示されます。IFIE の値の最大値、最小値も指定

可能です。”Draw Graph”をクリックするとグラフが表示されます。表示を図 2.109 に示し

ます。 



79 

 
図 2.108  IFIE MAP Graph 指定画面 

 

 

図 2.109  IFIE グラフ表示例 

マウスを表示上に置き、しばらくすると、該当のフラグメント番号、エネルギーの値が表示されます。 
File メニューで以下の動作が可能です。 
 

♦ Load CSV file 
Save CSV file で格納した形式のファイルをロードして表示します。 

♦ Save CSV file 
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CSV 形式でファイルを格納します。 
♦ Save Image 

表示を png,jpg,tiff 形式で格納します。 
 
3) 操作説明 

• Apply 
設定された表示形式で MAP を表示します。 

• Reset 
表示を初期状態に戻します。 

• 拡大、縮小、表示領域移動 

 ボタンをクリックすると、拡大、縮小、上下左右に表

示領域が移動します。 
• Structure Note 

表示の横と上に、2 次構造または、チェーンを表示します。 
• マウスにより拡大領域指定 

マップ表示上でマウスの左ボタンを押してドラッグするとラバーバンドが表示されボタンを

離すと拡大表示されます。 
• 値表示 

マウスを表示上に置き、しばらくすると、該当のフラグメント番号、エネルギーの値が表示さ

れます。 

 
• 対象フラグメントハイライト表示 

表示上でマウスの右ボタンをクリックすると、3D 表示で該当フラグメントがハイライト表示さ

れます。 
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2.7 FILM 等値面表示 
FILM の計算結果として、フラグメントペアごとの結果ファイルを読み込み、軌道を指定して、等

値面を表示します。まず計算を行った構造のファイルを読み込んでください。その後 Monitor→
FILE isosurface を選択してください。表示指定画面が表示されます。 

 

図 2.110  FILM 表示指定画面 
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表示指定項目を説明します。 

1)メニューの説明 
• File メニュー 

♦ Close 
この画面を閉じます。 

2) 表示パラメータ 
• Data Directory 

結果ファイルの格納されているフォルダを指定します。結果ファイル名は、xxx_n_m.lmp2
です。（xxx:任意、n.m フラグメント番号）。フォルダが指定されたら、そのフォルダ配下の

*.lmp2 ファイルを読み込み Fragment Pair へ表示します。 
• Fragment Pair 

読み込み可能なフラグメントペアを表示します。選択すると、そのフラグメントペアの軌道が

Orbital に表示されます。”Highlight fragments in 3D graphics”ボタンをクリックすると

対称のフラグメントが 3D 表示でハイライト表示されます。 
• Orbital 

Sort by energy で、Inter Fragment/Inner Fragment/All/None を選択します。Inter 
Fragment は、フラグメント間の軌道の組でエネルギーの順にリストが表示されます。

Inner Fragment は、フラグメント内の軌道の組でエネルギーの順にリストが表示されます。

All は、全体での軌道の組でエネルギーの順にリストが表示されます。None は、個別に軌

道を選択します。選択された軌道番号が Selected pairs に表示されます。また、選択され

た軌道間のエネルギーの和が Calculate Energy に表示されます。軌道は複数選択可能

です。 
Maximum number of pairs list 表示する軌道ペアの最大数、リターンキーで表示に

反映されます。 
Selected orbitals は、選択された軌道の初めの軌道番号が設定されます。 
Sum of Energies に、選択された軌道と、他の軌道の値の総和が表示されます。 
値は、Sort by energy の選択肢により、積算対象が Inter/Inner/All になります。 

Selected orbitals は、編集可能であり、リターンキーで Sum of Energies が計算され表

示されます。 
from 3D をチェックすると、3D 表示で、原子をクリックすると、その原子が関係している軌

道が、Selected pairs に表示されます。 



83 

 

図 2.111  Inter Fragment の軌道リスト表示の例 

 

図 2.112  個別指定の軌道リスト表示の例 

• Display Matrix 
軌道間のエネルギーのマトリックス表示を別ウインドウで表示します。対象フラグメント順に

そのフラグメントに含まれる軌道の値を示します。値は赤→白で色付けされます。最小、最

大値を変更し、”Apply”ボタンをクリックする色付けの範囲を変更して再描画します。マウス

をマトリクス上で止めると、軌道のインデックスと値が表示されます。クリックすると対象軌道

が Selected Orbitals に設定されます。コントロールキーを押しながら選択すると、対象

軌道が追加されます。表示例を図 2.113 に示します。 
表示 type は、”Inner Fragment”、”Inter Fragment”、”All”から選択できます。 
Menu の Save Image を選択すると表示画面を PNG,Tiff,JPG に格納できます。 
軌道リストで選択されている組を緑の枠で表示します。 

• Isosurface Parameter 
等値面の表示指定を行います。それぞれのフラグメントごとの色の指定が可能です。 
複数の軌道を表示するとき位相が逆で、色が逆に表示される場合は、以下の手順で、そ

れぞれの軌道の色を指定できます。 
“Set”ボタンをクリックすると、等値面の設定が、選択されている軌道に設定されます。等値

面を表示して、色が反転している場合は、表示色を反転させて(-,+)、その設定を適用する

Fragment の”Set”ボタンをクリックします。それぞれの軌道についてこの設定を行い、最
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後にまとめて表示すると所望の色で表示することが可能です。 
• Draw 

等値面を表示します。選択されているすべての軌道の等値面を表示します。 
• Delete 

等値面を表示から削除します。 
 

 
a) マトリクス表示(39,19)をクリック 

  
b) MAP で選択された軌道がリストでも選択される 

図 2.113  マトリクス表示例 
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図 2.114  FILM 等値面表示例 



86 

2.8 ABINIT-MP 入力ファイル作成 
File→Edit ABINIT-MP Input File を選択すると ABINIT-MP 入力ファイル編集画面が表示さ

れます。ABINIT-MP Open 1.0 rev.10 の ABINIT-MP に対応した入力ファイルの編集を行えま

す。入力ファイルのネームリストの名称がタブになっており、各項目の指定値を入力します。

CNTL,FMOCNTL,SCF,BASISが、FMO計算の主なパラメータで、その他は必要に応じて設定

してください。ABINIT-MP 入力ファイル編集画面を図 2.115 に示します。 
Control タブの Read Geometory File に表示している構造のファイル名がデフォルトで設定さ

れますが、実行時には、必要に応じて、計算サーバ上でのパスに変更してください。 
 

 

図 2.115  ABINIT-MP 入力ファイル編集画面 

各項目の詳細は別ファイル ABINIT-MP プログラム説明書を参照してください。ここでは、File メ

ニューと、3D 表示と連携機能のある、フラグメント編集機能（FMOCNTRL）、フラグメントペア指定

（FRAGPAIR）について説明します。 

2.8.1 File メニュー 

入力ファイルに関するオペレーションを File メニューで行います。 
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図 2.116  ABINIT-MP 入力ファイル編集画面 File メニュー 

1) Open File  
読み込む入力ファイルを指定します。 

2) Save File 
格納する入力ファイルを指定します。 

3) Set Defaults Value 
入力フィールドにデフォルト値を設定します。 

4) Close 
入力画面を閉じます。 

 

2.8.2 フラグメント編集機能（FMOCNTRL） 

FMOCNTRL タブを選択するとフラグメント指定に関するパラメータの入力画面が表示されます。

Auto Fragmentation は、フラグメント分割方法の指定で On/Off/Hybrid の 3 つのモードがあり

ます。 
1) On 自動分割でフラグメントを生成します。必要なパラメータを指定します。 
2) Off フラグメントを自動分割後、フラグメントを手動で分割指定します。AJF ファイルには、フ

ラグメント分割のすべての情報が出力されます。 
3) Hybrid フラグメントを自動分割後、フラグメントを手動で分割指定します。AJF ファイルに

は、自動フラグメント分割後に、修正したフラグメントの情報が出力されます。手動で分割し

その分だけ確認したい場合は、こちらが便利です。 
”On”選択時 の画面を図 2.117 に、 “off” または、”hybrid”を選択時の画面を図 2.118 に示

します。 “Set Fragmentation” ボタンをクリックするとフラグメント編集画面が表示されます。 
hybrid を使用した編集の例をチュートリアル 4.4、0 節に説明します。 
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図 2.117 Auto Fragmentation の“on”選択時 

 
図 2.118  Auto Fragmentation の”Off”/“hybrid”選択時 

 
フラグメント編集画面は、上部に、フラグメントの情報、下部に編集の４つのタブで構成されます。

画面を図 2.119 に示します。 
a) フラグメントの情報 
フラグメントの情報として、フラグメント番号、形式電荷、そのフラグメントに結合電子割り当てたフ

ラグメント間の結合本数、フラグメント境界の BDA-Connected Atom、フラグメントを構成する原子

の番号、Molecular Weight を表示します。 フラグメント番号は、ボタンになっていて、クリックする

と該当フラグメントが、3D 表示でハイライト表示されます。形式電荷は、ここで編集可能です。 
“Display All Information”は、Yes の場合はすべてのフラグメント情報を表実し。”No”の場合

は、編集されたものと HybridFrag に指定されたフラグメントのみ表示します（分子構造も）。

HybridFrag 指定後、”Apply”ボタンをクリックすると、指定されたフラグメントのみの表示に代わり

ます。編集されたフラグメントは、左端に”*”を表示します。HybridFrag に指定された番号は自動

分割時のフラグメント番号です。 
 “Fragment Position by sort”は、Hybridの場合の編集されたフラグメントの挿入方法を指定

します。”YES”の場合は、フラグメントに含まれる水素以外の原子番号により、挿入位置を決定しま

す。”NO”の場合は、自動生成されるフラグメントの最後に追加します。 
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図 2.119  フラグメント編集画面 

b) 編集機能 
Generate Fragments/Merge Fragment/Create New Fragment/Add/Delete Bond の 4 つ

の機能がタブに分かれて指定できます。それぞれのフラグメント指定は、3D 表示または、Tree 表

示の原子をクリックすることにより、その原子のフラグメント番号または、原子番号が指定画面に設

定されます。原子指定では、入力フィールドをクリアしないと、追加されていきます。 
(1) Generate Fragments 

タンパク質の自動分割を行う場合は、”Auto”を、分割する原子を個別指定し自動分割を行う

場合（デンドリマー等）は、”Manual”を、結晶系の分子の自動分割は”Crystal”を選択してく

ださい。 
1) タンパク質の自動分割(Auto) 
パラメータを指定し、”Generate Fragment”ボタンをクリックすると、自動フラグメント分割を行

い、結果を表示します。“View Log” ボタンをクリックすると、自動分割実行のログファイルが

表示されます。フラグメント間の結合部分で電荷の受け渡しがある部分は、楕円球で表示され、

小さい球が結合電子をあらわしています。Add/Delete Bond タブに、形式電荷(Formal 
Charge)、結合電子を自分のフラグメントに割り当てたフラグメント間の結合本数
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(#Interfragment)が自動的に計算され表示されます。表示例を図 2.120 に示します。 
パラメータ 
Number of Residue for each Fragment １残基あたりのフラグメント数 
Polynucleotide ヌクレオチドを分割する場合に、塩基をフラグメントに分割するかどうかを指

定する。 
   Base+Suger+Phosphate : 塩基をフラグメントに分割しない。 
   Base/Suger+Phosphate : 塩基をフラグメントに分割する。 
   Base/Suger/Phosphate : 塩基、リン酸をフラグメントに分割する。 
Amino acid 自動フラグメント分割でアミノ酸を分割する場合に、側鎖でフラグメントに分割する

かどうかを指定する。 
   +amino : 側鎖をフラグメントに分割しない。 
   /amino : 側鎖をフラグメントに分割する。 
   +peptide : 主鎖をペプチド結合で分割する。 
    -peptide : 主鎖をペプチド結合で分割し、かつ側鎖を分割する。 
Carbone hybrid orbital 自動フラグメント分割で炭素鎖をする場合に、位置の結合での炭

素混成軌道を指定する。 
    sp3: sp3: -C-C-結合で分割する。 
    sp2: sp2: -C=C-結合で分割する。 
Rsolv イオンが周囲のフラグメントとマージされる際の距離（Å）の閾値 
Ligand Charge フラグメントごとにチャージを指定する 

 

 

図 2.120  Gly5 を自動分割した結果（フラグメントで色づけ） 
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2) 分割する原子を個別指定し自動分割（Manual） 
Start→Ｎｅｘｔの方向に原子を探索していき、Ｓｔａｒｔと同じ原子名のところで、分割します。 
3D 表示で、自動分割の開始点となる原子をクリックして、分割方向のその隣となる原子をクリッ

クします。原子名が”Start Atom”、”Next Atom”に表示されます。”BDA”は、分割点で、どち

らに電子を割り当てるかを指定します。”Ｉｎｔｅｒｖａｌ”は、Ｓｔａｒｔと同じ原子名が見つかったときに、

何個おきに分割点を設定するかを指定します。複数の分割方向がある場合は、”Add”ボタンを

クリックして、指定を追加してください。”Delete”ボタンをクリックすると表示されている指定が削

除されます。Si12H26 の指定例を図 2.121 に、分割後の表示例を図 2.122 に示します。

Si12H26 は、デフォルトの接続チェックでは、ボンドが認識できないので、メニューの

Preferences→Set Preference→Connect Atom の Scale を a.3 にして、”Apply”ボタンをク

リックしてください。 
 

 

 

図 2.121 個別指定の自動分割指定例 

 

図 2.122  Si12 を自動分割した結果 

Ｓtart Atom(17) 
Next Atom(20) 
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3) 結晶系の分子の自動分割(Crystal） 
パラメータを指定し、”Generate Fragment”ボタンをクリックすると、自動フラグメント分割を行

い、結果を表示します。 
Crystal（residue name） pdb ファイル中の結晶部分を残基名で指定する。残記名は英数字

記号（空白を含む）3 文字で指定する。残基のグループ分けに使用。 
Minimun atoms to marge Detail Fragmentation で指定されたフラグメント分割を行った

際、ここで指定した数より少ない原子のフラグメントは自動的にマージされる。 

 

図 2.123 結晶系の分子の自動分割の指定例 

 
SiO2 を 5x5x2 配置した分子＋ペプチドをフラグメント分割する例を以下に示します。 

 

図 2.124 SiO2 を 5x5x2 配置した分子＋ペプチドの自動分割指定と結果 
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(2) Marge Fragment 
Base Fragment に指定されたフラグメントに、フラグメントまたは原子をマージします。Base 
Fragment の入力フィールドをクリアすると、3D 表示または、Tree 表示で、クリックされた原子

のフラグメント番号が設定されます。ラジオボタンで選択されているほうにクリックされた原子の

フラグメント番号または、原子番号が設定されます。 

 
 
(3) New Fragment 

指定された原子で、新しいフラグメントを作成します。Edit Bond を YES にすると、Create 
New Fragment クリック後、次の Add/Delete Bond タブが表示されます。ここで、作成したフ

ラグメントの相手フラグメントが作成されている場合は、YES にして、BDA の設定を行ってくだ

さい。リガンドのフラグメント等新しくフラグメントを作成する場合は、Edit Bond を NO にしてお

き、全てのフラグメントを作成してから BDA の設定を行ってください。 

 
 
(4) Add/Delete Bond 

フラグメント間の結合を指定します。“Display All Information”は、Yes の場合はすべてのフ

BDA 情報を表示し。”No”の場合は、編集された BDA 情報のみを表示します。フラグメント間

で、BDA(Bond detached Atom)がある場合、2 つの原子をクリックして、”Add”ボタンをクリッ

クすると結合が追加されます。形式電荷は Bond Detached Atom から Connected Atom へ

割り当てられます。 
3D 表示の結合か、結合のリストを選択し、”Delete”をクリックすると結合が削除されます。必要

に応じて形式電荷(Formal Charge)を編集してください。 
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注意！！ 

• フラグメント間で接続があり、BDA が指定されていない場合は、パラメータファイル出力時

にエラーになりますので、必ず指定してください。エラーがある場合は下記のメッセージが

表示されます。 

 

図 2.125  結合が指定されていない場合のエラー表示 

• フラグメント編集画面を閉じると、3D の結合表示が消えます。 
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2.8.3 フラグメントペア指定（FRAGPAIR） 

BSSE 計算で使用する、フラグメントペアを指定します。指定画面を図 2.126 に示します。 

 

 

図 2.126 フラグメントペア指定画面 

 
1) Add fragment # that picked in3D viewer 

3D 表示でフラグメントをクリックしたときにその番号を、カーソルのあるテキストエリアへ表示す

る場合は、On を選択してください。 
2) Range 

指定された範囲内にあるフラグメント同士のペアをリストに表示します。 
3) Group 

Group1、Group2 に指定されたフラグメント間のペアをリストに表示します。Enable Inner 
Fragment を On にすると、Group 内のフラグメント間もペアの対象とします。 

4) Get Fragment Pair 
上記で指定されたフラグメントペアのリストを Fragment Pair List へ表示します。 

5) Fragment Pair List 
フラグメントペアのリストの表示。入力ファイルへは、このフィールドの内容が出力されます。手

で編集することも可能です。 
6) Highlight Fragments in 3D Viewer 

指定されたフラグメントペアを 3D 表示でハイライト表示します。 
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2.9 基本動作 

2.9.1 表示の拡大、縮小、回転、移動 

表示された図は拡大、縮小、回転、移動が可能です。各動作のオペレーションを表 2.1 に示しま

す。 

表 2.1 拡大、縮小、回転、移動のオペレーション(windows2 つボタン) 

動作 オペレーション 
拡大 Alt キーを押しながらマウスの左ボタンを押し、下の方向へマウスポイ

ンターを移動させる。 
縮小 Alt キーを押しながらマウスの左ボタンを押し、上の方向へマウスポイ

ンターを移動させる。 
回転 マウスの左ボタンを押し回転させたい方向へマウスポインターを移動

させる。 
移動 マウスの右ボタンを押し移動させたい方向へマウスポインターを移動

させる。 
 

2.9.2 分子構造の座標の回転、移動 

ファイルごとに分子構造の座標の回転、移動がキーボードからの入力に 
より可能です。このオペレーションでは、対象のファイルの分子構造の座標 
そのものが変更され、分子構造の編集に使用できます。 
移動中心点に右のような移動方向を示すマークを表示します。キーバインドは、 

移動 x 方向(－:z＋:x)、y 方向(－:c＋:v)、z 方向(－:b＋:n) 
回転 x 軸(－:a＋:s)、y 軸(－:d＋:f)、z 軸(－:g＋:h) 

です。回転、移動すると、その原子の座標も変化します。 
移動は、キーを押すごとに 1.0Å移動し、シフトキーを押しながらの場合は 0.5Å、コントロールキ

ーを押しながらの場合は 0.1Å移動します。回転は、キーを押すごとに 45°回転し、シフトキーを

押しながらの場合は 5°、コントロールキーを押しながらの場合は 1°回転します。 
回転、移動の中心はファイル入力時は、そのファイルの原子全体の重心です。特定の原子の座

標を回転中心とすることができます。中心とする原子をクリックして Tool メニュー Set File 
Rotation Center を選択すると、クリックされた原子の位置が移動中心となります。 
何も選択されていない状態で Tool メニューの Set File Rotation Center を選択すると、ファイル

ごとの重心に中心を再設定します。 
 

2.9.3 可視化領域の制御 

 マウスホイールで、表示前後のクリップ距離を制御し、クリップ範囲外は表示しないようにして、可

視化領域を制限することが可能です。表示例を図 2.127 に示します。オペレーションは、マウスホ

イールの移動量により、表示前後のクリップ距離を制御し表示領域を制御します。これにより、指定

z x 

c 

v 
n 

b 
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範囲外が表示されなくなり、対象分子のみの表示が可能となります。ただホイールを回したときは、

前の領域をクリップし、シフトキーを押しながらホイールを回したときは、後ろの領域をクリップする。 

コントロールキーを押しながらホイールを回したときはクリップ量を x 0.1 にします。Alt を押しな

がらホイールを回した場合はクリップをリセットします。 

 

 

 
上：標準の表示、下：前後をクリップ 

図 2.127 分子の可視化領域の制御例 
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2.10 対象選択方法 
  ３Ｄ表示上で、分子構造をクリックするとクリックされた原子の情報がメッセージエリアに表示され、

対象の構造が黄色で表示され、Tree 図で強調表示されます。一つの対象をクリックし、シフトを押

しながら別の対象をクリックするとその間の項目も選択されます。コントロールキーを押しながらクリ

ックするとクリックされた対象が追加で選択されます。表示例を図 2.128 に示します。 
  Tree 図の残基名、原子名をクリックする事により対象の選択が可能です。選択された対象は 3D
表示上で黄色で表示されます。一つの対象をクリックし、シフトを押しながら別の対象をクリックする

とその間の項目も選択されます。コントロールキーを押しながらクリックするとクリックされた対象が追

加で選択されます。 
 

 

図 2.128 原子選択の例 
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2.11 表示形式等の指定 
  右ボタンで表示対象をクリックした場合はその対象の、表示有無、表示形式、色、ラベル表示指

定の画面がポップアップし各種指定がおこなえます。原子の指定画面を図 2.129 に、残基の指定

画面を図 2.130 示します。指定対象は、Tree 図の項目を左ボタンでクリックして選択し、右ボタン

でクリックする事により指定画面を表示する事もできます。Atom/Structure 両方に指定は適用さ

れます。 
 
Display : 表示の有無を指定します。 
Model : 残基の場合、表示形式を None、Wire Frame、Wire Frame with Fragment Bond、 

 Ball&Stick, Stick、Ball&Wire、CPK より選択します。None の場合のは、全体の指定

が有効となります。 
Label:ラベルの表示を指定します。原子の場合は名称と番号の選択が、残基の場合は名称と原

子番号付の名称が選択できます。 
Color: 表示色を、None、Atom、Residue、Charged Residue, Atom Charge、Fragment 

Charge 、 Residue Charge 、 Fragment 、 Interaction Energy 、 Interaction 
Energy[lock]、Chain、File、Other より選択します。None の場合は、全体の指定が有効

となります。Other の場合の設定色を横に表示します。そこをクリックすることによりカラー選

択画面が表示されます。 
 

 

図 2.129 原子表示指定の画面 

 

図 2.130 残基表示指定の画面 
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2.12 解析領域表示指定 
MOL2 ファイルを使用して解析領域を表示することができます。書式は@<TRIPOS>ATOM の前

の行に”grid file”と記述して、頂点の座標を適当な原子で記述し、@<TRIPOS>BOND で表示し

たい線をインデックスで指定します。以下に表示例とファイル例を示します。解析領域の色は、ファ

イルの順の色になります。 

 

図 2.131 解析領域表示指定例 
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@<TRIPOS>MOLECULE 
test data 
    8   12    0 
    0    0    0    0 
 
 
grid file 
@<TRIPOS>ATOM 
       1 N     -8.0000   -4.0000   -9.0000 N.4     1  GLY         0.0000 
       2 N      8.0000   -4.0000   -9.0000 N.4     1  GLY         0.0000 
       3 N     -8.0000   -4.0000    4.0000 N.4     1  GLY         0.0000 
       4 N      8.0000   -4.0000    4.0000 N.4     1  GLY         0.0000 
       5 N     -8.0000   18.0000   -9.0000 N.4     1  GLY         0.0000 
       6 N      8.0000   18.0000   -9.0000 N.4     1  GLY         0.0000 
       7 N     -8.0000   18.0000    4.0000 N.4     1  GLY         0.0000 
       8 N      8.0000   18.0000    4.0000 N.4     1  GLY         0.0000 
@<TRIPOS>BOND 
       1        1        2 1 
       2        2        4 1 
       3        3        4 1 
       4        3        1 1 
       5        5        6 1 
       6        6        8 1 
       7        7        8 1 
       8        7        5 1 
       9        1        5 1 
      10        2        6 1 
      11        3        7 1 
      12        4        8 1 

図 2.132 解析領域表示指定ファイル例(g10a_grid.mol2) 
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2.13 Molda 
Molda 自体のマニュアルは、別ファイルを参照してください。ここでは、Version 12 で Molda に

追加した、DNA,RNA 構造作成機能、DNA,RNA 塩基置換機能、DNA,RNA 塩基補完機能に

ついて記述します。 

2.13.1 DNA 構造作成 

1) Molda のメニュー 
Moldaのメニューを図 2.133 に示します。DNA,RNA 構造作成機能、DNA,RNA 塩基置換機能、

DNA,RNA 補完機能は「Model」メニューに追加されました。 

 

図 2.133 Molda メニュー 

2) DNA 構造作成メニュー 
DNA 構造作成メニュー 「Model」－「Input」－「DNA」を選択すると、DNA 構造の指定ダイアロ

グが表示されます。DNA 構造作成メニューを図 2.134 に、DNA 構造の指定ダイアログを図 
2.135 に示します。ダイアログの入力エリアには、DNA 構成要素の文字(A,G,T,C)を、作成する一

方の対のシーケンスとして入力します。ここでは「AAGGCCTT」を入力し、「OK」ボタンをクリックし

ます。作成された DNA 構造が 図 2.136 のように Molda の Viewer に表示されます。対応する

塩基は自動で作成されます。 

 

図 2.134 Model Input DNA メニュー 
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図 2.135 DNA 構造の指定 

 

 

図 2.136 DNA 構造作成結果 
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3) To Viewer 
「Display」－「To Viewer」 を行うことで、作成した DNA を BioStation Viewer へ 図 2.137 の
ように反映できます。 

 

図 2.137 作成した DNA 構造を BioStationViewer へ反映 
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2.13.2 RNA 構造作成 

1) RNA 構造作成メニュー 
RNA 構造作成メニュー 「Model」－「Input」－「RNA」を選択すると、RNA 構造の指定ダイアロ

グが表示されます。DNA 構造作成メニューを図 2.138 に、DNA 構造の指定ダイアログを図 
2.139 に示します。ダイアログの入力エリアには、RNA 構成要素の文字（A,G,C,U）のシーケンス

を指定します。ここでは「AAGGCCUU」を入力し、「OK」ボタンをクリックします。作成された RNA
構造が 図 2.140 のように Molda の Viewer に表示されます。 

 

図 2.138 RNA 構造作成メニュー 

 

図 2.139 RNA 構造の指定 
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図 2.140 RNA 構造作成結果 

2) To Viewer 
「Display」－「To Viewer」 を行うことで、作成した DNA を BioStation Viewer へ 図 2.141 の
ように反映できます。 

 

図 2.141 作成した RNA 構造を BioStationViewer へ反映 



107 

2.13.3 DNA 塩基置換 

1) DNA 構造ファイル表示 
BioStation Viewer で DNA 構造ファイル(pdb ファイル等)を開きます。 

 

図 2.142 BioStation Viewer で開いた pdb ファイル 

2) Molda で表示 
BioStationViewer で表示した DNA 構造を「File」－「Molda[with file]」メニューにより Molda
を起動し、表示します。 

 

図 2.143 BioStationViewer に表示中の構造を Molda で表示した結果 
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3) DNA 塩基置換準備 
DNA の塩基置換を行います。「View」－「Sequence Viewer」を表示し、置換を行う塩基を選択し

「OK」をクリックします。Moldaに表示されている構造上に選択された塩基が水色の状態となります。

ここでは DC3 を選択した例を 図 2.144 に示します。Molda に表示されている DNA の構造の

DC3 塩基部分が選択された状態を 図 2.145 に示します。 

 

図 2.144 Sequence viewer で DC3 塩基を選択 

 

図 2.145 DC3 塩基を選択された状態の Molda Viewer 
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4) DNA 塩基置換 
DNA 塩基置換メニュー 「Model」－「Point Mutation」－「DNA」メニューを選択すると、DAN
塩基置換のダイアログが表示されます。DNA 構造作成メニューを図 2.146 に、DAN 塩基置換の

ダイアログを図 2.147 に示します。置換する塩基タイプ(DA,DG,DC,DT) から選択し、「OK」をク

リックします。DC３を「DT」へ置換するため、「DT」を選択します。塩基置換結果は 図 2.148 のよ

うに表示されます。 

 

図 2.146 DNA 塩基置換のメニュー 

 

図 2.147 DNA 塩基置換ダイアログ 

 

図 2.148 DNA 塩基置換結果表示 
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5) To Viewer 
「Display」－「To Viewer」 を行うことで、作成した DNA を BioStation Viewer へ 図 2.149 の
ように反映できます。 

 

図 2.149 塩基置換した DNA 構造を BioStationViewer へ反映 
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2.13.4 RNA 塩基置換 

1) BioStationViewer の起動 
BioStation Viewer で RNA 構造ファイル(pdb など)を開きます。 

 
図 2.150 BioStation Viewer で開いた pdb ファイル 

2) Molda で表示 
BioStationViewer で表示した RNA 構造を「File」－「Molda[with file]」メニューにより Molda
で表示します。 

 

図 2.151 BioStationViewer に表示中の構造を Molda で表示した結果 
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3) RNA 塩基置換準備 
RNA の塩基置換を行います。「View」－「Sequence Viewer」を表示し、置換を行う塩基を選択し

「OK」をクリックします。Moldaに表示されている構造上に選択された塩基が水色の状態となります。

ここでは U2 を選択した例を 図 2.152 に示します。Molda に表示されている RNA の構造の

U2 塩基部分が選択された状態を 図 2.153 に示します。 

 

図 2.152 Sequence viewer で U2 塩基を選択 

 

図 2.153 U2 塩基を選択された状態の Molda Viewer 
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4) RNA 塩基置換 
RNA塩基置換メニュー 「Model」－「Point Mutation」－「RNA」メニュー選択すると、RAN塩基

置換のダイアログが表示されます。RNA 塩基置換メニューを図 2.154 に、RAN 塩基置換のダイ

アログを 図 2.155 に示します。置換する塩基タイプ(A,G,C,U)から選択し、「OK」をクリックします。

ここではU2をAに置換します。このため、「A」を選択します。置換結果が 図 2.156 のように表示

されます。 

 

図 2.154 RNA 塩基置換のメニュー 

 

図 2.155 RNA 塩基置換ダイアログ 

 

図 2.156 RNA 塩基置換結果表示 
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5) To Viewer 
「Display」－「To Viewer」 を行うことで、作成した RNA を BioStation Viewer へ 図 2.157 の
ように反映できます。 

 

図 2.157 塩基置換した RNA 構造を BioStationViewer へ反映 

 



115 

2.13.5 DNA 塩基補完 

塩基補完には Position に 5’Terminal、3’Terminal、Middle のいずれかを指定し、補完するシ

ーケンスを指定します。5’Terminal は、5’端へ塩基を補完します。3’Terminal は、3’端へ塩基を

補完します。Middle は、末端以外のところへ塩基を追加します。 
DNA 塩基補完では 3 パターンの Position の操作方法を示します。 
 
2.13.5.1 Position：5’Terminal 
5’Terminal 方向に塩基を補完します。 
1) BioStationViewer の起動 
BioStation Viewer で DNA 構造ファイル(pdb など)を開きます。ここでは見やすいように Atom
表示を Off、Structurs Cα[line]表示とし、「Tool」－「Label」の「Residue Label」を On にします。

以下の DNA 構造は B 鎖 DC9 に対応する A 鎖の塩基が欠落しています。これを補完します。 

 

図 2.158 BioStation Viewer で開いた pdb ファイル 
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2) Molda の起動 
BioStationViewer で表示した DNA 構造を「File」－「Molda[with file]」メニューにより Molda
で表示します。 

 

図 2.159 BioStationViewer に表示中の構造を Molda で表示した結果 

3) DNA 塩基補完準備 
DNA の塩基補完を行います。「View」－「Sequence Viewer」を表示し、補完を行う基点となる塩

基を選択し「OK」をクリックします。ここでは DA1 を選択し、 図 2.160 に示します。Molda に表

示されている構造上に選択された塩基が水色に選択された状態となります。Molda に表示されて

いる DA1 が選択された状態を 図 2.161 に示します。 

 

図 2.160 Sequence viewer で DA1 塩基を選択 
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図 2.161 DA1 塩基を選択された状態の Molda Viewer 
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4) DNA 塩基補完 
DNA 塩基補完メニュー 「Model」－「Add Nucleotide」－「DNA」メニューを選択すると、DNA
塩基補完のダイアログが表示されます。DNA 塩基補完メニューを図 2.162 に、DNA 塩基補完の

ダイアログを 図 2.163 に示します。補完する方向を Position で、5’Terminal、3’Terminal、
Middle から選択します。ここでは 5’Terminal を選択します。ダイアログの入力エリアには、選択し

た塩基に対し、Position 指定した方向に補完する塩基を DNA 構成要素の文字(A,G,T,C)を使用

して、シーケンスとして入力します。ここでは「G」を入力し、「OK」ボタンをクリックします。塩基の補

完結果は 図 2.164 のようになります。 
 

 

図 2.162 DNA 塩基補完のメニュー 

 

図 2.163 DNA 塩基補完ダイアログ 
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図 2.164 DNA 塩基補完結果表示 

注意 
※ 補完する対象の鎖に 2 つ以上の塩基がない場合、補完処理は実施できません。 
※ Position に 5’Terminal を指定する場合、選択した基点となる塩基がその鎖の始端でな

ければなりません。 
5) To Viewer 
「Display」－「To Viewer」 を行うことで、補完した DNA を BioStation Viewer へ 図 2.165 の
ように反映できます。 

 

図 2.165 塩基補完した DNA 構造を BioStationViewer へ反映 
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2.13.5.2 Position：Middle 
Middle 方向に塩基を補完します。 
1) BioStation Viewer の起動 
BioStation Viewer で DNA 構造ファイル(pdb など)を開きます。ここでは見やすいように Atom
表示を Off、Structurs Cα[line]表示とし、「Tool」－「Label」の「Residue Label」を On にします。

以下の DNA 構造は A 鎖 DG2、DG3 に対応する B 鎖の塩基が欠落しています。これを補完しま

す。 

 

図 2.166 BioStation Viewer で開いた pdb ファイル 

2) Molda の起動 
BioStationViewer で表示した DNA 構造を「File」－「Molda[with file]」メニューにより Molda
で表示します。 

 

図 2.167 BioStationViewer に表示中の構造を Molda で表示した結果 
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3) DNA 塩基補完準備 
DNA の塩基補完を行います。「View」－「Sequence Viewer」を表示し、補完を行う基点となる塩

基を選択し「OK」をクリックします。ここでは、DA5を選択し、図 2.168 に示します。Moldaに表示

されている構造上に選択された塩基が水色に選択された状態となります。。Moldaに表示されてい

る DA5 が選択された状態を 図 2.169 に示します。 

 

図 2.168 Sequence viewer で DA5 塩基を選択 

 
図 2.169 DA5 塩基を選択された状態の Molda Viewer 
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4) DNA 塩基補完 
「Model」－「Add Nucleotide」－「DNA」メニューを選択すると、DNA 塩基補完のダイアログが表

示されます。補完する方向を Position で、5’Terminal、3’Terminal、Middle から選択します。こ

こでは Middle を選択します。ダイアログの入力エリアには、選択した塩基に対し、Position 指定し

た方向に補完する塩基を DNA 構成要素の文字(A,G,T,C)を使用して、シーケンスとして入力しま

す。ここでは「GC」を入力し、「OK」ボタンをクリックします。DNA 塩基補完ダイアログを 図 2.170 
に示します。補完結果が 図 2.171 のように表示されます。 

 

図 2.170 DNA 塩基補完ダイアログ 

 

図 2.171 DNA 塩基補完結果表示 
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注意 
※ 補完する対象の鎖に 2 つ以上の塩基がない場合、補完処理は実施できません。 
※ Position に Middle を指定する場合、選択した基点となる塩基がその鎖の始端か中間で

なければなりません。 
※ Position に Middle を指定する場合、欠落している塩基の数以上の塩基を指定すること

はできません。 
 
5) To Viewer 
「Display」－「To Viewer」 を行うことで、補完した DNA を BioStation Viewer へ 図 2.172 の
ように反映できます。 

 

図 2.172 BioStationViewer に表示中の構造を Molda で表示した結果 
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2.13.5.3 Position：3’Terminal 
1) BioStation Viewer の起動 
BioStation Viewer で DNA 構造ファイル(pdb など)を開きます。ここでは見やすいように Atom
表示を Off、Structurs Cα[line]表示とし、「Tool」－「Label」の「Residue Label」を On にします。

以下の DNA 構造は B 鎖 DA4 に対応する A 鎖の塩基が欠落しています。これを補完します。 

 

図 2.173 BioStation Viewer で開いた pdb ファイル 

2) Molda の起動 
BioStationViewer で表示した DNA 構造を「File」－「Molda[with file]」メニューにより Molda
で表示します。 

 

図 2.174 BioStationViewer に表示中の構造を Molda で表示した結果 
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3) DNA 塩基補完準備 
DNA の塩基補完を行います。「View」－「Sequence Viewer」を表示し、補完を行う基点となる塩

基を選択し「OK」をクリックします。ここでは、DC3を選択し、図 2.175 に示します。Moldaに表示

されている構造上に選択された塩基が水色に選択された状態となります。Molda に表示されてい

る DG３が選択された状態を 図 2.176 に示します。 

 

図 2.175 Sequence viewer で DG3 塩基を選択 

 

図 2.176 DA4 塩基を選択された状態の Molda Viewer 
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4) DNA 塩基補完 
「Model」－「Add Nucleotide」－「DNA」メニューを選択すると、DNA 塩基補完のダイアログが表

示されます。補完する方向を Position で、5’Terminal、3’Terminal、Middle から選択します。こ

こでは 3’Terminal を選択します。ダイアログの入力エリアには、選択した塩基に対し、Position
指定した方向に補完する塩基を DNA 構成要素の文字(A,G,T,C)を使用して、シーケンスとして入

力します。ここでは「C」を入力し、「OK」ボタンをクリックします。DNA 塩基補完ダイアログを 図 
2.177 に示します。補完結果が 図 2.178 のように表示されます。 

 

図 2.177 DNA 塩基補完ダイアログ 

 

図 2.178 DNA 塩基補完結果表示 
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注意 
※ 補完する対象の鎖に 2 つ以上の塩基がない場合、補完処理は実施できません。 
※ Position：3’Terminal を指定する場合、選択した基点となる塩基がその鎖の終端でなけ

ればなりません。 
※ Position に 3’Terminal を指定する場合、基点となる塩基は 5’Terminal 方向に塩基と

接続していなければなりません。塩基が欠落して接続がない場合には、Position：

Middle を指定するなどして、中間の欠落している塩基を補完した後に、Position：
3’Terminal の補完を行うようにしてください。 

 
5) To Viewer 
「Display」－「To Viewer」 を行うことで、補完した DNA を BioStation Viewer へ 図 2.179 の
ように反映できます。 

 

図 2.179 塩基補完した DNA 構造を BioStationViewer へ反映 
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2.13.6 RNA 塩基補完 

RNA 塩基補完は DNA 塩基補完と操作と同じです。 
Position に Middle を指定した操作手順を例に示します。 
1) BioStation Viewer の起動 
BioStation Viewer で RNA 構造ファイル(pdb など)を開きます。ここでは見やすいように Atom
表示を Off、Structurs Cα[line]表示とし、「Tool」－「Label」の「Residue Label」を On にします。

以下の RNA 構造は G3 から C8 間の延期が欠落しています。これを補完します。 

 

図 2.180 BioStation Viewer で開いた pdb ファイル 

2) Molda の起動 
BioStationViewer で表示した DNA 構造を「File」－「Molda[with file]」メニューにより Molda
で表示します。 

 

図 2.181 BioStationViewer に表示中の構造を Molda で表示した結果 
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3) RNA 塩基補完準備 
RNA の塩基補完を行います。「View」－「Sequence Viewer」を表示し、補完を行う基点となる塩

基を選択し「OK」をクリックします。ここでは、G3を選択し、図 2.182 に示します。Moldaに表示さ

れている構造上に選択された塩基が水色に選択された状態となります。Molda に表示されている

G３が選択された状態を 図 2.183 に示します。 

 

図 2.182 Sequence viewer で G3 塩基を選択 

 

図 2.183 G3 塩基を選択された状態の Molda Viewer 
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4) RNA 塩基補完 
「Model」－「Add Nucleotide」－「RNA」メニューを選択すると、RNA 塩基補完のダイアログが表

示されます。RNA 塩基補完メニューを図 2.184 に、RNA 塩基補完のダイアログを 図 2.185 に
示します。補完する方向を Position で、5’Terminal、3’Terminal、Middle から選択します。ここ

では Middle を選択します。ダイアログの入力エリアには、選択した塩基に対し、Position 指定し

た方向に補完する塩基を RNA 構成要素の文字(A,G,U,C)を使用して、シーケンスとして入力しま

す。ここでは「AGU」を入力し、「OK」ボタンをクリックします。補完結果が 図 2.186 のように表示

されます。 

 

図 2.184 RNA 塩基補完のメニュー 

 

図 2.185 RNA 塩基補完ダイアログ 
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図 2.186 RNA 塩基補完結果表示 

注意 
※ 補完する対象の鎖に 2 つ以上の塩基がない場合、補完処理は実施できません。 
※ Position に 5’Terminal を指定する場合、選択した基点となる塩基がその鎖の始端でな

ければなりません。 
※ Position に Middle を指定する場合、選択した基点となる塩基がその鎖の始端か中間で

なければなりません。 
※ Position に Middle を指定する場合、欠落している塩基の数以上の塩基を指定すること

はできません。 
※ Position：3’Terminal を指定する場合、選択した基点となる塩基がその鎖の終端でなけ

ればなりません。 
※ Position に 3’Terminal を指定する場合、基点となる塩基は 5’Terminal 方向に塩基と

接続していなければなりません。塩基が欠落して接続がない場合には、中間の欠落して

いる塩基を補完した後に 3’Terminal の補完を行うようにしてください。 
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5) To Viewer 
「Display」－「To Viewer」 を行うことで、補完した DNA を BioStation Viewer へ 図 2.187 の
ように反映できます。 

 

図 2.187 塩基補完した RNA 構造を BioStationViewer へ反映 
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3 使用例 
3.1 ABINIT-MP 計算結果表示 

サンプルデータを使用して、各種表示を行います。サンプルデータは 

o (Gly)10 のサンプルデータ 
 FMO-HF/STO-3G 計算の check point file g10a.cpf  
 電子密度を計算する入力データ den.inp  
 電子密度のグリッドデータ g10a_fmo_sto-3g_3.den  
 電 子 密 度 上 の 静 電 ポ テ ン シ ャ ル マ ッ プ 力 デ ー タ 

g10a_fmo_sto-3g_3.map 
 静電ポテンシャルのグリッドデータ g10a_fmo_sto-3g_4.esp  
 分子軌道のグリッドデータ g10a_fmo_sto-3g_3.mo 
 領域表示例データファイル g10a_grid.mol2 
 電場ベクトルデータファイル g10a_fmo_sto-3g_3.efv 

です。 

3.1.1 分子構造表示 

Viewerを起動して、g10a.cpfを読み込みます。ファイルを読み込んだ画面を図 3.1に示します。

起動時の分子構造の表示形式はスティックになっています。 

 

図 3.1 g10a.cpf を読み込んだ画面 

Model(ATOM)メニューより、Wire frame ,Wire frame(with fragment bond)(Color を frame
に指定),Ball&Stick, Ball&Wire,CPK, Backbone,Cα(line)を選択して表示形式を変更して表

示します。表示結果を図 3.2～3.8 に示します。 
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図 3.2 ワイヤーフレーム形式 図 3.3 ワイヤーフレーム形式(フラグメント境界付)形式 

  

図 3.4 ボールアンドスティック形式    図 3.5 ボールアンドワイヤー形式 
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図 3.6 CPK 形式   図 3.7 backbone 形式   

 

図 3.8 CαLine 形式 
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3.1.2 色付けを変更した表示 

Color メニューより、Atom, Residue(Name), Charged Residue, Atom Charge, Frangment, 
Chain を選択して表示色を変更して表示します。表示結果を図 3.9～3.13 に示します。 
なお、Model(ATOM)メニューでは Stick を設定しています。 

   

図 3.9 原子の種類で色付け 図 3.10 残基の種類で色付け 

   

図 3.11 残基の電荷で色付け  図 3.12 原子の電荷で色付け 



137 

   

図 3.13 フラグメントで色付け   図 3.14 チェーンで色付け(1 チェーンなので

1 色) 

フラグメント間相互作用エネルギーを表示するには、基準となる 2 番目のフラグメントを選択し（黄

色で表示）、Monitor→Interfragment Interaction→1:1 を選択し、最小値に-5,最大値に 5 を

指定しています。表示結果を図 3.15 に示します。フラグメント間相互作用エネルギーの詳細は

3.3 節で詳しく説明します。 

 

図 3.15 フラグメント間相互作用エネルギーの値で色付け。黄色の２番目のフラグメント

を基準として表示している。 
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3.1.3 ラベル表示 

Tool→Label を選択するとラベル表示画面が表示されます。図 3.16 に残基のラベルを表示した

例を、図 3.19 に原子のラベルを表示した例を示します。 

   

 図 3.16 残基のラベル表示例      図 3.17 原子のラベル(原子名)表示例 
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3.1.4 電子密度の等値面表示 

電子密度の表示を行います。File→Open で g10a_fmo_sto-3g_3.den を指定します。等値面

指定画面が表示され、表示する等値面の値はファイルに記述されている値です。このまま Ok をク

リックします。すると、電子密度の等値面が表示されます。表示を    図 3.18 に示します。 
File→File List を選択すると入力されているファイル一覧が表示されています。ここで、

g10a_fmo_sto-3g_3.den の横の Value ボタンをクリックします。等値面指定画面が表示されるの

で、色を変更します。Color の横のボタンをクリックするとカラー選択画面が表示されます。ここで適

当な色を選択します。表示を             図 3.19 に示します。 

  

    図 3.18 等値面表示             図 3.19 色を変更した等値面表示 

 
File→Close File を選択すると入力されているファイル一覧が表示されています。ここで、

g10a_fmo_sto-3g_3.den を選択肢 Ok ボタンをクリックします。表示から等値面が削除されます。 
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3.1.5 電子密度の等値面上に静電ポテンシャルの値により色付けした表示 

電子密度の等値面上に静電ポテンシャルの値により色付けした表示を行います。File→Open で

g10a_fmo_sto-3g_3.map を指定します。静電ポテンシャル指定画面が表示されます。Min Max 
を-0.05 0.05 に設定します。Ok をクリックすると、電子密度の等値面が表示されます。表示を図 
3.20 に示します。 
等値面の透明度を変更します。File→File List を選択すると入力されているファイル一覧が表示

されています。ここで、g10a_fmo_sto-3g_3.mapの横のValueボタンをクリックします。静電ポテン

シャル指定画面が表示されるので、Transparency を 50 に変更します。また、Color→Atom 
Charge を選択します。表示を図 3.21 に示します。 

   

図 3.20 電子密度の等値面上に静電ポテン

シャルの値により色付けした表示 
図 3.21 透明度を変更した等値面表示 
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3.1.6 静電ポテンシャルの等値面表示 

静電ポテンシャルの等値面表示を行います。File→Openでg10a_fmo_sto-3g_4.espを指定し

ます。静電ポテンシャル指定画面が表示されます。Min,Max を-0.01,0.01、Transparency を 50
にして Ok をクリックすると、静電ポテンシャルの等値面が表示されます。分子構造を Stick で合わ

せて表示した例を図 3.22 に示します。 
 

 

図 3.22 静電ポテンシャルの等値面表示 
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3.1.7 分子軌道の等値面表示 

分子軌道の等値面表示を行います。File→Openで g10a_fmo_sto-3g_3.moを指定します。分

子軌道指定画面が表示されます。ここで、グラフより表示したい軌道を選択し、Draw をクリックする

と、電子密度の等値面が表示されます。この例では１番目のフラグメントの LUMO の等値面を表

示しています。表示を図 3.23 に示します。 
 

 
 

図 3.23 分子軌道の等値面表示 
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3.1.8 電場ベクトルの表示 

電場ベクトルの表示を行います。File→Openで g10a_fmo_sto-3g_3.efvを指定します。デフォ

ルトの電場ベクトルが表示されます（図 3.24）。 
次に表示形式を変更して表示する例を示します。Min,Max の値を-0.1,0.1 にします。断面指定

をするため、Section→Setボタンを押下し、Assign Section Plane のAngleタブでBを-27度に

設定して、Value は Density を指定して"Draw"ボタンをクリックすると断面が表示されます。表示

指定を図 3.25 に、表示を図 3.26 に示します。 
構造表示形式を Ball&Stick、電場ベクトルの透明度を 50、表示形式を Min,Max の値を

-0.02,0.02、Stick、ステップ数を 150 にし”Draw”ボタンをクリックすると Stick 形式の電場ベクトル

が表示されます。ステップ数を増やしたので、下のほうの＋のグリシンから、上の－のグリシンへ電

場ベクトルが表示されます。表示指定を図 3.27 に、表示を図 3.28 に示します。 
 

 

図 3.24 電場ベクトルの表示 
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図 3.25 断面の表示指定 

 

図 3.26 断面の表示 
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図 3.27 電場ベクトルの表示指定 

 

図 3.28 Stick 形式での電場ベクトル表示 
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3.2 エストロゲン受容体－リガンド複合体の構造表示例 
サンプルデータを使用して、各種表示を行います。サンプルデータ(フォルダ sample にありま

す)には、エストロゲン受容体－リガンド複合体を用います。リガンドとしてアゴニストである 17β
-estradiaol と選択的アンタゴニスト raloxifene が結合した場合のｐｄｂファイル ERE_EST.pdb、
ERR_RAL.pdb を使用します。 

 

3.2.1 ペプチド鎖の Cα line 表示 

Viewerを起動して、ERE_EST.pdbを読み込むと、デフォルトの設定で、Model(Atom)→Off、
Model(Structure)→Cα Line で表示されます。ファイルの読み込みはドラッグでも可能です。

色は、２次構造の種別で表示されます。表示を図 3.29 に示します。その他の形式の表示例は図 
2.28－図 2.34 を参照してください。 
 

 

図 3.29 ファイル読み込み後の表示 
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3.2.2 ペプチド鎖の Cα line 表示＋リガンド表示形式変更 

Selection→Residue を選択し、リガンドをマウスの左ボタンでクリックします。クリックされたリガン

ドが強調表示された画面を図 3.30 に示します。 
 

 

図 3.30 リガンド選択 
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次に、右ボタンでリガンドをクリックします。すると残基表示指定画面が表示されますの

で Color：Atom 、Model：Ball&Stick を選択し Ok をクリックします（図 3.31）。これで、

リガンドがボールアンドスティック形式で表示されます。表示を図 3.32 に示します。 

 

図 3.31 リガンドの表示形式指定画面 

 

図 3.32 リガンドをボールアンドスティック形式で表示 
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次に、リガンドを右クリックし残基表示指定画面でModelの項目はCPKを選択し、Colorの項目は

other にし、横のボタンをクリックし、適当な色を選択します。リガンドが空間充填モデル形式で指

定した色で表示されます。表示を図 3.33 に示します。 

 

 

図 3.33 リガンドを空間充填モデル形式で表示 
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3.2.3 ペプチド鎖の Cα line 表示＋リガンド表示＋選択した残基の表示 

リガンド周辺の残基を Wire Frame で表示します。シフトを押しながら左ボタンで 5 つほどリガン

ド周辺の残基（この例では ASN519～GLU523）をクリックします。シフトを押しながら右ボタンその

ひとつをクリックします。残基表示指定画面が表示されますので Color：Atom、Model：Wire 
Frame を選択し Ok をクリックします。これで、選択された残基がワイヤーフレーム形式で表示され

ます。表示を図 3.34 に示します。 

 

 

図 3.34 選択した残基のワイヤーフレーム形式表示 
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次に Tree 図からの指定で表示を変更します。リガンド周辺の残基をクリックします。Tree 図に選択

された残基が強調表示されますので、残基名の横の マークをクリックし残基の展開を閉じ、もう

一度この残基をクリックし 5 個下の残基をシフトを押しながらクリックします（この例では GLY420～
PHE425）。これで、複数の残基が選択されます。次に右ボタンで選択された残基をクリックします。

残基表示指定画面が表示されますのでColor：Atom、Model：Wire Frame を選択し Ok をクリッ

クします。これで、選択された残基がワイヤーフレーム形式で表示されます。表示を図 3.35 に示し

ます。  

 

 

図 3.35 Tree 図上で選択した残基のワイヤーフレーム形式表示 
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3.2.4 リガンド＋荷電残基表示 

Model(Atom)→Wire Frame, Model(structure)→Off で全体を Wire Frame で表示します。

Tool→Display Selected Residue を選択します。残基表示有無指定画面が表示されますので、

Unselect All をクリックし、荷電残基(ASP,GLU,LYS,ARG)を選択します。すると指定された荷電

残基のみ表示されます。表示を図 3.36に示します。同様に、任意の指定残基のみを表示すること

ができます。 
 

 

図 3.36 荷電アミノ酸の表示 
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Color(Atom)→Charged Residue を選択すると、表示されている残基が荷電の値により色付けさ

れます。正電荷が赤、負電荷が青で表示されます。表示を図 3.37 に示します。 

 

図 3.37 荷電アミノ酸で色付けした表示 

Tool→Display Selected Residue を選択します。残基表示有無指定画面が表示されますので、

Select All をクリックします。残基の表示指定が解除され全体が表示されます。表示を図 3.38 に

示します。 

 

図 3.38 荷電アミノ酸で全体を色付けした表示 
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3.2.5 リガンド周辺表示と距離表示 

リガンドから指定した距離内の原子を表示します。リガンドをクリックし選択し、Tool→Display 
Atom in Distance を選択します。距離指定の画面が表示されますので、From selected で
Residueを選択し、Distanceに４と入力します。するとリガンドから距離4Å以内の原子が表示され

ます。表示を図 3.40 に示します。ここで、リガンドの真ん中のあたりの原子をクリックして Tool→
Set Rotaion Center を選択します。すると、回転中心が選択された原子になるので、表示の移動

がやりやすくなります。 

 

図 3.39 指定範囲内の原子の表示の指定画面 

 

図 3.40 リガンドから指定距離内の表示 
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次に、原子間の距離を表示します。Color(Atom)→Atom を選択し、全体を原子で色付けし、リガ

ンドを右ボタンクリックし残基表示指定で、Ball&Stick、原子で色付けを指定します。ここで、

Monitor→Distance を選択します。リガンドの端の水素原子をクリックし、次にその近くの残基上

の酸素原子をクリックします。するとメッセージエリアに両原子間の距離が表示されます。表示を図 
3.41 に示します。 
 

 

図 3.41 原子間の距離の表示 
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3.3 フラグメント間相互作用エネルギー表示例 
エストロゲン受容体－リガンド複合体の計算結果を使用して、フラグメント間相互作用エネルギ

ーの表示を行います。1 フラグメント＝1 残基として計算を行えば、残基間相互作用、残基－リガン

ド間相互作用を表示することができます。 
 

3.3.1 ファイル入力 

Viewer を起動して、ERE_EST.cpf を読み込み表示します。表示を図 3.42 に示します。 

 

図 3.42 ファイルを入力して表示 
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3.3.2 フラグメント間相互作用エネルギー表示の指定 

Tree 図よりリガンド EST600 をマウスの左ボタンでクリックして選択します。また、Monitor→
Interfragment Interaction→1:1 を選択します。すると図 3.43 のような値の指定画面が表示さ

れます。ここでは、min:-10,max:10 と入力して Ok ボタンをクリックします。これで、リガンドからの

各残基間相互作用エネルギーを-10～10kcal/mol の範囲で色付けした分子構造が表示されます。

相互作用エネルギー値がの値が負→零→正となるに従って、赤→白→青の順で色付けされ、色

の濃さが相互作用の強さを表しています。表示を図 3.44 に示します。 

 

図 3.43 フラグメント間相互作用エネルギーの表示指定 

 

図 3.44 フラグメント間相互作用エネルギーの表示 
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3.3.3 閾値を指定して表示 

ここで、フラグメント個別の表示を行うために、Model(Structure)→Off、Model(Atom)→Wire 
Frame にします。リガンドを目立たせるために、Ｔree 図のＥＳＴ600 をマウスの右ボタンでクリックし

て表示属性指定画面を表示します。ここで、Ｃｏｌｏｒはメニュー横のボタンをクリックして適当な色を

選択し、Model は CPK を指定します（図 3.45）。次に、Monitor→Interfragment Interaction
→1:1[lock]を選択し、値の指定画面で threshold に 2 を指定しますこれで、相互作用エネル

ギーの絶対値が 2kcal/mol 以下の残基が表示されなくなります。表示を図 3.46 に示します。 

 

図 3.45 リガンドの表示指定 

 

図 3.46 閾値を指定したフラグメント間相互作用エネルギーの表示 
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3.3.4 指定したフラグメント間の相互作用エネルギー表示 

Model(Atom)→Stick にします。Monitor→Interaction Energy を選択します。もう一度このメ

ニューが選択されるまではメニューが緑で表示され、表示をピックすると指定されたフラグメント（残

基）間の相互作用エネルギーを表示します。リガンドとその周辺のフラグメントをクリックして表示し

た例を図 3.47 に示します。また、エラー! 参照元が見つかりません。に示したようにフラグメント

（残基）間の相互作用エネルギーの値をリスト表示することも可能です。 
 

 

図 3.47 指定したフラグメント間の相互作用エネルギーの表示 
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3.4 重ね合わせ操作例 
ERE_EST.cpf、ERR_RAL.cpf のデータを使用して重ね合わせの使用例を示します。 
 

3.4.1 ファイル入力 

Viewer を起動して、ERE_EST.cpf、ERR_RAL.cpf を読み込み、Color(Structure)→File、
Model(Structure)→Cαを選択します。これでファイルごとに色付けされ表示されます。表示を図 
3.48 に示します。 

 

図 3.48 2 つのファイルを読み込んで表示 
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3.4.2 すべてのＣαを用いた指定による重ね合わせ 

Tool→Overlay Molecules を選択します。重ね合わせの指定画面が表示されます。ここでは、

デフォルトの値を使用するので Oｋボタンをクリックします。デフォルトでは、ファイルごとに Cαの座

標を用いて重ねあわせを行います。重ねあわせ後の表示を図 3.49 に示します。全体で重ね合わ

せしたために全体的にずれがあります。 
 

 

図 3.49 ファイルごとに Cαの座標を用いて重ねあわせを行った表示 

3.4.3 指定した残基内の原子(Cα)指定による重ね合わせ 

次に原子(Cα)を３つ指定して重ねます。Tool→Overlay Molecules を選択し、Type の項目を

Residue、Methodの項目をCαを選択します。そして構造的に近い残基を交互にそれぞれ3点ク

リックします。クリックされた残基番号が入力フィールドに表示されます。入力フィールドはキーボー

ドで編集可能なので間違えた場合はキーボードより削除が可能です。指定を図 3.50 に示します。

ここで、”Ok”ボタンをクリックします。それぞれのリガンド(EST600,RAL600)をＳｔｉｃｋ表示にします。

アゴニスト(EST、ピンク色)、アンタゴニスト(RAL、青色)それぞれのリガンドが計都合した場合に、

Ｃ末側のへリックス 12 の位置が異なっている様子がわかります (図 3.51) 。 
次に Model(Structure)→Cα{tube}を選択します。この表示を図 3.52 に示します。 
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図 3.50 重ね合わせの指定 

 

 

図 3.51 残基指定で重ね合わせを行った結果の表示 
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図 3.52 残基指定で重ね合わせを行った結果の表示(Cα{tube}) 
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3.5 水素付加の操作例 
あらかじめ水素を取り除いたサンプルファイル(ERE_EST_noH.pdb)を用いて水素付加の操作

例を示します。水素付加を行うにはReduceがインストールされている必要があります。インストール

は 7.5 章をご参照ください。 
ERE_EST_noH.pdb を読み込みます。表示されたら Tool→Add Hydrogen を選択してくださ

い。すると、水素追加指定画面（図 3.53）が表示されます。出力ファイル名は入力ファイル名に

_addH を付加したものがデフォルトとして表示されます。Options には Reduce で使用できるオプ

ションを指定します。Ok ボタンをクリックするとコマンドプロンプトの画面が表示され実行のログが表

示されます。終了したら exit を入力して（図 3.54）閉じてください。 

 

図 3.53 水素追加指定画面 

 

図 3.54 コマンドプロンプト 
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コマンドプロンプトを閉じると結果を表示するかどうかの問い合わせがあります。ここでOkをクリッ

クすると表示が水素付加されたものと置き換わります。 

 
図 3.55 結果表示の確認 

 

 

図 3.56 水素追加後の分子構造 

 



166 

3.6 フラグメント間相互作用エネルギー 多対１の例 
DNA とタンパク質の計算を例にフラグメント間相互作用エネルギーの多対１の表示例を示しま

す。サンプルファイル trunc-DB7_Hopt_moe_DNA.cpf を読み込み、Cα[tube]形式で表示しま

す。。Monitor→Interfragment Interaction→N:1 を選択し指定画面を表示します。このファイ

ルはフラグメント番号 23～222 までがタンパク質、223 がリガンド、1～22 までが DNA です。そこ

で、タンパク質、リガンドと DNA のフラグメント間相互作用を見るために Base Fragments に

23-222 と入力し、Min,Max を-100,100 にし”Ok”ボタンをクリックするとタンパク質、リガンドと

DNA のフラグメント間相互作用エネルギーで色付けされ表示されます。赤の色の濃い部分が安定

化している部分です。 
 

 

図 3.57 フラグメント間相互作用エネルギー 多対１の例 
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3.7 トラジェクトリー表示例 

3.7.1 グリシンの例 

サンプルファイル G05A.trj を読み込みます。はじめの分子構造が表示されます（図 3.58）。
 ボタンをクリックすると、構造が変化する様子が表示されます。最後のステップの分子構造を

図 3.59 に示します。 

 

図 3.58 はじめの分子構造 

 

図 3.59 最後のステップの分子構造 
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3.7.2 SI８の例 

サンプルファイル dyna_pot_test.tr2 を読み込みます。このファイルは「戦略的基盤ソフトウエ

アの開発」の研究テーマのひとつ「ナノシミュレーション」の結果です。Si8 の MD 計算の結果を表

示用に 10 ステップごとに編集したものです。ベクトルは、原子に作用している力の大きさをあらわし

ています。ファイル読み込み後 Model(Atom)→Wire Frame、Preference→Set Preferences
→Arrow(Trajectory)タブ中→Scale に 10 を設定し、"Apply"ボタンをクリックして下さい。はじめ

のステップの表示を図 3.60 に示します。  ボタンをクリックすると、ベクトル表示が変化する様

子が表示されます。最後のステップを図 3.61 に示します。 
 

 

図 3.60 はじめのステップの表示 
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図 3.61 最後のステップの表示 

 

3.7.3 トラジェクトリー表示の動画ファイルを作成 

BioStation Viewer 自体に動画ファイル作成機能がありますが、ここではオープンソースソフトウェ

アである FFmpeg を使用した動画ファイル作成例を説明します。 
１) ファイル読み込み 

File > Open Fileからトラジェクトリｰファイルを読み込みます。この際、Files of Type

で、Trajectory fileを選択すると、トラジェクトリｰファイルだけがリストに表示されるのでフ

ァイルを選びやすくなります。トラジェクトリｰファイルを読み込むと、Trajectory Control ウィン

ドウが表示されます。 
２) 表示指定 

フラグメント毎に色分けする場合は、BioStation Viewer のメインウインドウから、Color > 

Fragmentを選択します。 
メインウインドウのPreferences > Set Preference > Resolutionで、Ball, Stick, 

CPK, Tubeの解像度を最大(64)にしておくと、分子モデルがきれいに表示されます。また、画

面左下の xyz 座標を表示しない場合は、Preference > Display Axisで Disableを

選択します。 
３) 画像ファイル生成 

Trajectory Control ウィンドウの、File > Create image files で、画像ファイルを保
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存するフォルダを指定します。画像ファイルは、JPEG形式で保存されます。ファイル名は 6桁

の連番をつけたファイル名になります。 
４) 動画ファイル作成の準備 

FFmpeg のソースコードは、http://ffmpeg.org/ からダウンロードできます。Windows
用の実行形式は、http://blog.k-tai-douga.com/ 等からダウンロードでます

（Windows Vista でも使用可能）。ダウンロードした zip ファイルを解凍してできた

ffmpeg.exeを、C:¥Program Files¥ffmpeg等へコピーし、スタート > コントロール パ

ネル > システム > システムの詳細設定 > 環境変数 のユーザー環境変数のPATHの最後

に 
   ;C:¥Program Files¥ffmpeg 

を追加しておくと、実行時に ffmpeg.exeを保存したフォルダを指定しなくても済むので便利

です（;の前後にスペースを入れないように注意する）。 
５) 動画ファイル作成 

入力画像ファイルが保存されているフォルダで、コマンド プロンプトを開き、下記のように入力

します。Windows Vista の場合、エクスプローラの右側のウィンドウに開きたいフォルダ名を表

示しておき、マウスのカーソルをフォルダ名に合わせて、Shift キーを押しながらマウスの右ボ

タンをクリックし、コマンド ウインドウをここで開く を左クリックすると簡単です。 
 
ffmpeg -r 75 -i "image%06d.jpg" -vcodec wmv2 -sameq -s 640x480 

out_r75_640x480.wmv 

 

-r 75 ：フレームレート（1秒間に表示するコマ数）を 75に設定（デフォルトは 25）。75にする

と三倍速で表示される。 

-i "image%06d.jpg"：入力する画像ファイルの指定。%06d は、ファイル名中の連番が

000000～999999であることを示す。 

-vcodec wmv2：画像コーデックに Windows Media Video を指定する（mjpeg や

msmpeg4v2 (MS-MPEG4)を指定すると、PC によっては PowerPoint で動画が再生できな

いので使用しない）。 
-s 640x480: 画面サイズを 640x480で保存する（-sオプションを省略すると、入力画像フ

ァイルと同じサイズで動画ファイルを作成する。入力画像が大きい場合は、動画ファイルが重く

なるので、-sオプションで画像サイズを指定した方がよい）。 
-sameq：入力画像と同じ画質を指定 
out_r75_640x480.wmv：出力する動画ファイル名。拡張子は wmv とする。 
また、 
  ffmpeg -h > ffmpeg.txt 

で FFmpegのヘルプを 
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  ffmpeg -formats > formats.txt 

で FFmpeg で利用できるフォーマットやコーデックをファイルに保存することができます。 
６) 作成した動画ファイルを PowerPoint に貼り付ける 

メニューの挿入 > ビデオ > ファイルからビデオを選択します。 

PowerPoint に貼り付けた動画やサウンドは、埋め込まれるのではなく、リンクされるだけなの

で、別の PC 等へコピーする場合は、PowerPoint のファイル（ppt ファイル）だけでなく、動画

ファイル（wmv ファイル）も一緒にコピーします。 
 
参考文献 
 
1) http://opensourceaki.blogspot.com/2007/10/ffmpeg_19.html 
2) 原一浩、寺田学、本間雅洋、足立健誌、堀内康弘、堀田直孝、月村潤、尾花衣美、FFmpeg

で作る動画共有サイト（毎日コミュニケーションズ、2008） 
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3.8 結晶系の表示例 
Bi超薄膜(4層)の原子構造と電荷密度の Gaussian Cubeファイルを読み込み等値面、周期表

示を行います。このファイルは「戦略的基盤ソフトウエアの開発」の研究テーマのひとつ「ナノシミュ

レーション」の結果です。 

3.8.1 ファイルの読み込み、等値面の表示 

サンプルファイル 4LBi.cube を読み込みます。このデータは電子密度のデータなので、ファイル

タイプは Density を選択します。次に、表示形式を Ball&Stick 等値面の値を 0.009 に、透明度

を 50,境界表示を On にすると等値面が表示されます。

指定画面、表示画面を図 3.62～図 3.64
に示します。 

 

 

図 3.62 ファイルタイプの選択 

 

図 3.63 等値面の指定 

 

図 3.64 電子密度の等値面の表示 
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3.8.2 周期表示 

View PointメニューのPeriodicを選択し周期表示指定画面を表示します。この例ではGaussian 
Cube ファイルを読み込んでいるのでＸ，Ｙ，Ｚの Interval が３つずつ入力が可能です。デフォルト

ではファイルに記述された値が指定されています。Ｘ，ＹのNumを2に指定して”Draw”ボタンをク

リックしてください。すると、X,Yそれぞれの方向に2つずつ表示されます。等値面の表示指定で枠

の色も変更します。 
 

 

図 3.65 周期表示例 

3.8.3 断面の表示 

等値面指定画面の Section の”Set”ボタンをクリックします。すると断面指定画面が表示され、3D
表示上では断面が半透明で表示されます。ここで、Z 方向を少しずらし、原子を横切るようにして、

Color RangeのMinを1.0E-3にして”Draw”ボタンをクリックします。これで断面が表示されます。 
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図 3.66  断面指定画面と断面表示例 

次に、Type を Line に、Number of lines を 32 にして”Draw”ボタンをクリックします。等高線が表

示されます。 

 

図 3.67 等高線表示例 
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断面指定の Type を Fringe に戻し、等値面指定の Color を Min,Max の指定にして Min の値を

1e-3 にします。これで、等値面と断面の色のつけ方が同じになるので、断面と交差する等値面の

色が同じになります。 

 

図 3.68 等値面の色のつけ方を変更して表示 
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3.8.4 ボンドの表示 

Preference メニューの Set Preference を選択し Preference 画面で Connect Atom の Scale
を 1.1、Covalent を選択して、Resolution の Ball を 16 にして”Apply”ボタンをクリックすると、ボ

ンドが表示され原子の表示が滑らかになります。 

 

図 3.69 球の解像度、ボンドのスケールを変更して表示 
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3.9 CHPI プログラム使用例 
CHPI27)は、微生物化学研究所 梅沢先生、CHPI 研究所 西尾先生、微生物化学研究会によ

って開発されたプログラムです。この機能を使用して、論文を執筆される場合は、参考文献２７の参

照を記述するようにしてください。BioStationViewer では、このプログラムの入力ファイルを作成し、

起動、結果表示を行うことができます。CH/π相互作用の詳細は、「新版 有機化学のための分子

間力入門」 講談社を参照ください。 
簡便な使用方法を示します。まず、解析対象とする PDB ファイルを入力します。次に、Tool→

CHPI を選択すると CHPI 処理画面が表示されます。デフォルトのパラメータで実行する場合は、

ここで、”Execute CHPI Program”ボタンをクリックすることで、実行し、結果が表示されます。 
 

3.9.1 CH/π相互作用の探索方法 

XH/πの探索方法を以下に示します。 

 

図 3.70 XH/π探索方法説明図 

  Method for exploring XH/π contacts (the six-membered aromatic ring is shown as an 
illustrative example). (a) O: centre of the π-plane. A1 and A2: nearest and second nearest 

sp2-atoms, respectively, to the hydrogen H. ω: dihedral angle defined by A1OA2 and HA1A2 
planes. α: X-H-I’

 

angle. Dpln: perpendicular distance between H and the π-plane (H/I). Datm: 
HA1 distance. Dlin: distance between H and the line A1-A2

 

(H/J). (b) Regions to be searched. 
Region 1: zone where H

 

is above the ring. Regions 2 and 3: zones where H is out of region 1 
but may interact with the π-ring. Unless otherwise noted, the program was run to search for 
short H/π contacts with the following conditions: Dmax = 3.05 Å; Dpln < Dmax (region 1); Dlin < 

Dmax

 

(region 2); Datm < Dmax (region 3); ωmax = 127.5°, -ωmax < ω < ωmax; α < 63°. Dhpi: H/π 
distance (Dpln for region 1, Dlin for region 2, Datm for region 3). 
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O I O
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3.9.2 入力パラメータ編集 

入力パラメータ編集画面を図 3.71 に示します。ここで、各パラメータを指定します。Pi-system 
Table で指定されたファイルは、次の PI 情報ファイル編集で編集します。 

 

図 3.71 入力パラメータ編集画面 

File メニューの動作を説明します。 
1) Open 

パラメータファイルを指定し入力します。ファイルの内容が GUI へ設定されます。Pi-system 
Table で指定されたファイルは入力され、PI 情報に設定されます。 

2) Save 
指定されている内容をファイルに格納します。 

3) Set Default Value 
デフォルト値を設定します。PDB ファイルは、3D 表示で表示されているファイルが設定されま

す。Pi-system Table は、“PDB ファイル名.vpi“ファイルが設定され、このファイルが存在す

ればファイルを読み込み、なければ、デフォルトの PI 情報が設定され*.vpi ファイルが作成さ

れます。 
4) Close 

画面を閉じます。 



179 

入力項目を説明します。 
1) PDB File 

解析対象の PDB ファイルを指定します。 
2) Pi-system Table 

PI 情報ファイルを指定します。Edit ボタンをクリックすると編集画面が開きます。 
3) H/pi interactions 

CHPI 結果ファイルの出力先ファイルを指定します。 
4) Co-ord. of H/pi interaction atom 

CHPI 相互作用の結果の座標のみを記述したファイルの出力先ファイルを指定します。 
5) Residue & atom to delete[A7] 

解析対象からはずす残基(A3)、原子名(+A4)を指定します。最後に”END”と記述します。 
6) Distance from hydrogen to pi center  

H と環の中心（O）からの距離(Dcent)の範囲を指定します。通常は変更しないでください。 
7) H/pi distance from hydrogen to pi-system 

region1 の Dmaxの範囲を指定します。 
8) OMEGA<127.5(deg), ALPHA(Hangle)<63(min63~90)(deg) 

ω、αの値を指定します。通常は変更しないでください。 
9) Type of ALPHA(Hangle):H-X-R  

CHPI 計算の水素の角度(H-X-R) [R=pi_plane, line(A1-A2), A1(closest pi_atom)]の取り

方を指定します。通常は a) です。 
a) region1~3: R=pi_plane 全ての領域で、H-X-pi_plane（=α）をパラメータとして使います。 
b) region1: R=pi_plane, region2: R=line, region3: R=A1 region1 で H-X-pi_plane, 
region2 で H-X-line, region3 では H-X-A1をパラメータとして使用します。 
c) region1~3:R=A1  H-X-A1を全ての領域で使います。 

10) Type of display for CHpi contacts 
相互作用の PI 側の表示位置を指定します。 
a) region1: pi_plane (Dpln), region2: line (Dlin), region3: A1 (Datm) 
b) region1~3: A1 (Datm) 
c) region1~3: O (Dcent) 

a)  b)  c)  



180 

 
11) Type of interactions 

計算する相互作用の分子間の組み合わせを指定します。inter/intra の区別は、PDB ファイ

ルのチェーン IDで区別しているので、必要に応じてPDBファイルを編集してから、実行してく

ださい。 
12) Type of regions 

計算する相互作用の範囲を指定します。 
13) Type of XH(NXATM) 

対象とする原子を指定します。 
14) H-pi network 

結果ファイルへの CHPI ネットワーク出力の有無を指定します。 
15) Execute CHPI Program 

このボタンをクリックすると実行が開始されコマンドプロンプトにログが表示されます。 
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3.9.3 PI 情報ファイル編集 

Pi-system TableのEditボタンをクリックすると編集画面が開き、PI情報を編集します。編集画

面を図 3.72 に示します。 

 

図 3.72 PI 情報ファイル編集画面 

 
フォーマットを説明します。1 行に以下の項目が記述されています。 

• 識別名 任意の識別名をつけます。 
• 残基名 PDB 中の対象とする残基名を指定します。 
• K 指定した残基内での構成要素番号を指定します。 
• L 1 つの構成要素内での通し番号を指定します。 
• M 構成要素内の環要素数をはじめに指定します。 
• VPI FIV/SIX/OLE を指定します。 
• N 環要素の構成原子数を指定します。 
• 1-6 環要素の構成原子名を指定します。 
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PI 情報の編集例を示します。ここでは、STU 周辺に直目するため表示を STU 周辺にします。

STU の適当な原子(C18)をクリックして、メニューの Tool→Display Residue in Distance で 10
Åを指定して、STU 周辺の表示にし、Tool→Set Rotation Center を選択して、回転中心をクリッ

クした原子に設定します(図 3.73)。Tree図で、STUをクリックし右ボタンを押すと表示形式指定の

画面が表示されるので Color を Atom に、Model を Stick にします(図 3.74)。 

 

図 3.73  Display Residue in Distance、Set Rotation Center を選択 

 

図 3.74  マウスの右ボタンを STU 上でクリックして STU の表示属性を設定 
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各ボタンの動作を説明します。 
1) Highlight selected atoms in 3D viewer 

編集領域で選択されている原子が、3D 表示でハイライト表示されます。 

 

2) Add a atom name that picked in 3D viewer 
On にすると、3D 表示でクリックされた原子名がカーソル位置に挿入されます。 
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ファイルメニューを説明します。 
1) Open 

PI 情報ファイルを指定し入力します。ファイルの内容が GUI へ設定されます。 
2) Save 

指定されている内容をファイルに格納します。 
3) Set Default Value 

デフォルト値を設定します。アミノ酸、DNA,RNA の関しては、定型の情報が設定されます。そ

れ以外は、PDB File で指定された PDB ファイルの HEM の部分の環を認識して設定されま

す。認識して生成された情報の識別名は XXX となっています。認識できる範囲の複数の環を

まとめて 1 つの要素とします。修正が必要な場合はユーザが編集可能です。

1qpj_CHminCFFAB.pdb の例を以下に示します。 

 

図 3.75 1qpj_CHminCFFAB.pdb のデフォルト PI 情報 

4) Close 
画面を閉じます。 
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3.9.4 起動 

Execute CHPI Program ボタンをクリックすると実行が開始されコマンドプロンプトにログが表示さ

れます。 

 

図 3.76 CHPI 実行のコマンドプロンプト 

終了したら、これを閉じます。すると、結果が 3D 表示に表示されます。1 つの相互作用が CHPIn
（nは通し番号）という残基名で表示され、3D表示上でクリックするとメッセージエリアに距離が表示

されます。表示形式は、Preference 指定で変更できます。図 3.77－図 3.79 に表示例を示しま

す。 

 

図 3.77 CHPI 結果表示（CHP57 をクリック） 
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図 3.78 Preference で表示形式変更(Model を Line Solid,色を青) 

 

図 3.79 周辺の残基をスティック形式でラベルも表示 
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3.10 CNS 形式の電子密度グリッドデータの解析例 
BioStation Viewer では X 線結晶解析等の実験で得られた CNS 形式の電子密度と FMO 法

に基づいて計算した電子密度を比較することができます。 
 

3.10.1 AJF ファイルの作成例  

CNS 形式での電子密度データを出力するには、ABINIT-MP Input File ウィンドウの

GRIDCNTRL タブにて CNS formmated Electron Density (*.cns) にチェックを入れます（図 
3.80）。ここで、X 線結晶解析等の実験で得られた電子密度と ABINIT-MP で計算される電子密

度を比較するためには実験データに用いられてものと同じグリッドポイントで電子密度を計算する

必要があります。実験データの CNS ファイルがある場合は、図 3.80に示す Import ボタンを用い

て実験データに用いられているものと同じグリッドを指定することができます。 

 

図 3.80 GRIDCNTRL タブ画面 
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3.10.2 CNS 形式の電子密度グリッドデータの表示例  

CNS ファイルを BioStation Viewer の画面にドラッグ＆ドロップすることで CNS 形式の電子密

度グリッドデータのファイルを読み込むことができます。 
 

 

図 3.81 CNS 形式の電子密度グリッドデータを BioStation で読み込み・表示 
0.1 e/Å3の等値面を表示 

 

3.10.3 タンパク質周囲の電子密度のみを抽出する例  

 電子密度を読み込んだのちに表示される Isosurface Value ウィンドウの Tool → Extract 
Density を実行し、電子密度の切り出しを行うことができます。また、切り出した電子密度を File→
Save File により CNS 形式のファイルに保存することができます。 
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  図 3.82  電子密度の切り出し操作を行うための GUI 

 
 
 

 
(a) 実験結果に基づく電子密度          (b) 原子座標を基に切り出した電子密度 

  図 3.83  Crambin(3NIR)の実験結果に基づく電子密度の切り出し(1.0 Å)。 
1.0 e/Å3の等値面を表示 
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3.10.4 タンパク質周囲の電子密度のみを抽出する例  

Monitor → Compare Density Files から複数のグリッドデータを数値的に比較できます。以

下は Crambin(3NIR)の実験結果に基づく電子密度と FMO 計算(FMO-MP2/6-31G*)に基づく

電子密度に関して ARG10 の 1.0 Å周辺の電子密度を比較した結果です。2 つの電子密度の差

分が Viewer の立体構造表示画面に表示され、メッセージパネルに電子密度の差分の絶対値の

平均値(average of abs(Δρ))が表示されます。電子密度の差分はFile->Save FileからCNS形

式に保存できます。 
 

 
図 3.84   Crambin(3NIR)の実験結果に基づく電子密度と FMO 計算(FMO-MP2/ 6-31G*)に 

基づく電子密度の ARG10 の 1.0 Å周辺の差分電子密度。1.0 e/Å3の等値面を表示 
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4 チュートリアル 
4.1 (Gly)10 の分子内相互作用解析 
グリシン 10 残基（α－へリックス型）の計算例を示します。フラグメント分割は１残基単位とし、

FMO-HF/STO-3G レベルの計算をおこないました。 
 

4.1.1 構造作成 

Veiewer を起動して、File→MOLDA を選択し、MOLDA の画面を表示します。Model→
input→Peptideを選択すると、Peptide入力画面が表示されます。ここで、グリシンの略号 gを 10
個入力し”OK”ボタンをクリックするとグリシンが表示されます。以下に入力画面を示します。 

 

 

図 4.1 グリシンの入力指定 

構造が表示されたら、File→Displaｙ→To Vieｗer で、構造を Vewer に渡します。Viewer へは、

molda_tmp.pdb というファイル名で表示されます。 
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4.1.2 構造最適化 

Viewer を起動したカレントフォルダにファイルはあるので、ファイル名を、gly10.pdb に変更して

File→Close File で一度表示を消して、ｇｌｙ10.ｐｄｂを File→Open File で読み込みます。 
Tool→Hydrogen Capping Mode をクリックし、末端処理として、Terminal にマークし COOH 

NH2 を選択し、”OK”ボタンをクリックします。 

 
末端処理の指定 

 

図 4.2 末端処理後の構造（Stick 表示） 
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Tool→Optimize structure で構造最適化指定画面が表示されます。構造最適化は、水素付加

のオプションファイル、構造最適化のオプションファイル、入力構造ファイルを指定し“OK“をクリック

します。指定例を以下に示します。 
※日本語やスペースを含む Path を指定すると正常に動作しない事があるため注意する事。 

 

図 4.3 構造最適化の指定 

構造最適化が実行され表示されます。結果ファイル名は gly10_H_opt.pdb であり、入力ファイル

に_H_opt が付加されたものになります。オプションファイルの内容は、以下のようになっていて、構

造最適化で指定可能なオプションを記述しておきます。オプションの詳細は、5 章に示します。 
ここで、アミノ酸の水素付加、構造最適化は、独自開発のプログラム(an eXtended Universal 
Force Field Universal Force Field (XUFF))で行っています。 
gly10_Hydrogen.par 

 

gly_Optimize.par 

 
 
 

4.1.3 計算実行 

BioStation Viewer に gly10_H_opt.pdb が表示されている事を確認したうえで、File→Edit 

-O 
-h 
OPTIMIZATION 100 
SDLOOP 100 
MAXLOOP 500 
SDGRADIENT 1000.0. 
CGGRADIENT 0.1  
RGRADIENT 0.1 
RENERGY 0.0001 

-B 
-R 
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ABINIT-MP Input File を選択し入力ファイル指定画面を表示します。入力項目を指定し、ファ

イルを格納し、そのファイルを使用し ABINIT-MP を実行します。 
Read Geometory File, Write Geometory は、計算サーバでのディレクトリに修正してから

ABINIT-MP を実行してください。 
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図 4.4 ABINIT-MP 入力の指定 

4.1.4 計算結果 

以上のように、モデリングを行い、XUFF 力場を用いて水素付加および構造最適化を行
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った構造に対する、FMO 計算結果を示します（１）。また参考に、水素原子を最適化する

前の構造を用いて FMO 計算を行った結果を示します（２）。 
α－へリックスでは３フラグメント離れた残基ごとに水素結合が現れるため、n と(n+3)

のフラグメント（残基）間の相互作用エネルギーが安定化している様子がわかります。ま

た、XUFF 力場で水素原子の構造最適化を行うことにより、水素結合のところの相互作用

が約 0.4 kcal/mol ずつ安定化しています。 
 
(1) XUFF 力場による水素原子最適化構造の結果 
全エネルギー 
  ========================= 

     ## FMO TOTAL ENERGY 

  ========================= 

        Nuclear repulsion =      5342.1817591836 

        Electronic energy =     -7458.3751057039 

        Total      energy =     -2116.1933465204 

 
フラグメント間相互作用エネルギー(IFIE) 

表 4.1 XUFF 力場で水素原子を最適化した構造の IFIE 解析(FMO-HF/STO-3G) 

  Gly1 Gly2 Gly3 Gly4 Gly5 Gly6 Gly7 Gly8 

Gly1         

Gly2         

Gly3 0.72        

Gly4 0.46 1.44       

Gly5 0.81 -4.66 1.85      

Gly6 0.61 -2.48 -4.85 1.95     

Gly7 0.24 -0.24 -2.40 -4.73 1.75    

Gly8 0.14 -0.16 -0.21 -2.39 -4.72 1.92   

Gly9 0.11 -0.26 -0.16 -0.22 -2.47 -4.94 1.84  

Gly10 0.10 -0.23 -0.41 -0.23 0.00 -2.54 -7.71 5.15 

 
(2) MOLDA モデリング構造の結果 
 
全エネルギー 
  ========================= 

     ## FMO TOTAL ENERGY 

  ========================= 

        Nuclear repulsion =      5352.4874175133 
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        Electronic energy =     -7468.6560823049 

        Total      energy =     -2116.1686647916 

 
フラグメント間相互作用エネルギー(IFIE) 

表 4.2 MOLDA でモデリングした構造の IFIE 解析(FMO-HF/STO-3G) 

  Gly1 Gly2 Gly3 Gly4 Gly5 Gly6 Gly7 Gly8 

Gly1         

Gly2         

Gly3 1.77        

Gly4 0.77 1.53       

Gly5 0.54 -4.27 1.47      

Gly6 0.55 -2.46 -4.43 1.56     

Gly7 0.27 -0.27 -2.41 -4.34 1.48    

Gly8 0.15 -0.17 -0.25 -2.41 -4.29 1.64   

Gly9 0.08 -0.25 -0.17 -0.26 -2.49 -4.47 1.57  

Gly10 0.10 -0.23 -0.40 -0.24 -0.01 -2.55 -7.30 5.04 
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4.2 受容体タンパク質と低分子リガンド化合物との結合性解析 
受容体タンパク質と低分子リガンド化合物との結合性を解析する手順について、エストロゲン受

容体(約 250 残基)と 17β－エストラジオールとの結合を例に解説します。 
 本例は手順を解説するものであり、結果の妥当性については現在検討および改良を行っていま

す。 
 
受容体－リガンドの結合解析は以下の手順で行う。 
1) 受容体－リガンド立体構造データのダウンロード 
2) 受容体－リガンド立体構造モデリング 

A) 主鎖の補完 
B) 側鎖の補完 
C) 水素原子の付加、構造最適化 

3) 受容体－リガンド結合エネルギーの計算入力ファイル作成 
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4.2.1 受容体－リガンド立体構造データのダウンロード 

タンパク質の構造データは、Protein Data Bank(PDB)から検索し、ダウンロードすることができ

ます。エストロゲン受容体(ER)の構造データを入手する為には、検索キーワードを入力するか、も

しくは直接 PDB ID を入力します。 
 

手順１：webブラウザを立ち上げて、protein date bankのページ( http://www.rcsb.org/pdb) を
表示します。 

手順１：エストロゲン受容体のリガンド結合ドメインと17β-エストラジオールとの結合体である 
1ERE 、およびDiethylstilbestrolとの結合体である3ERDをダウンロードします。ダウンロード

は、１ERE、３ERDをキーインして”SEARCHボタンをクリックすると結果が表示されるので、右上

の1EREのところで、マウスの右ボタンを押し、「対象をファイル名を指定して保存」を選択します。

ダウンロードしたファイルは、それぞれEREoriginal.pdb、ERDoriginal.pdbの名前で保存しま

す。 
 

 
図 4.5 PDB サイトで 1ERE を検索、ダウンロード 
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4.2.2 BioStation Viewer で A 鎖のみに編集 

ダウンロードしたファイル（1ERE,3ERD）は、エストロゲン受容体リガンド結合ドメインの 6 量体、

2量体であるので、あらかじめBioStation Viewerの 2.2.8節Edit編集機能のCut(unselected)
を使って単量体（A chain）の部分のみにしておきます。ファイル名は、ERE.pdb, ERD.pdb としま

す。 
 

4.2.3 ERD より主鎖を補完 

ダウンロードしてきた PDB ファイルには、タンパク質の主鎖および側鎖が部分的に欠損している

ことがあります。この欠損部分は、ダウンロードした PDB ファイルをテキスト表示することによって確

認します。 
テキスト表示をすると、原子の座標データの前の REMARK セクションに欠損している部分に関

する情報が記載されています。 
 
 MISSING ATOM → 側鎖中に欠損している原子 
 RESIDUES MISSING FROM THE PDB ENTRY DUE TO DISORDER 
  → 主鎖の欠損部分 
 
側鎖中の原子が欠損している場合は側鎖の残基ごと置き換えます。主鎖が欠損している場合は、

公開されている同じ受容体の PDB データから該当部分を探して切り取り、貼り付けます。 
ERE.pdb を確認すると、A 鎖のうち欠損しているのは 

 残基番号 306, 466, 469, 492, 531, 536 中の原子 
 残基番号 301-304, 331-336, 462-464, 549-553 の主鎖 
であることがわかります。Ｎ末端、Ｃ末端が欠けている場合は削除できるので、ここでは

A307-A547 までのペプチド鎖に対して欠損のない構造を作成することにします。主鎖の欠損部

分に対しては、最初に ERE.pdb とともにダウンロードした Diethylstilbestrol との結合体

ERD.pdb から該当部分を切り出し、補完することにします 
 

ERD.pdb の主鎖 331-336, 464-464 を確認すると、欠損しているのは 
 残基番号 332, 335, 464-464 中の原子 
です。従って補完する必要があるのは、 

 残基番号 331-336, 462-464 の主鎖 
 残基番号 332, 335, 462, 463, 464, 466, 469, 492, 531, 536 中の原子 

となりました。 
ここで、Viewerを起動し補完をおこないます。メニューよりFile→Open Fileを選択しERE.pdb

を読み込みます。Tree 表示で、331-336,462-464 が欠損していることが確認できます。表示の
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ModelをCα[Line]に変更し、Tree表示で、GLU330,PHE337を選択すると、3D表示で欠損部

分が確認できます。同様にして 462-464 の確認もできます。 

 

図 4.6 主鎖の欠損部分の表示 

次に Tool→Complement Main Chain を選択し、補完に使用するファイル名(ERD.pdb)を指

定し、”Apply”ボタンをクリックします。補完する主鎖の番号を指定しない場合は、欠損している部

分を自動的に補完します。補完する主鎖の番号を指定する場合は、元の構造の端の残基を Tree
図上でクリックすることにより指定します。補完後のファイルは、Viewer 起動ディレクトリに元のファ

イル名(xxx)より、xxx_complement.pdb として格納される。補完後の表示を図 4.6 に示します。 

 

図 4.7 主鎖の欠損部分を補完 
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4.2.4 原子欠損のある残基を Molda のポイントミューテーション機能で置き換える 

編集機能 MOLDA を使用し、残基のポイントミューテーションを行います。3D 表示には、

ERE.pdb も表示されているので、File→Delete File List を選択し、ERE.pdb は削除しておきま

す。File→Molda[with file]を選択すると、MOLDA が起動され分子構造が表示されます。View
→Sequence Viewer を選択します。ポイントミューテーションする残基 ASP332 を選択し、”OK”を
クリックします。該当部分が水色で表示されます。Model→Point Mutation を選択し、ASP と入力

し、”OK”をクリックします。これで、ASP332 のミューテーションが行われる、残りの残基番号 335, 
462, 463, 464, 466, 469, 492, 531, 536 についても同様に行います。この結果を Viewer で表示

するために Display→To Viewer を選択します。ERE_complement_tmp.pdb として表示されま

す。ERE_complement.pdb の表示は、必要ないので File→Delete File List で削除します。 

     

図 4.8 ASP332 のポイントミューテーション 

4.2.5 水素付加、構造最適化を実行。 

末端処理を行うためViewerでその処理を行う。Tool→Hydrogen Capping Modeを選択し、こ

こでは、COO-NH3、を選択し、“OK“をクリックします。 

 

図 4.9 末端処理の指定  
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水素付加、構造最適化を行うため Tool→Optimize Structure を選択し、Hydorgen Option 
FileはERE_Hydrogen.parを、Optimaze Option Fileは、ERE_Optimize.parを、Input File
は、ERE_complement_tmp.pdb を入力し“OK“をクリックします。構造最適化が実行され表示さ

れます。結果ファイル名はERE_complement_tmp_opt.pdbであり、入力ファイルに_H_optが付

加 さ れ た も の に な り ま す 。 。 水 素 が 付 加 さ れ た だ け の 構 造 フ ァ イ ル は

ERE_complement_tmp_H.mol2 として保存されます。オプションファイルの内容は、以下のように

なっていて、構造最適化で指定可能なオプションを記述してきます。オプションの詳細は、５章に示

します 
ここで、低分子の水素付加は Babel で、アミノ酸の水素付加は、独自開発のプログラムで行って

います。 
 

ERE_Hydrogen.par 

 
 
ERE_Optimize.par 

 
この指定は、水素(-h)、主鎖補完したアミノ酸(ACTIVE_RESIDUE)、ポイントミューレーションした

アミノ酸側鎖(ACTIVE_SIDECHAIN)を構造最適化するものです。リガンドの構造を最適化したい

場合は ACTIVE_RESIDUE に PDF 中のリガンドの残基番号 600 を追加します。 
 
 
 
 

-O 
-h 
SDLOOP 100 
CGLOOP 400 
MAXLOOP 500 
SDGRADIENT 1000.0. 
CGGRADIENT 0.1  
RGRADIENT 0.1 
RENERGY 0.0001 
ACTIVE_RESIDUE -331 336 -462 464 
ACTIVE_SIDECHAIN 466 469 492 531 536 

-B 
-T 
-R 
-H d 
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4.2.6 ABINIT-MP 入力ファイル作成 

File→New ABINIT-MP Input Fileを選択し、入力ファイル指定画面を表示します。入力項目を

指定し、ファイルを格納し、そのファイルを使用し ABINIT-MP を実行します。 
 Read Geometory File 以外は、前節のグリシンと同じ指定です。 

 

図 4.10 ABINIT-MP 入力ファイル作成画面  
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4.3 アライメント指定の VISCANA 機能 
5 種の PDB 構造（PDBID: IERE, 1L2J, 1QKM, 1U3Q, 2I0G）からなるデータを例とし、アミ

ノ酸配列アラインメント用いた VISCANA のためのデータ準備と使用方法について説明します。 

4.3.1 CPF ファイルの準備 

FMO 計算を実行して、実行結果の CPF ファイルを取得する。すべての CPF ファイルは同一の

フォルダ（以下、データフォルダ）に格納します。 

 

図 4.11 データフォルダへの CPF ファイルの格納（名前で昇順ソート）  

4.3.2 配列データの取得 

RCSB Protein Data Bank にて、PDBID をもとにアミノ酸配列データを取得します。PDBID
の入力順は、対応する CPF ファイルを Windows のフォルダにて名前で昇順ソートした場合の順

序と一致させます。 
CPF ファイルの配列データ取得ウェブ画面（図 4.12）と、取得した配列データ（表 4.3）を示しま

す。 
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図 4.12  Protein Data Bank からデータ取得 

表 4.3  Protein Data Bank からダウンロードした配列データ 

>1ERE:A|PDBID|CHAIN|SEQUENCE 

SKKNSLALSLTADQMVSALLDAEPPILYSEYDPTRPFSEASMMGLLTNLADRELVHMINWAKRVPGFVDLTLHDQVHLLE 

CAWLEILMIGLVWRSMEHPGKLLFAPNLLLDRNQGKCVEGMVEIFDMLLATSSRFRMMNLQGEEFVCLKSIILLNSGVYT 

FLSSTLKSLEEKDHIHRVLDKITDTLIHLMAKAGLTLQQQHQRLAQLLLILSHIRHMSNKGMEHLYSMKCKNVVPLYDLL 

LEMLDAHRLHAPT  

>1L2J:A|PDBID|CHAIN|SEQUENCE 

MGSSHHHHHHSSGLVPRGSHMRELLLDALSPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAK 

KIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQH 

KEYLCVKAMILLNSSMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGME 

HLLNMKCKNVVPVYDLLLEMLNAHVLRGCKS 

>1QKM:A|PDBID|CHAIN|SEQUENCE 

VRELLLDALSPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESC 

WMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLV 

TATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEM 

LNAHVLRGCKSSITG 

>1U3Q:A|PDBID|CHAIN|SEQUENCE 

DALSPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLM 

MGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA 

DSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNAHVL 

>2I0G:A|PDBID|CHAIN|SEQUENCE 

MHHHHHHRELLLDALSPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQV 

RLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNS 

SMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVY 

DLLLEMLNAHVLRGCKS 
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4.3.3 配列データの編集 

3 次元構造データである PDB ファイルに含まれるアミノ酸残基は、通常、Protein Data Bank
からダウンロードして得られる配列データ（表 4.2）の一部です。そこで、ダウンロードした配列デー

タから PDB ファイルに含まれる残基のみを切り出したデータを作成します（表 4.3）。 
配列の 1 行の文字数は、ダウンロードデータ（表 4.2）と同一でなくても良いです。では、各配列

を 1 行にまとめています。 

表 4.4 PDB ファイルに含まれる残基のみを切り出した配列データ 

>1ERE:A|PDBID|CHAIN|SEQUENCE 

SLTADQMVSALLDAEPPILYSEYDPTRPFSEASMMGLLTNLADRELVHMINWAKRVPGFVDLTLHDQVHLLECAWLEILMIGLVWRSMEHPGKLLFAPNLLLDRNQ

GKCVEGMVEIFDMLLATSSRFRMMNLQGEEFVCLKSIILLNSGVYTFLSSTLKSLEEKDHIHRVLDKITDTLIHLMAKAGLTLQQQHQRLAQLLLILSHIRHMSNK

GMEHLYSMKCKNVVPLYDLLLEML 

>1L2J:A|PDBID|CHAIN|SEQUENCE 

SPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKC

VEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEH

LLNMKCKNVVPVYDLLLEMLNA 

>1QKM:A|PDBID|CHAIN|SEQUENCE 

SPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKC

VEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEH

LLNMKCKNVVPVYDLLLEMLNA 

>1U3Q:A|PDBID|CHAIN|SEQUENCE 

SPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKC

VEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEH

LLNMKCKNVVPVYDLLLEMLNA 

>2I0G:A|PDBID|CHAIN|SEQUENCE 

SPEQLVLTLLEAEPPHVLISRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKC

VEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDADSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEH

LLNMKCKNVVPVYDLLLEMLNA 
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4.3.4 アラインメントデータの取得 

EBI Clustal Omega にて切り出した配列データのアラインメントを行ないます。アラインメント実

行ウェブ画面（図 4.13）と、アラインメント結果ファイル（表 4.5）を示します。 

 
図 4.13 EBI/Clustal Omega でのアラインメント実行 

表 4.5 アラインメント実行結果 
（clustalo-I20170117-043407-0256-70767858-pg.clustal） 

CLUSTAL O(1.2.4) multiple sequence alignment 

 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      SLTADQMVSALLDAEPPILYSEYDPTRPFSEASMMGLLTNLADRELVHMINWAKRVPGFV 

1L2J:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

1QKM:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

1U3Q:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 
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2I0G:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

                                   : :*:* :**:**** :     *: **:*****  **:***:******.***::**** 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      DLTLHDQVHLLECAWLEILMIGLVWRSMEHPGKLLFAPNLLLDRNQGKCVEGMVEIFDML 

1L2J:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

1QKM:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

1U3Q:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

2I0G:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

                                 :*:*.***:***..*:*:**:**:***::*****:***:*:***::******::****** 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      LATSSRFRMMNLQGEEFVCLKSIILLNSGVYTFLSSTLKSLEEKDHIHRVLDKITDTLIH 

1L2J:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

1QKM:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

1U3Q:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

2I0G:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

                                 ***:**** ::** :*::*:*::*****.:* ::::* .: :.. :: ::*: :**:*:  

 

1ERE:A|PDBID|CHAIN|SEQUENCE      LMAKAGLTLQQQHQRLAQLLLILSHIRHMSNKGMEHLYSMKCKNVVPLYDLLLEML-- 

1L2J:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA 

1QKM:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA 

1U3Q:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA 

2I0G:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA 

                                 ::**:*:: ***  ***:**::***:** ******** .********:********   

 

4.3.5 アラインメントデータの編集 

アラインメントデータにて、リガンドや水分子などアミノ酸配列以外の分子のフラグメント位置情報

を記述します。 
FMO 計算に用いた PDB ファイルの全てにおいて、リガンドなどの注目するフラグメントがアミノ

酸フラグメントの直後にある場合には、アラインメントデータファイル（*.clustal、表 4.6）を直接

VISCANA の入力として用いることができます（本節の以下の手順は不要）。 
 
上記以外の場合には、リガンドなどの注目するフラグメントの位置を合わせる必要があります。位

置合わせには、表 4.6 の末尾の赤字の様に配列文字を追加して調整します。配列文字の追加ル

ールは以下の通りです。 
 

i. 全てのアラインメント配列文字の数を同一とする。 
ii. フラグメントが無い場合には、ギャップ文字（-）を記述する。 

iii. フラグメントがある位置には、ギャップ文字以外の任意文字を記載可能である。※ 記録目的

のため、通常のアミノ酸文字列を避け、任意のアミノ酸を表す配列文字（X）やリガンドなどの

注目するフラグメント位置を特別な文字（@,#,$,…）で表しておくとよい。 
iv. リガンドなどの注目するフラグメント位置（複数ある場合は最後のフラグメント）の直前までの記

載でよい。 
v. 一行の配列文字数が定型（30 文字）を超えてもよい。 

 

表 4.6 アラインメントデータの編集 
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（00_clustalo-I20170117-043407-0256-70767858-pg.clustal） 

CLUSTAL O(1.2.4) multiple sequence alignment 

 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      SLTADQMVSALLDAEPPILYSEYDPTRPFSEASMMGLLTNLADRELVHMINWAKRVPGFV 

1L2J:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

1QKM:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

1U3Q:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

2I0G:A|PDBID|CHAIN|SEQUENCE      --SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFV 

                                   : :*:* :**:**** :     *: **:*****  **:***:******.***::**** 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      DLTLHDQVHLLECAWLEILMIGLVWRSMEHPGKLLFAPNLLLDRNQGKCVEGMVEIFDML 

1L2J:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

1QKM:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

1U3Q:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

2I0G:A|PDBID|CHAIN|SEQUENCE      ELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPDLVLDRDEGKCVEGILEIFDML 

                                 :*:*.***:***..*:*:**:**:***::*****:***:*:***::******::****** 

 

1ERE:A|PDBID|CHAIN|SEQUENCE      LATSSRFRMMNLQGEEFVCLKSIILLNSGVYTFLSSTLKSLEEKDHIHRVLDKITDTLIH 

1L2J:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

1QKM:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

1U3Q:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

2I0G:A|PDBID|CHAIN|SEQUENCE      LATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVW 

                                 ***:**** ::** :*::*:*::*****.:* ::::* .: :.. :: ::*: :**:*:  

 

1ERE:A|PDBID|CHAIN|SEQUENCE      LMAKAGLTLQQQHQRLAQLLLILSHIRHMSNKGMEHLYSMKCKNVVPLYDLLLEML--X@ 

1L2J:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@ 

1QKM:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@ 

1U3Q:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@ 

2I0G:A|PDBID|CHAIN|SEQUENCE      VIAKSGISSQQQSMRLANLLMLLSHVRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@ 

                                 ::**:*:: ***  ***:**::***:** ******** .********:********   

 

4.3.6 アラインメントデータの配置 

データフォルダにアラインメントデータ（*.clustal）を格納する（図 4.14）。アラインメントデータが

複数ある場合には、名前・昇順ソートで最初のデータが使用されます。 
図 4.14では編集を行なったアラインメントデータについて、そのファイル名の先頭を「00_」とし、

VISCANA 実行時に読み込まれるようにしています。 
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図 4.14 データフォルダへのアラインメントデータの格納 

4.3.7 VISCANA 実行 

BioStation Viewerの「Monitor」メニューから「VISCANA」を選択してVISCANA ウィンドウを

開きます。 
VISCANAのウィンドウにて、「CPF Data Directory…」ボタンをクリックしてデータフォルダを設

定します。次いで「Load」ボタンをクリックすると、データフォルダのアラインメントデータおよび CPF
が読み込まれます。 

「Apply」ボタンをクリックするとクラスタ解析が行われ、結果が表示されます（図 4.15）。 

 

図 4.15  VISCANA ウィンドウ（アラインメント実行結果） 



213 

左下の「Data Select」から「IFIE」を選び、プルダウンから「MP2」を選び、「Apply」ボタンを押

すとの図 4.16 ようになる。 

 

図 4.16  VISCANA ウィンドウ（IFIE, MP2 データ選択実行） 

表示される色のスケールを変更するには、中央下のエネルギーの下限「Min」・上限「Max」を設

定します。一度「Apply」ボタンを押すとデータの下限・上限が表示されます。この値を参考に

「IFIE/PIEDA(X)」の下限を-20、上限を+20、「IFIE Sum over X」の下限を-50、上限を 50 とし、

「Apply」ボタンを押すと、図 4.17 のように設定されて表示されます。 

 

図 4.17  VISCANA ウィンドウ（カラースケール設定） 
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Base Fragment からの距離により、表示するフラグメント数を絞るためには、右下の「View 
Filter」の「Distance」に値を設定します。「Distance」に 15（Å）を設定して、「Filter」ボタンを押

すと、図 4.18 のようにフラグメントが限定されて表示されます。 

 

図 4.18  VISCANA ウィンドウ（フラグメントの絞込み） 

VISCANA 実行後には、アラインメント配列情報を記載したファイル（sequence.txt）が出力され

ます（図 4.19）。sequence.txt には、アラインメントデータファイルの名前、配列の本数、各配列の

PDBID・Chain、配列文字列、アミノ酸残基数、配列文字数が出力されます（表 4.7）。 

 

図 4.19  データフォルダ（VISCANA 実行後） 
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表 4.7  sequence.txt 

C:\test_data\00_clustalo-I20170117-043407-0256-70767858-pg.clustal 

#sequences : 5 

1ERE|A|SLTADQMVSALLDAEPPILYSEYDPTRPFSEASMMGLLTNLADRELVHMINWAKRVPGFVDLTLHDQVHLLECAWLEILMIGLVWRSMEHPGKLLFAPN

LLLDRNQGKCVEGMVEIFDMLLATSSRFRMMNLQGEEFVCLKSIILLNSGVYTFLSSTLKSLEEKDHIHRVLDKITDTLIHLMAKAGLTLQQQHQRLAQLLLILSH

IRHMSNKGMEHLYSMKCKNVVPLYDLLLEML--X@(#=238/240) 

1L2J|A|--SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPD

LVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSH

VRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@(#=235/240) 

1QKM|A|--SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPD

LVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSH

VRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@(#=235/240) 

1U3Q|A|--SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPD

LVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSH

VRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@(#=235/240) 

2I0G|A|--SPEQLVLTLLEAEPPHVLI-SRPSAPFTEASMMMSLTKLADKELVHMISWAKKIPGFVELSLFDQVRLLESCWMEVLMMGLMWRSIDHPGKLIFAPD

LVLDRDEGKCVEGILEIFDMLLATTSRFRELKLQHKEYLCVKAMILLNSSMYPLVTATQDA-DSSRKLAHLLNAVTDALVWVIAKSGISSQQQSMRLANLLMLLSH

VRHASNKGMEHLLNMKCKNVVPVYDLLLEMLNA-@(#=235/240) 
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4.4 フラグメント手動指定（リガンド 4 分割） 
自動分割して、リガンド部分（フラグメント番号 200 番）を手動で 4 フラグメントとする。 

4.4.1 PDB 読み込み 

PDB（HIV-P.pdb）を読み込み、File→Edit ABINIT-MP Input File を選択し、ABINIT-MP 
Input File 編集画面を表示します。FMOCNTRL タブをクリックし、Auto Fragmentation で

hybrid を指定。”Set fragmentation”ボタンをクリックします。 

 

図 4.20  FMOCNTRL タブ 

4.4.2 フラグメント自動生成 

Generate Fragmentsでフラグメントを自動生成します。リガンドは200番になります。フラグメン

トを自動生成時は、Atom の色は Fragment に設定されます。 

 

図 4.21  Generate Fragments 

4.4.3 リガンド編集の表示設定 

リガンド編集のため、Display All InformattionをNOにして、HybridFragで編集対象の200
番を指定して“Apply”ボタンをクリックする。Display All DBA を NO にします。 
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図 4.22  編集対象の表示指定 

 

図 4.23  リガンドの表示 

4.4.4 新しいフラグメントの設定 

リガンド部分のフラグメントを Create New Fragment で指定し、分割して指定する３つのフラグ

メントを設定します。表示で対象原子をクリックするか、番号がわかっているならば、カット＆ペース

トして、”Create New Fragment”ボタンをクリックします。 
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図 4.24 フラグメントの構成原子指定 

 
図 4.25 フラグメントの指定後 

カット＆ペースト 

クリックした原子の番号が設定される 
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図 4.26 フラグメントの指定後（フラグメント情報） 

 

4.4.5 アラインメントデータの編集 

1) BDA を３つ設定 
原子をクリックして”Add”ボタンをクリックする。 
 

 

図 4.27 BDA 指定 

クリックした原子の番号が 
設定される 
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図 4.28  BDA 作成後 

 

 

図 4.29  BDA 作成後（BDA 情報） 

4.4.6 AJF ファイル出力 

File→Save を選択し、出力するファイル名を指定する 
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出力されたファイル（抜粋） 
… 
&FMOCNTRL 
FMO='ON' 
NBody=2 
AutoFrag='HYBRID' 
FragSizeResidue=1 
FragSizeNucleotide='/base' 
FragSizeAminoacid='+amino' 
Frag_Carbon='sp3' 
HybridFrag='200' 
HybridNF=4 
HybridSort='YES' 
… 
&FRAGMENT 
      26      20      27      21 
       1       0       0      -1 
       0       1       1       1 
    3132    3133    3134    3135    3136    3137    3138    3139    3140    3141 
    3153    3154    3155    3161    3162    3163    3164    3165    3166    3167 
    3168    3169    3170    3223    3224    3225 
    3156    3157    3158    3159    3160    3171    3172    3173    3174    3175 
    3176    3177    3178    3179    3180    3181    3182    3183    3184    3185 
    3142    3143    3144    3145    3146    3147    3148    3149    3150    3151 
    3152    3186    3187    3188    3189    3190    3191    3192    3193    3194 
    3195    3201    3202    3203    3204    3205    3206 
    3196    3197    3198    3199    3200    3207    3208    3209    3210    3211 
    3212    3213    3214    3215    3216    3217    3218    3219    3220    3221 
    3222 
    3154    3156       3 
    3159    3186       3 
    3195    3196       3 
/ 
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4.5 フラグメント手動指定（タンパク質と共有結合しているリガンドの BDA 設定） 
この例題の PDB では、タンパク（Cys797）とリガンド（HKI）の間に共有結合があり、自動分割で

は対応できない構造のため、Viewer で手動により設定することにより、解析に使用可能な AJF フ

ァイルを作成します。 

4.5.1 PDB の読み込み 

PDB （3W2Q_wild_mmff94xOpt-renumberd.pdb ）を読み込みます。次に File→Edit 
ABINIT-MP Input File を選択し、ABINIT-MP Input File 編集画面を表示。FMOCNTRL タ

ブをクリックし Auto Fragmentation で hybrid を指定。”Set fragmentation”ボタンをクリックしま

す。 

4.5.2 自動分割実行 

この例の PDB をそのまま自動分割すると、リガンド部分の共有分の電荷が現状では評価できず、

自動分割でエラーとなるので、フラグメント自動分割のパラメータとして Ligand Charge に HKI=1
を指定することにより自動分割を行います。 

 

図 4.30 フラグメント自動分割パラメータ指定 

 

図 4.31 自動分割後 
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4.5.3 フラグメント番号を確認 

Tree 図で編集対象の Cys797 とリガンド（HKI）のフラグメント番号を確認。101,297 です。

  

4.5.4 対象フラグメントだけを表示 

編集しやすいように、対象フラグメントだけを表示します。Display All Information、Display 
All BDA を No にして、HybridFlag に 101,297 を指定して”Apply”ボタンをクリックします。

Cys797 とリガンド（HKI）だけ表示されます。ここで、Formal Charge はそれぞれ -1, 1 ですが

BDA の設定により変わってしまうので後でこの値に修正します。 

 

図 4.32 対象フラグメントの表示指定 

 

図 4.33 表示指定後 

C(4824) 

S(1602) 
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4.5.5 BDA 設定 

自動分割では、CYS-リガンド間の BDA が設定されないので、手動で BDA を設定します。設定

するリガンドの C(4824)、CYS の SG(1602)を順にクリックして、”Add”ボタンをクリックします。BDA
が設定され表示されます。 

  

 

図 4.34  BDA 設定 

4.5.6 Formal Charg の設定 

BDA の設定によりFormal Chargeが、-2,2に変わってしまうので、本来の値の-1,1 に修正しま

す。 
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4.5.7 AJF ファイル出力 

File→Save を選択し、出力するファイル名を指定する 

 
出力されたファイル（抜粋） 
… 
FMO='ON' 
NBody=2 
AutoFrag='HYBRID' 
FragSizeResidue=1 
FragSizeNucleotide='/base' 
FragSizeAminoacid='+amino' 
Frag_Carbon='sp3' 
LigandCharge='HKI=-1' 
HybridFrag='101, 297' 
HybridNF=2 
HybridSort='YES' 
… 
&FRAGMENT 
      10      70 
      -1       1 
       2       0 
    1592    1593    1597    1598    1601    1602    1603    1604    1605    1606 
    4797    4798    4799    4800    4801    4802    4803    4804    4805    4806 
    4807    4808    4809    4810    4811    4812    4813    4814    4815    4816 
    4817    4818    4819    4820    4821    4822    4823    4824    4825    4826 
    4827    4828    4829    4830    4831    4832    4833    4834    4835    4836 
    4837    4838    4839    4840    4841    4842    4843    4844    4845    4846 
    4847    4848    4849    4850    4851    4852    4853    4854    4855    4856 
    4857    4858    4859    4860    4861    4862    4863    4864    4865    4866 
    1591    1592       3 
    4824    1602       3 
/ 
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5 超分子計算 
超分子計算の結果を表示する場合の計算式を示します。 
FMO 法による超分子計算（複合体のフラグメント分割がタンパク質、リガンドのフラグメント分割

の単純な和になっている場合 C: 複合体, P:タンパク質, L:リガンド, C = P∪L）は、複合体の全

エネルギーをEC、タンパク質の全エネルギーをEP、リガンド分子の全エネルギーをELとすると、超

分子計算によるタンパク質とリガンド間の結合作用エネルギーΔE は 

)( LPC EEEE +−=∆        (式 5.1) 

となります。 LPC EEE ,, を FMO2 法で計算したとすると、 
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5.2) 

となります。（ 'E は、環境静電ポテンシャルからの寄与を除いたモノマーのエネルギー、 IJE~∆ はフ

ラグメント間相互作用エネルギー(IFIE)の値を示す）
CE をタンパク質内、リガンド内、タンパク質―

リガンド分子間の項に分解すると 
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となります。ここで、タンパク質、リガンド分子について項をまとめ 
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を定義すると、ΔE を 
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と表すことができます。ここで、第 1 項はタンパク質とリガンド分子の結合によるタンパク質の電子緩

和による安定化エネルギー、第2項はリガンド分子の電子緩和による安定化エネルギー、第3項は

タンパク質―リガンド分子間の IFIE と解釈できます。 
 Viewer では、複合体、タンパク質、リガンドそれぞれの計算結果チェックポイントファイルを読み

込み、対応するフラグメント番号を指定して、上記の計算を行います。 
 チェックポイントファイルに記述されている IFIE、モノマー計算結果からの具体的な計算方法を

次に示します。 
1) ステップ１ IE '∆ の計算 
複合体から、タンパク質、リガンドそれぞれモノマー部分の値の差を計算します。 

 
図 5.1 IJE′∆ の計算のメモリイメージ 

2) ステップ２ IJE~∆∆ の計算 

複合体から、タンパク質、リガンドそれぞれ IFIE の値の差を計算します。 

 

図 5.2 IJE~∆∆ の計算のメモリイメージ 
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3) ステップ 3 Supermolecule IFIE '~C
IJE∆ の計算 

ステップ１，２の結果を使用して計算します。 

タンパク質 ： ∑
∈
≠

∆∆+′∆=′′∆

PK
IK

IKII EEE ~
2
1      (式 5.7) 

リガンド  ： ∑
∈
≠

∆∆+′∆=′′∆

LK
JK

JKJJ EEE ~
2
1      (式 5.8) 

IEJEEE JI
C
IJ

C
IJ //~~ ′′∆+′′∆+∆=∆ ′      (式 5.9) 

 

 

図 5.3 ∑∆∆ IJE~ の計算のメモリイメージ 

 
(式 5.7)の右辺第２項では、電子緩和によるタンパク質内部の IFIE 変化分をそれぞれ 1/2 にして

各フラグメントに帰属します。(式 5.8)のリガンドについても同様です。得られる supermolecule 
IFIE では、リガンド結合による電子緩和の効果を取り込んだ、フラグメント単位のタンパク質－リガ

ンド IFIE 解析が可能になります。 
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6 構造最適化のオプション 
構造最適化は、Viewer より別プログラムを呼び出すことにより実行しています。ここで、指定可

能なオプションを以下に示します。このオプションを記述したファイルを用意し、構造最適化の画面

で指定します。 
  
 
タンパク質の水素付加 
（任意） 

–B 
 Atom type の計算を指定。 
–n 
 水素原子の付加（–B 指定時に有効）。 

水素を付加する場合：無記入 
水素を付加しない場合：–n 

構造最適化の指定 
（任意） 
 

–O 
 XUFF 力場による構造最適化の実行。 
  構造最適化計算を行う場合：–O 
  構造最適化計算を行わない場合：無記入 
 
–X # 

MQEq 法による電荷再計算の最適化計算ループ間隔（–O 指定時に

有効）を正の整数#で指定する。 
 
–h 
水素原子位置の最適化（–O 指定時に有効）。全ての水素原子に対し

て、下記で示す ACTIVE が指定されたとして処理し、水素原子以外

の全ての原子に対して、下記で示す INACTIVE が指定されたとして

処理する。 
 
–S 
主鎖の重原子位置を固定。側鎖構造と水素原子位置の最適化（–O
指定時に有効）。主鎖の重原子を除く全ての原子に対して、下記で

示す ACTIVE が指定されたとして処理し、主鎖の全ての重原子に対

して、下記で示す INACTIVE が指定されたとして処理する。 
 
PDB 形式と MOL2 形式での主鎖の認識方法は以下の通り。 

 
PDB 形式の主鎖： 

Atom name 
N 

CA 
C 
O 

OXT 
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MOL2 形式の主鎖： 
Atom name Atom type 

N N.4 或いは N.am 
CA C.3 
C C.2 
O O.2 

OXT O.3 
（両方を満たすもの） 

 
–T 
 N 末端、C 末端の処理。 
    N 末端、C 末端を解離させるとき：－T 
    (NH4+, COO-) 
    N 末端、C 末端を解離させないとき：無記入 
    (NH3, COOH) 
 
–R 
 ASP, GLU, LYS, ARG の処理。 
    荷電状態を指定するとき：－R 
    中性状態を指定するとき：無記入 
 
–H # 
 ヒスチジンのイミダゾール環の処理（デフォルトはπ型）。 
    π型（d 型）：－H d 
    τ型（e 型）：－H e 
    ｐ型（p 型）：－H p 
 
–C # c 
分子毎に全電荷を指定。 

#：分子の番号 
c：charge 

デフォルトは各分子の全電荷ゼロ。 
PDB 形式と MOL2 形式での分子の区別方法は以下の通り。 
 
PDB 形式の分子の区別：（一部未対応） 

TER、HETATM、分子名（残基名）、残基番号の順に確認する。以

下の場合、分子を変更する。 
・ TER が現れたら。 
・ HETATM が現れたら。 
・ HETATM 内の分子名が変わったら（5 原子程度以下の分子を

除く、水分子を除く）。 
・ HETATM から ATOM に変わったら。 
・ 残基番号が小さくなったら。 
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MOL2 形式の主鎖の区別： 
以下の Substract id と Substract name の情報を利用して区別する。 
Substract id：アミノ酸残基や低分子化合物単位に与えられている

整数。昇順にカウントされる。 
Substract name：アミノ酸残基や化合物の名称。異なる低分子化合

物が連続で指定されていると、Substract id が変化

しない場合でも、この Substract nameが変化する。 
 
–k [Tinker_key_file] 
   [Tinker_key_file]：Tinker 形式の Keyword Control ファイルを指定

（–O 指定時に有効）。 
   デフォルト名は tinker.key。 

各原子が ACTIVE か INACTIVE かを指定できる。 
例）ACTIVE 4 -9 17 23 

は、原子4, 9-17, 23を計算時にアクティブにする。マイナス（－）

は範囲のスタートを意味する。ACTIVE は複数指定可能。

INACTIVE はアクティブの逆の意味で、やはり複数指定でき

る。但し、同じ原子が ACTIVE と INACTIVE の両方を指定され

た場合 ACTIVE が優先することと、ACTIVE と INACTIVE のど

ちらの指定にも該当しない原子はアクティブになることの 2 点

で、ACTIVE と INACTIVE の利用方法が異なる。 
 
–f [xuffopt_parameter_file] 
   [xuffopt_parameter_file]：xuffopt 独自形式のパラメータファイルを指

定。-f 以外のオプションと以下のアミノ酸残基に関する計条件
ACTIVE_RESIDUE, INACTIVE_RESIDUE, 
ACTIVE_SIDECHAIN の指定と、最適化ループの収束計算に関す

る 条 件 SDLOOP, CGLOOP, MAXLOOP, SDGRADIENT, 
CGGRADIENT, RENERGY, RGRADIENT が指定できる。 

   デフォルト名は xuffopt.par。 
 

各アミノ酸残基が ACTIVE_RESIDUE か INACTIVE_RESIDUE
かを指定できる。指定方法は ACTIVE, INACTIVE と同じ。 

例）ACTIVE_RESIDUE 4 -9 17 23 
は、残基4, 9-17, 23を計算時にアクティブにする。マイナス（－）は範

囲のスタートを意味する。ACTIV_RESIDUE は複数指定可能。

INACTIVE_RESIDUE はアクティブの逆の意味で、やはり複数指定

できる。但し、同じ残基が ACTIVE_RESIDUE と

INACTIVE_RESIDUE の両方を指定された場合

ACTIVE_RESIDUE が優先することと、ACTIVE_RESIDUE と

INACTIVE_RESIDUE のどちらの指定にも該当しない残基はアクテ

ィブになることの 2 点で、ACTIVE_RESIDUE と

INACTIVE_RESIDUE の利用方法が異なる。 
各ア ミ ノ酸残基の側鎖 （主鎖を除いた部分 ）に対して

ACTIVE_SIDECHAIN を指定できる。指定方法は ACTIVE, 
ACTIVE_RESIDUE と同じ。 
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最適化ループの収束計算回数と収束判定条件を指定できる（以

下の例はデフォルト値）。 
 例）SDLOOP  100 
   CGLOOP  400 
   MAXLOOP  500 
   SDGRADIENT  1000.0 
   CGGRADIENT  0.1 
   RGRADIENT  0.1 
   RENERGY  0.0001 
 

SDLOOP：最大 Steepest Descent 法ループ数(SD ループ) 
CGLOOP：最大 Conjugate Gradient 法ループ数(CG ループ) 
LOOPMAX：最大ループ数 
SDGRADIENT：SD ループの gradient 打ち切り値 
CGGRADIENT：CG ループの gradient 打ち切り値 
RGRADIENT：Gradient の収束判定値 
RENERGY：全エネルギーの残差(kcal/mol)の収束判定値 

 
Gradient は 2 乗和ルートの値で判定。単位は(kcal/mol・Å)。SD

ループが途中で打ち切られた場合、CG ループは「最大 SD ループ

数＋最大 CG ループ数」まで続く。 
なお、現在 BFGC 法の計算を行っていないので、CGLOOP と

CGGRADIENT は無効になっている。 
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7 インストール 
7.1 配布形式 
配布形式は、Windows のインストーラです。 
 
7.2 システムのインストール 
インストーラをダブルクリックするとインストールします。デスクトップにショートカットが作成されます。 
スタート→ABINIT-MP Open Consortium→BioStationViewer 
を選択すると起動します。起動時のカレントフォルダーは、インストールディレクトリになっています。

変更するには、メニューの BioStationViewer 上で右ボタンをクリックして、プロパティーを選択し、

作業フォルダーを変更してください。この場合、インストールディレクトリをPathに加える必要がある

ので、 
C:¥Program Files¥ABINIT-MP Open Consortium¥BioStationViewer 

を加えてください。 
 
7.3 動作環境 
動作環境を表 7.1 に示します。 
3D 表示を快適に行うには、VRAM 128M 以上のグラフィックカードをご利用ください。解像度は

SXGA(1280x1024)以上をご使用ください。 
 

表 7.1 動作環境 

項目 用件 
OS Windows(2000/XP,7,10) 

 
CPU Pentium Ⅱ 400MHz 以上 
メモリ メモリ 2GB 以上を推奨 

 
7.4 ファイルの取得 
ABINIT-MP のホームページから関連ファイルをダウンロードして取得してください。以下のファイ

ルが必要なファイルです。 
ファイル名 説明 

BioStationViewerOpen_1.0_rev11.exe BioStation インストーラファイル 
sampleData.zip サンプルファイル 
tutorial.zip チュートリアルデータ 
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7.5 Reduce の設定 
水素付加機能で Reduce を使用します。Reduce は  
http://kinemage.biochem.duke.edu/software/reduce.php 
よりダウンロード可能なフリーのプログラムです。 
プログラムをダウンロードして適当な場所へ保存し、そのフォルダーへＰａｔｈを設定して下さい。

Path の設定方法は前節を参照してください。オプションを以下に示します。 
 
reduce: version 2.15 10/4/01, Copyright 1997-2001, J. Michael Word 
arguments: [-flags] filename or - 
 
Adds hydrogens to a PDB format file and writes to standard output. 
(note: By default, HIS sidechain NH protons are not added. See -BUILD) 
 
Flags: 
-Trim             remove (rather than add) hydrogens 
 
-NOOH             remove hydrogens on OH and SH groups 
-OH               add hydrogens on OH and SH groups (default) 
 
-HIS              create NH hydrogens on HIS rings 
-FLIPs            allow complete ASN, GLN and HIS sidechains to flip 
                        (usually used with -HIS) 
-NOHETh           do not attempt to add NH proton on Het groups 
-ROTNH3           allow lysine NH3 to rotate (default) 
-NOROTNH3         do not allow lysine NH3 to rotate 
-ROTEXist         allow existing rotatable groups (OH, SH, Met-CH3) to rotate 
-ROTEXOH          allow existing OH & SH groups to rotate 
-ALLMEthyls       allow all methyl groups to rotate 
-ONLYA            only adjust 'A' conformations (default) 
-ALLALT           process adjustments for all conformations 
-NOROTMET         do not rotate methionine methyl groups 
-NOADJust         do not process any rot or flip adjustments 
 
-BUILD            add H, including His sc NH, then rotate and flip groups 
                  (except for pre-existing methionine methyl hydrogens) 
                  (same as: -OH -ROTEXOH -HIS -FLIP) 

http://kinemage.biochem.duke.edu/software/software2.html#reduce
http://kinemage.biochem.duke.edu/software/software2.html#reduce
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-Keep             keep bond lengths as found 
-NBonds#          remove dots if cause within n bonds (default=3) 
-Model#           which model to process (default=1) 
-Nterm#           max number of nterm residue (default=1) 
-DENSity#.#       dot density (in dots/A^2) for VDW calculations (default=16) 
-RADius#.#        probe radius (in A) for VDW calculations (default=0) 
-OCCcuttoff#.#    occupancy cutoff for adjustments (default=0.01) 
-H2OBcuttoff#.#   B-factor  cutoff for water atoms (default=40) 
-H2OOCCcuttoff#.# occupancy cutoff for water atoms (default=0.66) 
-PENalty#.#       fraction of std. bias towards original orientation (default=1) 
-HBREGcuttoff#.#  over this gap regular HBonds bump (default=0.6) 
-HBCHargedcut#.#  over this gap charged HBonds bump (default=0.4) 
-BADBumpcut#.#    at this gap a bump is 'bad' (default=0.4) 
-SEGIDmap "seg,c..."  assign chainID based on segment identifier field 
-Xplor            use Xplor conventions for naming polar hydrogens 
-NOCon            drop conect records 
-LIMIT#           max num iter. for exhaustive search (default=100000) 
-NOTICKs          do not display the set orientation ticker during processing 
-SHOWSCore        display scores for each orientation considered during processing 
-FIX "filename"   if given, file specifies orientations for adjustable groups 
-DB "filename"    file to search for het info 
                        (default="/usr/local/reduce_het_dict.txt") 
note: can also redirect with unix environment variable: REDUCE_HET_DICT 
 
-Quiet            do not write extra info to the console 
-REFerence        display citation reference 
-Help             more extensive description of command line arguments 
 
 
7.6 Babel の設定 
環境変数 BABEL_DIR に 
C:¥Program Files¥ABINIT-MP Open Consortium ¥ BioStationViewer¥babel-lis 
を設定する。 
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7.7 Bond Builder の使用方法 
水素付加プログラム bond_builder の使用方法を表 7.2 に示す。 
 

表 7.2 bond_builder の使用方法 

コマンドライン % bond_builder.exe –i [input_file_name] [input_file_type] 
 –o [output_file_name] [output_file_type] 
–B –n –T –R –H # 

入力ファイルの指定 –i [input_file_name] [input_file_type] 
[input_file_name]：入力ファイル名（必須）。 
[input_file_type]：入力ファイルの形式（任意）。 

PDB 形式の場合：pdb, ent 
MOL2 形式の場合：mol2 

デフォルトは、入力ファイル名 input_file_name の拡張子が pdb か ent
の場合 PDB 形式、mol2 の場合 MOL2 形式。 

出力ファイルの指定 –o [output_file_name] [output_file_type] 
  [output_file_name]：出力ファイル名。 

[output_file_type]：出力ファイルの形式（任意）。 
PDB 形式の場合：pdb, ent 
MOL2 形式の場合：mol2 

デフォルトは、入力ファイル名 output_file_nameの拡張子が pdbか ent
の場合 PDB 形式、mol2 の場合 MOL2 形式。 
－o の指定がないと、入力ファイルに_builder を付加したファイル名で

出力する。例）input_builder.mol2 
このとき、-B（Atom type の計算を指定）が指定されている場合、入力

ファイルに_H を付加したファイル名で出力する。例）input_H.pdb 
水素付加 
（任意） 

–B 
 Atom type の計算を指定。 
–n 
 水素原子の付加（–B 指定時に有効）。 

水素を付加する場合：無記入 
水素を付加しない場合：–n 

N 末端、C 末端の処理 
（任意） 
 

–T 
 N 末端、C 末端を解離させるとき：－T 
 (NH3+, COO-) 
 N 末端、C 末端を解離させないとき：無記入 
 (NH2, COOH) 

荷電アミノ酸残基 
ASP, GLU, LYS, ARG 
の処理（任意） 

–R 
 荷電状態を指定するとき：－R 
 中性状態を指定するとき：無記入 

ヒスチジンのイミダゾー

ル環の処理 
（デフォルトはπ型） 

–H # 
π型（d 型）：－H d 

 τ型（e 型）：－H e 
 ｐ型（p 型）：－H p 
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7.8 TINKER の設定 
http://dasher.wustl.edu/tinker/ よりダウンロードし、インストールフォルダ/binをPathに設定す

る。インストールフォルダ/jre/bin/client/jvm.dll を bin へコピーする。jvm.dll をコピーしておかな

いと実行時にエラーとなる。 
 
 

http://dasher.wustl.edu/tinker/
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